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CHAPTER 1: INSTALL & GETTING STARTED

Welcome to WebArranger 2.0! 

Now you can capture, control, and organize your Internet world!

Thank you for your purchase of CE Software’s WebArranger, the only information 
manager built for the information age. We’re sure you’ll soon find it an indispensable companion for all 
your Internet and personal information management needs ... that’s right! WebArranger is a powerful 
PIM and IIM!

As you explore WebArranger, you’ll find that you own one of the most customizable applications 
available today. We understand you want to organize your information your way. 

Visit our Web site for information on new WebArranger plug-ins, product updates, and cool extras 
available exclusively on-line. If you have any feature suggestions for future versions of WebArranger, 
please send E-mail to feedback@cesoft.com. 

Again, thanks for your purchase of WebArranger. We’re confident you’ll soon wonder how you ever 
surfed or kept track of yourself without it. 

FEATURES

ON-LINE HELP

We’ve included a WebArranger Help Document. Just press  -? or select Help in your Apple menu. 

And, we’ve embedded a special notifier agent to tell you when we update the User Guide at the 
CE Software Web site — http://www.cesoft.com/webarranger/wasupportpage.html  

Use WebWhacker to whack the User Guide for off-line reading. Enjoy the power of a linked html User 
Guide right on your desktop. See Open “WebWhacker” on page 116.

IIM TEMPLATE

When you launch WebArranger, you’ll have a working Internet Information Manager (IIM)Document 
ready for you. It’s complete with a variety of Folders, Topics, and examples already set up to help you 
get going. And it’s loaded with Internet addresses in URL Notes, ready to take you to fascinating places 
on the Web.

PIM TEMPLATE

WebArranger also ships with The Organizer Template, your Personal Information Manager (PIM). This 
is helpful if you want to set up a separate Document as your PIM. 
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NETSCAPE NAVIGATOR SUPPORT

WebArranger 2.0 provides full support for Netscape 2.0 history and bookmarks. Anarchie 
bookmarks are supported, too. 

For more information, see Import/Export on page 115 and Start WWW Foot Steps on 
page 114. 

THE GRABBER

The Grabber captures information and graphics for you, any place, any time. You 
can grab a URL, text on a Web site, a piece of a Microsoft® Word document, an 
image in Adobe Photoshop™, or an E-mail message — whether or not 
WebArranger is running! And, you can define your own easy hot keys activate 
the Grabber. 

Grabbed material is placed in the Clippings Topic. URLs are placed as URL Notes. Other items are 
placed as Memo Notes. The Clippings Topic is located in the My Data Folder. See Set Up The Grabber 
on page 9.

WEBWHACKER

 We bundled WebWhacker™ with WebArranger because it can 
reduce your dependency upon an Internet connection. 

Use WebWhacker to download (aka whack) entire Web sites to 
your hard drive. Look at your favorite Web sites even when 
you’re not connected to the Internet!

For more information about using WebWhacker, see its Topic 
in the WebArranger 2.0 template and Open WebWhacker on 
page 116.

URL VALIDATOR

Have you ever used a URL, only to discover it no longer works? WebArranger’s URL Validator Agent 
gets that information for you.

The Validator checks http URLs in your History Topic, and puts invalid ones in a special Topic. The 
Validator also attaches an Error Description field to each invalid URL, so you’ll know if it is no longer 
active or if it has changed. The History Topic auto-gathers all URL Notes in your Document. See Start 
URL Agent on page 112.
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FTP DOWNLOAD

We got so frustrated trying over and over to download from busy Anarchie FTP sites, we created an 
agent to do it for us. The FTP Download Agent attempts to download files from specified FTP sites at 
intervals you define. When a file is downloaded, its URL is put in a special Topic, showing that your 
download is complete. See FTP Download Agent on page 114.

LINK UP YOUR STUFF

We could make all kinds of puns here about networking, but we’ll resist and stick to this point: You can 
link one WebArranger Note to another, and it can be linked somewhere, and somewhere can be linked 
elsewhere, and on and on and........... 

So, if you need to remember that your best friend pays rent to a potential in-law of yours who just 
happens to be a loan officer (and your car is wheezing really bad and spewing stuff that’s illegal in 37 
states), and who also has a Web page filled with job opportunities in your field of dreams — you just 
might find it very handy to link all that information together. For more information, see Note Link Field 
on page 68 and Linked Notes on page 34.

HOOK UP YOUR STUFF

WebArranger’s File Note features the File Reference Field. This amazing field connects you to other 
documents — in other applications — directly from WebArranger! Say you’re putting together a recipe 
book of obscure-but-marvelous cheeses and greens from around the world. One fine day you’re nosing 
around the Web, and you find this to-die-hard-for recipe from eastern New Zealand. You Grab it and put 
it in your word-processor recipe document — all from WebArranger! For more information, see File 
Reference Field on page 70 and File Note on page 20. 

PEACE OF MIND

We don’t know about you, but we used to spend way too much time looking for something we knew 
darn well we’d put away some place for safe keeping ... and the place made sense at the time. 

Well, now we don’t even have to pretend to use logic when we put some thing away. We’ve got 
WebArranger! No, WebArranger cannot find all your missing socks and earrings, but it can find any 
thing you’ve got in its database.

WebArranger has a database search function that finds whatever you tell it to. In addition to a regular 
Find, you’ve got Advanced Find, Select, Advanced Select, and a query-by-example that we fondly call Gather.
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SYSTEM REQUIREMENTS

For best performance to use WebArranger, a Web browser, and Internet Config together, these are your 
system requirements:

■ Hard disk with at least 4 megabytes of free disk space

■ 12 megabytes of RAM 

■ TCP/IP (Transmission Control Protocol and Internet Protocol) connection to the Internet

■ System software version 7.1 or later

■ Internet Config v. 1.2 (provided with WebArranger)

■ Floppy drive for installing WebArranger (if you are installing from a disk)

INSTALLATION

 You may have received WebArranger 2.0 from an 
on-line service or as a set of disks. By the time you see 
this Document you may have already installed 
WebArranger. So, if you’re already up and running, 
Congratulations! Welcome! You can just skim 
this part.

To install WebArranger:

1 Verify there’s enough space for 
WebArranger (4 mb).

2 Restart your computer with all extensions and 
anti-virus programs turned off. Hold down the Shift key while you Restart.

3 Double-click the install icon.

4 Click Continue.

5 Read the Read Me.

6 Click Continue.

7 Select your type of install.

8 Click Yes to restart after installation.

9 Specify the location for WebArranger and its files to be stored.

10 Enter your Activation Key and name (they are required), and your company (that’s optional). 



WebArranger  5

11 Click OK.

If you are installing a demo version, it will 
expire in 30 days. This time-out also applies 
to the WebWhacker application. Your 
expiration date is displayed in the 
WebArranger About box as well as on 
the application’s opening screen.

12 Insert disks as requested. Depending upon 
your configuration, you may not need all three disks.

LAUNCH WEBARRANGER

To launch the application, double-click the WebArranger icon. 

The first time you launch WebArranger, you’re looking at a template. Now you need to save and name it 
as your Document. Select Save in the File menu. See Home Document on page 13.

THE WEBARRANGER FOLDER

After installation, a Folder named Arrange Folder displays on your hard disk. It contains:

■ WebArranger 2.0 — The application. Double-click this to run the program.

■ WebWhacker Folder — The application. Installed with WebArranger. Access in the 
Tools menu.

■ WebArranger Help — On-line help Document.

■ Organizer Template — A template designed for personal information management. See Cool 
Trick #7 for information about using it.

■ Plug-ins Folder — Any plug-ins installed with WebArranger are installed into this Folder. If 
you install plug-ins later on, put them into this Folder. Keep this Folder in the same Folder as 
the application.

■ Icon Library — A collection of icons to use when you create Topics and Note types. Keep this 
file in the same Folder as the application.

■ Getting Started Folder — Files and Documents you use to complete the Getting Started 
tutorial in the User Guide at the CE Software home page on the Web at:
http://www.cesoft.com/webarranger/wasupportpage.html

■ Internet Config 1.2 — This application is the bridge between WebArranger and your other 
Internet applications. Its Folder contains extensions and user Documentation. 

❖ Note: If you install WebWhacker by itself, Internet Config is not installed.
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WEBARRANGER SIZE LIMITS

■ File size — 256 mb

■ Number of fields — 100 per Note

■ Number of Sub-Notes — 50 per Note

■ Note Link field — 50 Notes per Note Link field

■ Field size — 16K

■ Grabber and Import — 4K 

THE USER GUIDE

This guide helps you learn how to use WebArranger, and assumes you know how to use the Macintosh 
computer. If you don’t, read the documentation that came with your computer before you continue.

INTERNET CONFIG 

First things first. Before WebArranger can do its tricks, it has to know which Internet applications you 
want to use, among other things. Internet Config tells WebArranger which Internet applications to use, 
and you tell Internet Config. Make sense? OK, let’s make this a little more clear.

1 Launch WebArranger and select Open 
“Internet Config” in the Tools menu. 

If you don’t already have a copy of 
Internet Config, a message displays 
indicating the Internet Config Extension 
is not installed and it asks if you would 
like to install it. Yes you would, so give it 
the OK. It tells you when the installation is complete (don’t worry, you won’t have to Restart).

2 Click the Helpers button in the Internet 
Preferences dialog.
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The Helpers dialog displays with a list of the 
types of applications you might need such as 
http, ftp, mailto, etc.

3 Click Add in the Helpers dialog to display the 
Add Helper dialog. 

4 Type the kind of helper application you want to select 
in the Helper For: field.

For example: Type http to indicate a browser 
application. And, type mailto to indicate an 
E-mail application.

5 Click Choose Helper to display a standard Open dialog. 

6 Navigate through your drives and point to the Internet application to use as the Helper. 
For example: Point to QuickMail™ Pro as your mailto Helper, and to your Web browser application 
as your http Helper. 

7 Click Open.

8 The Add Helper dialog returns. Click OK to return to the Helpers dialog. 

Repeat Steps 3 through 8 until you have pointed Internet Config to all the applications you want to use.

➣ IMPORTANT: Internet Config defaults to applications already installed on your machine, but you may 
not want to use those. For example: You select Netscape as your browser, so Internet Config defaults to 
Netscape as your mailto Helper. You do not have to choose Netscape in the Helpers dialog as the mailto 
Helper because Internet Config finds it. However, you may want to use another application as your 
mailto Helper.

CHANGE THE HELPER APPLICATION 

1 Highlight an item in the Helpers dialog and click Change.

2 Follow Steps 6 and 7 in the previous section. 
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DEFINE FILE TRANSFER DOWNLOAD FOLDER

The Internet Config File Transfer dialog helps you set 
preferences related to the transfer of files from the 
Internet to your computer using FTP.

1 Click the File Transfer button in the 
Internet Preferences dialog.

2 Click Download Folder. Specify where to put 
downloaded information from FTP sites. This 
location is placed by WebArranger in a field called 
Downloaded File.

When WebArranger’s FTP Download Agent puts a 
URL in the Successful FTP Downloads Topic, it adds the 
Downloaded File field to the URL Note. From this field, you go to the downloaded information. 

INTERNET E-MAIL PREFERENCES

If you are using an Internet E-mail application, be sure your preferences are set up. 

NETSCAPE

To set up your preferences:

1 Launch Netscape.

2 Select Mail and News Preferences in the Options menu.

3 Provide your information in the Identity and Servers options.

OTHERS

Click the Email button in the Internet 
Preferences dialog. Complete the Email 
dialog with your information.

❖ Note: If you use QuickMail Pro, 
you do not need to complete the 
Email dialog.
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SET UP THE GRABBER

Grab a URL from anywhere! Grab information from anywhere! Grab a graphic from anywhere! ... You 
get the idea.

WebArranger’s Grabber™ captures text and graphics so you can add them to your WebArranger Notes. 
And WebArranger does not have to be running when you grab!

DO IT WITH A HOT KEY

You can set up the Grabber to work with the hot key of 
your choice:

1 Select Grabber Preferences in Preferences in the 
File menu.

2 Enter your hot key in the Grabber text box, if 
you don’t want to use the default. Use any 
combination of the four modifiers (Shift, Control, 
Option, Command) and one other key. Or, you can 
use a function key.

This key will grab what you have selected.

3 Enter your WebArranger hot key, if you don’t want 
to use the default. This key will either launch or go to WebArranger.

4 Select the Hot keys enabled checkbox.

5 Select the Make sound when grabbed checkbox.

6 Click OK.

HOW TO USE THE GRABBER

1 Select anything you want to capture from any application, Internet site, or from any 
electronic source.

2 Press your Grabber hot key. When your selection has been grabbed, you hear chimes.

3 Most captured data is placed in the Clippings Topic as a Memo Note. Grabbed URLs are placed in 
Clippings as a URL Note. Clippings is located in the My Data Folder.

The Clippings Topic in the WebArranger 2.0 template has some examples of grabbed stuff.

4 Press your WebArranger hot key. If it is running in the background, the hot key brings 
WebArranger to the front. If WebArranger is not running, the hot key launches the application.
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5 If WebArranger is not running when you grab something, the item is stored in a temporary file until 
you open WebArranger. You can grab more than one item before you open WebArranger.

6 When WebArranger is launched, the item is placed in the Clippings Topic. From the Clippings Topic, 
you can drag the Note to another Topic as a Note. 

Or, you can copy the data into a Note. 

Or, you can convert the Note to another Note type. Select Convert Note in the Notes menu.

❖ Note: The difference, between using the Grabber and the usual copy and paste commands, is that 
the Grabber works even when WebArranger is not running.

❖ Note: The Grabber may not work properly if you have not specified a Home Document and if the 
Arrange BackGrounder extension is disabled

SET PREFERENCES

 WebArranger gives you plenty of control over its features. 

The Preferences submenu in the File menu is where you tell 
WebArranger’s various elements when and how to do their 
work. Maybe you’ve already been in Preferences to change 
your Grabber hot keys. See Set Up The Grabber on page 9.

STYLE

Style Preferences sets your default settings for text styles.

The Style Preferences dialog gives options for default style settings for Folders, Topics, Summary Line, 
tables/calendars, text, and field names. 
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Individual field and Note definitions have text 
style settings which override these defaults. You 
can further override the default settings for 
selected field text and table views. 
See Text Format on page 63.

Style sets the default text styles for many 
elements of the application. The left side of the 
dialog is a list of radio buttons to specify which 
element of the Document to apply styles to. The 
right side contains style drop-down lists.

DEFAULT TEXT

This setting affects unstructured Notes, like Memo Notes, and the fields of structured Notes, like People 
and To Do Notes. It sets the default text style for all information you enter in the active Document. You 
can override the default style with a different style wherever you want. 

When you override default styles, there is a specific order in which style settings are applied:

1 The Default Text setting specifies the “base” level style for your information. It controls the text style 
of information everywhere it is displayed.

2 The next level is applied in the Define Field dialog. This Default Style dialog lets you override the 
document-wide Default Text setting. Choose specific text formatting for information that appears in 
that particular field. See Create or Change a Field Definition on page 54.

3 The next level is applied in the Define Note dialog. The Styles dialog lets you set the text format for 
the selected fields within the selected Note type. Select one or more of the fields in the prototype 
field list. This setting overrides both the document-wide Default Text setting and the field-specific 
Default Style setting. See The Define Note Dialog on page 57.

4 The most specific level is applied when you select information in a field of a Note and select the 
Text menu. This overrides all other text formats. See Text Menu on page 27.

SUMMARY LINES

This dialog is the only place you can control the format of Summary Lines. There is only one setting that 
applies to all types of Notes. It sets the default text format used for the Summary Lines of all Note types in 
the current Document. 

However, you can set the fields that are displayed in Summary Lines for each Note type. Select a Note of 
the appropriate type and select Set Summary Line in the Notes menu. See Summary Lines on page 61. 

TABLES

This sets the text style for information displayed in the columns of Table Views. The information in all 
the columns of a Table have the same formatting.
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You can override this setting for a particular Table. Select the Table, choose View Settings in the Views 
menu, and click View Style. See Show Table on page 90.

FIELD NAMES

This setting controls the style of field names of all fields in all Notes of the current Document. It sets the 
default style for field names. 

TOPIC NAMES

This setting controls the style of all Topics in the current Document. It sets the default style for 
Topic names. 

FOLDER NAMES

This setting controls the style of all Folders in the current Document. It sets the default style for 
Folder names. 

DATE

Date Preferences sets the date style. WebArranger has 
three styles for fields defined as date type: 2/27/96 or 
Tue, Feb 27, 1996 or Tuesday, February 27, 1996. Use 
the pop-up menu to select the date style you prefer.

When you select the Always Convert checkbox, any date 
you enter is converted to the preferred style.

The date/time at the left side of the Topic header bar shows the current date style. This date field can be 
used as a date/time stamp for a Note. Select a Note, and click the date/time in the Topic header bar. The 
date and time is added to your Note. See Topic Header Bar on page 41. 

DOCUMENT

You can set preference settings for each 
WebArranger Document.

As a default, WebArranger does not compress 
files as it saves them. The Document Preferences 
dialog has three checkboxes for save specifications. 
They can be selected independently 
and concurrently:
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FAST SAVES 

We recommend you do not use the Fast Save option. Leaving Fast Save disabled reduces the overall 
WebArranger Document size by up to 50%. Individual savings may vary.

AUTO-SAVE EVERY ___ MINUTES

Sets a time period for regular saves of the Document. This option is not selected by default.

BACKUP AS

By default, we recommend you save your Documents in TAIL format every day. The TAIL format can 
be used as a recovery file in the event that any information is lost or damaged in the original Document. 
TAIL files cannot be password protected.

Without going into a lot of engineering details, WebArranger is built on an object-oriented database — 
this means WebArranger can hold just about any kind of electronic information you can get and you 
arrange it however you want. 

This information is stored in a sort of “object soup.” So, to effectively protect the data, we recommend 
you save it in a more hierarchal file format ... TAIL. 

Saving in the TAIL format may take a bit longer than you are used to. We believe the benefits of 
WebArranger’s power and flexibility are well worth the short time it takes to make a hierarchal snapshot 
of your data.

REPEATING EVENT BEHAVIOR

See Repeating Events on page 107.

PASSWORD

Protect your WebArranger Document with a password.   

HOME DOCUMENT

The Home Document is the default Document that 
opens every time you launch WebArranger. It is also 
the Document that contains the Clippings Topic when 
you use the Grabber. 

WebArranger 2.0 ships with a template ready for your 
use. As recommended in the Installation section, name 
your Document with Save in the File menu as soon as 
you get started. Then, specify your Home Document.
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INTERNET PLUG-IN

Two preferences set the intervals for WebArranger Agent activities. 

URL AGENT

The URL Agent monitors the specified http URLs for changes. 
To specify a URL, put a copy of a URL Note in the Topic, 
URL Agent. The Agent checks the sites for you, so you don’t 
have to look yourself to see if any thing has changed. URL 
Agent puts the URLs of changed sites in the Topic, Changed 
Web Pages. 

Set the intervals here for URL Agent checking. Select the 
checkbox if you want a dialog to alert you when a change has 
been detected. See Start URL Agent on page 112.

❖ Note: URL Agent looks at the last modified field in a Web page’s http header. If this field is not 
present, URL Agent can not work as described and the affected URLs are put in the Changed Web 
Pages with an error field attached. It may be helpful for you to contact the WebMaster at a site 
which does not use this field, if you want its URL checked by URL Agent.

FTP DOWNLOAD AGENT

The FTP Download Agent can save the time spent waiting for an 
Anarchie FTP site to be available for downloading. It 
attempts to download files from the specified ftp URLs 
for you.

To specify a URL, put it in the Topic, FTP Download Agent. The 
Agent puts the downloaded files’ URLs in the Topic, 
Successful FTP Downloads. Each file you want downloaded 
must have its own URL.

Set your intervals for FTP Download Agent attempts in the 
Internet Plug-in Preferences dialog.

FTP stands for File Transfer Protocol. This is a common way of moving files between two Internet sites. 
It’s a special method to login to another Internet site to get and/or send files. There are many Internet 
sites which have established publicly accessible files of material that can be downloaded using FTP.
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THE USER GUIDE

This guide helps you learn how to use WebArranger, and assumes you know how to use the Macintosh 
computer. If you don’t, read the documentation that came with your computer before you continue.

Chapter 2: Notes explains the most basic element of WebArranger.

Chapters 3: Folders &Topics describes how WebArranger can organize your information. 

Chapter 4: Note Fields shows you the various fields that make up Notes and how you can create your 
own Note types.

Chapter 5: Views, Tables & Calendars explains the many ways you can rearrange your information for 
different uses. 

Chapter 6: Tools describes how to use the WebArranger tools.

Chapter 7: Forms shows you how to create Forms and print your information on Forms.

Chapter 8: Finding Information describes how to use WebArranger’s powerful search features to locate 
almost anything.

Chapter 9: Import & Export explains how to import information from other databases.

Chapter 10: Printing goes over how to print information from your WebArranger Document.

YOU WANT MORE?

For more information about the power, flexibility, and cool stuff WebArranger has, see the WebArranger 
Help Document that shipped with WebArranger 2.0.

We’ve embedded a special notifier agent to let you know whenever we update the User Guide. Use 
WebWhacker to get the Documentation ... then you can peruse it off-line!
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CHAPTER 2: NOTES

The Note is the most basic element of WebArranger. 

Without going into a lot of engineering details, WebArranger™ is built on an 
object-oriented database — this means WebArranger can hold just about any kind of 
electronic information you can get. Notes are the objects, akin to records in a database. 
They store your captured information, any way you want ... Notes are completely flexible.

Notes are displayed in a WebArranger Document. A Document is a collection of Notes, which are kept 
in Topics. The Topics are stored in Folders. The flexibility part comes into play because you can move 
the Notes, the Topics, and the Folders around as you want. Plus, the Notes can hold almost any kind of 
information you can get your hands — or wires — on.

NOTE TYPES

WebArranger ships with seven types of Notes. These seven are designed to hold the usual array of 
information you’ll want. You can modify these Notes and create other types. See Chapter 4: Note Fields 
on page 51.

THE SHELF

Buttons and icons for the Note types are stored on the Shelf. 

Click a Note button to create a Note at the current insertion point in 
your Document. 

Click the Note icon and drag, to place it in a different location in the Document. 
The Note icon is beside the Note button.

When you define your own Note types, WebArranger automatically places copies 
of them on the Shelf.

URL

The URL Note stores an Internet address. URL 
means Universal Resource Locator.

TO DO

To Do Notes have a field which links to a URL 
Note. The To Do Note is a fast way to schedule 
your visits to the Internet. You can also use the 
To Do Note to schedule visits to your dentist’s 
office. See Note Link Field on page 68.

Figure 1 The Shelf
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You can place other types of Notes in your calendar, which is in the Web Schedule Topic. However, other 
Note types will not carry forward to the next day. The To Do Note’s advantage is that it stays on your 
calendar until you check the Completed field’s checkbox. See Carry Forward Notes on page 98.     

HEADING

The Heading Note is designed just 
to be a name of a group of Notes. 
For example: You have a Heading 
Note named Milky Way. Your 
group lists your collection of 
URLs that go to Web pages 
featuring news about the galaxy.

PICTURE

A Picture Note lets you display a photo or graphic. 

MEMO

The Memo Note is the generic, no frills Note ... 
you can put graphics and write any thing in a 
Memo Note.

PEOPLE

People Notes hold your contacts information. This example has a Picture 
Note positioned as a Sub-Note. Any Note indented beneath another Note is 
called a Sub-Note. See Sub-Notes on page 30.

FILE

The File Note points to files of any type on your computer. You 
can arrange references to Documents, applications, etc., so you 
don’t have to bring the entire file into WebArranger. 



WebArranger  19

THE ORGANIZER TEMPLATE 

NOTE TYPES

The Organizer Template provides some of the same Note types as the 
WebArranger template: Memo, People, To Do, File, and Picture. The 
Organizer Template does not ship with the URL and Heading Notes. 
Additional Note types in the Organizer are Appointment and Reminder.

See The Organizer Template on page 47.

APPOINTMENT

Keep track of where you’re supposed be when with 
Appointment Notes ... good for the dog’s hair 
styling, your hair cut, a meeting with the Boss, a hot 
date, etc. See Appointment Note on page 21.

REMINDER

The Reminder Note features an alarm to remind you of 
important dates and tasks. WebArranger does not need to be 
running for the reminders to appear. When an alarm is set for 
a Note, a small black set alarm symbol is in the top right of 
the Note’s icon. Reminder Notes are automatically collected 
to the Schedule Topic and displayed on the date set in the Alarm 
on field. See Reminder Note on page 22.
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CREATE NOTES

To add information to WebArranger, you create Notes to store the information. 
New Note in the Notes menu lets you create a Note of any type.

To create a Note:

1 Select New Note in the Notes menu;

■ Or, press -N.

2 Select a Note type from the drop-down list. 

■ WebArranger’s incredible type ahead feature recognizes your existing 
list of Note types. Just begin to type, and as soon as the characters match 
a Note type in your Document, the name is completed. The new Note dialog also offers 
a drop-down list of your Note types.

3 Click OK to create a new Note and 
to exit the dialog.

NEW NOTE SHORTCUT
Press -Return to create a Note.

■ If there is an insertion point in 
the Document, the new Note is 
the same type as the Note with 
the insertion point, and inserts it after that Note.

■ If there isn’t an insertion point, the Note created is of the same type as the default of the Topic. 
If there is no default Note type set for the Topic, the new Note is the same as the last Note in the 
Topic. The new Note is inserted at the end of the Topic.

FILE NOTE

You can link a document from any other program into WebArranger, with a File Note.

1 Create a File Note. 

2 Click the pop-up menu and select Set to display a list of 
documents to link.

3 Select the document.

4 Click Open.

5 The document is linked to the File Note, and the name of the file displays. See File Reference Field 
on page 70.
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APPOINTMENT NOTE

To set up an Appointment Note:

1 Create an Appointment Note. Drag its icon from the Shelf, click its button on the Shelf, or 
press -N.

2 Complete the Summary Line.

3 Complete the Who, Category, Where, and Comments information if you want. 

The Who field is a Note Link field. This means the Appointment Note can be linked to another Note. 
Click and hold the icon to select the Note type you want to be linked. See Note Link Field on 
page 68.

The Category, Where and Comments fields are drop-down list fields. Click the list icon and make a 
selection. Or, type your own information. 

4 Set the Appointment’s date and time in the Begin and End fields. 

Click the little box symbol in the Begin field. The little box is supposed to represent a calendar. It’s a 
stretch ... just work with us on this one. The clock’s not bad. 

Anyway, when you click the calendar, a calendar pops up. Point to the day of your Appointment.

Click the clock and...you guessed it already...a clock pops up. Drag to the time of 
your Appointment.

5 Set your End date and time.
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MORE THAN ONE APPOINTMENT

1 Click the curved arrow to display the Repeating Event dialog. 

2 Select the frequency in the pop-up dialog. 

3 Select the date to disable the repeating Appointment, or enter a number of days for the event 
to repeat. 

4 Click OK.

See Insert Repeating Event on page 107. 

REMINDER NOTE

You can attach an alarm to a Note anywhere, not just the calendar — drag a Reminder Note to any 
Topic page.

To set up a Reminder Note:

1 Create a Reminder Note. Drag its icon 
from the Shelf, click its button on the 
Shelf, or press -N.

2 Complete the Summary Line.

3 Complete the Who information if you 
want. The Who field is a Note Link field. This means the Reminder Note can be linked to a Note you 
want to remember. 

Click and hold the icon to select the Note type you want to be linked.

See Note Link Field on page 68.

4 Click the calendar icon and select the date for the Alarm.

5 Click the clock icon and select the time for the Alarm.

6 Click OK.

7 Press -S to Save your WebArranger Document. You must save after setting an alarm. If you do not 
save your Document after setting an alarm, the alarm won’t go off.

An alarm set symbol is added to the Alarm icon when the alarm is set.

MORE THAN ONE REMINDER

1 Click the curved arrow to display the Repeating Event dialog. 

2 Select the Reminder Note’s frequency in the dialog. 
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3 Select the date to disable the Reminder or enter a number of days. 

4 Click OK.

5 Press -S to Save your WebArranger Document. You must save after setting an alarm. If you do not 
save your Document after setting an alarm, the alarm won’t go off.

See Insert Repeating Event on page 107.

ATTACH ALARM TO OTHER NOTE TYPES

You can attach alarms to any Note type. For example: Attach an alarm to a 
People Note to remind you of a birthday and to a Memo Note to remind you 
to research something before a meeting.

To attach an alarm to one Note:

1 Select the Note. A box appears around the selected Note.

2 Select Set Alarm in the Notes menu to display the Set Alarm dialog.

■ Or, press -E.

3 Set up the alarm.

■ Select a specific date and time for an alarm. If the Note does not contain a date/time field, use 
the first radio button features to select a specific date and time for the alarm to display. The 
features include a calendar icon and time pop-up.

■ Select a relative date and time for an alarm. If the Note contains a date/time field, use the 
second radio button to select a relative time for the alarm to display. Also select which date/
time field on which you want to base the alarm display. You can add a date/time field to any one 
Note if you want to use a relative time with that Note.

For example: If you select the When field, and 
select 5 minutes before the When field’s time, the 
alarm displays five minutes before the time set in 
the Note’s When field.
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ADD AN ALARM TO ALL FUTURE NOTES OF ONE TYPE

1 Choose Note Catalog in the Notes menu.

2 Select a Note type from the list. 
Double-click it to display the Define 
Note dialog. 

■ Or, -double-click a Note icon 
in the Shelf to open the Define 
Note dialog.

3 Select the Alarm on field in the 
pop-up field list.

4 Click >> to add the Alarm on field to the 
Note type.

5 Click OK.

6 Select Set Alarm in the Notes menu or press -E.

Use the second radio button to select a relative time for all Notes of this type. Otherwise, all alarms 
will display at the same time.

7 Select which date/time field on which to base the alarm display time.

8 Click OK.

❖ Note: When you use the Define Note dialog to add an alarm to all Notes of one type, the alarm only 
affects future Notes that you add; it does not affect existing Notes.

THE ALARM DIALOG
When an alarm goes off, a dialog 
appears in whatever program you are 
currently working in to alert you. The 
Alarm dialog appears no matter what 
program you’re running. 

The Alarm dialog displays the type of 
Note that generated the alarm, the name 
of the Document where the Note resides, 
and the time the alarm went off. The 
dialog displays the first seven lines in 
a Note.

The Alarm dialog offers several options:
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■ Click Acknowledge to close the Alarm dialog.

■ If you want the Alarm dialog to display again at a later time, click Snooze this Alarm for ___ minutes 
and specify an amount of time before the alarm displays again.

■ If multiple alarms are going off, click Acknowledge All to turn all Alarm dialogs off. Or click 
Snooze All and specify a time so you can read your alarms at a later time.

■ Click Go to This Note to launch WebArranger and go to the Note whose alarm is displaying.

■ If WebArranger is not running when an Alarm displays, the Go To this Note button says Launch.

CONVERT NOTE

Convert Note changes a Note of one type to another type. The selected Note can be a variety of types. 
They are all converted to the same new type. Convert Note is helpful to combine different kinds of 
information into one new Note type.

Convert Note creates a Note. The information from the 
former Note is copied to the new Note. You never lose 
information when converting. 

■ Fields in both Note types retain their values.

■ Fields included in the new Note only are given 
default values (if any have been defined) or remain empty.

■ Fields from the old Note that aren’t included in the new one are automatically added and retain 
their existing values.

See Chapter 4: Note Fields on page 51.

NOTE AND TEXT SELECTIONS

SELECT TEXT IN A NOTE

You select text in WebArranger just as you would select text in any standard Macintosh application: 

1 Place the cursor where you want to start the selection.

2 Hold down the mouse button.

3 Drag the mouse across the text you want to select.
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KEYBOARD SHORTCUTS

Table 1 Text selection

SELECT NOTE

1 To select an entire Note, click the Note’s icon. When a Note is selected, it is boxed.

2 To deselect a Note, 
click an empty part of 
the Topic area. If the 
Topic area is filled 
with Notes, you can 
click the empty area of 
the bar directly above the Topic area. This bar is called the Topic header bar. See Topic Header Bar on 
page 41.

SELECT MULTIPLE NOTES

To select multiple Notes, hold down the Shift key and click the icons of the Notes you want. You can 
select any number of Notes in any number of places in the Topic area. Selection rectangles appear 
around each selected Note. Subsequent operations apply to all selected Notes.

Text Selection
Action Press

Move the insertion point forward and backward Left and right arrow keys

Extend or reduce the selection by one character at 
a time

Hold down the Shift key and press 
the left and right arrow keys

Move the insertion point one line Up and down arrow keys

Extend or reduce the selection by a line at a time. Hold down the Shift key and press 
the up and down arrow keys

Select all text in a Memo Note or in a field

Hold down the Option key and choose Select Text in the Edit menu

Press -Option-A

Hold down the Option key and use the Left and Right arrow keys to move the insertion point 
by words

Triple-click the mouse anywhere within the text.

To select field text

Hold down the mouse button while dragging across the text you want to select.

Click the field contents, hold down the Option key, and choose Select Text in the Edit menu.

Click the field contents and press -Option-A

Figure 2 The Topic header bar 
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TEXT MENU

The Text menu offers text formatting features. The effect of a command depends 
upon the current selection.

■ If text is selected, the changes you make are applied to the selected text. 

■ If one or more Notes or fields is selected, the changes are applied to all 
selected Notes.

■ If there isn’t a current selection, the Text menu is disabled.

The Font submenu lists all fonts currently available in your System.

The Text menu includes six standard font sizes. To use a different size, select Other... 
and enter the font size in the dialog. 

Four standard text styles are listed in the Text menu. The Other submenu offers 
four more. 

The Color submenu includes five standard colors. Choose Other… to set a custom color.

You can justify selected text as Left, Center, or Right. Justification works only on text fields. It does not 
work on date and number fields.

JUSTIFY TEXT FOR ALL NOTES OF ONE TYPE

1 Select Note Catalog in the Notes menu, and select a Note type to display the Define Note dialog.

■ -click a Note name to go to the Define Note dialog.

See The Define Note Dialog on page 57.

2 Put the insertion point in a text field to select that field.

3 Select Justification in the Text menu.

4 Choose Center, Left, or Right.

5 Click OK.

Every time a Note of that type appears, text in the field you selected is justified.
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ORGANIZE YOUR NOTES 

MOVE NOTES

To move a Note:

1 Drag and drop it. Click and hold the mouse button down on the Note’s icon. 

2 As you drag the Note, a gray rectangle representing the Note follows the mouse movements. A gray 
destination bar appears in the Topic area at locations where you can drop the Note. The Note can 
only be placed before or after other Notes; it cannot be placed within the text of a Note.

3 The Note itself stays in its original position in the Document until you release the mouse button. 
The Note then moves to the destination you select. 

If you have multiple Notes selected, they all move to the new location. 

If you want to drag a Note to a position that is beyond the top or bottom edge of the Topic area, drag 
and hold the Note over either place. The Topic area scrolls in the appropriate direction.

Moving Notes is just one example of how drag and drop works in WebArranger. As you learn your way 
around, you’ll find that drag and drop is often the easiest way to manipulate your information.

CUT, COPY, AND PASTE

The Macintosh Clipboard holds information as it is moved from one place to 
another. You move information to and from the Clipboard Cut, Copy, and Paste in the 
Edit menu.

To remove a Note from your Document, select the Note(s) you want to remove, 
then choose Cut.

To move a Note (or Notes) from the Clipboard to your Document, choose Paste. 
You can Paste a Note in any Topic. Topics are described in further detail in Chapter 
3: Folders & Topics on page 39..

❖ Note: A Topic can only contain a single copy of a Note. If you try to Paste 
multiple copies of a Note in the same Topic, WebArranger moves the Note instead.

You can also move linked copies of Notes with the Copy and Paste commands. See Linked Notes on 
page 34.

When you select Paste with no Notes selected, the Clipboard contents are inserted at the end of your list 
of Notes. When you select Paste with a Note selected the Clipboard contents are inserted after the 
selected Note.
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MOVE NOTES BETWEEN TOPICS

Moving copies of Notes between Topics is one of WebArranger’s most powerful tools. A single Note 
can be copied into multiple Topics. Each place a Note appears is called an appearance. Notes can 
appear in any number of Topics, though typically only once as a top-level Note per Topic.

USE THE SHELF 

To move a Note from one Topic to another, drag the Note to the Shelf. Press the Option key to drag 
linked Notes to or from the Shelf. See Linked Notes on page 34.

Then open the other Topic, and drag the Note from the Shelf where you want.

You may find this easier than dragging a Note from another Topic. When you just drag a Note from one 
Topic to another, the Note is put at the bottom of the Topic. After you find it, you must drag the Note 
again to place it where you want.

You can move Notes between Topics at any time, making it very easy to organize and access your 
information. You can also move Notes between Topics with Cut and Paste in the Edit menu.

DRAG AND DROP
To move a Note to a different Topic:

1 Click the Note’s icon in the Topic area.

2 Hold down the mouse button and drag the Note to the Contents list.

3 Position the cursor over the target Topic. A destination rectangle appears around the Topic.

4 Release the mouse button.

The Note is removed from the selected Topic and added to the end of the target Topic. The original 
Topic remains displayed in the Topic area.

See The Contents List on page 41.
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SUB-NOTES 

It’s often useful to attach pieces of information together. 
Staplers and paper clips are common tools for this. In 
WebArranger, you attach information together by making 
one Note a Sub-Note of another Note. This lets you 
structure your information into an outline. 

The Notes to which Sub-Notes are attached are called 
parents. A Sub-Note remains attached to its parent Note 
when you move it. A Note can have 50 Sub-Notes.

LEVELS

Sub-Notes can also be parent Notes to other Sub-Notes. Like 
items in an outline, the Sub-Notes of a Note are grouped into 
levels. The number of Sub-Notes you can create at any level 
is limited only by the amount of memory that’s available to WebArranger. The maximum number of 
Sub-Note levels is 15.

Notes located at the top level of your Topic are 
called top-level Notes. The number of top-level Notes 
in a Topic is indicated on the right side of the Topic 
header bar. 

The number of top-level Notes gives you a quick idea of the scope of a Topic. You can also get a count 
of the total number of Notes in a Topic — top-level Notes and all their Sub-Notes — with a View. See 
Chapter 5: Views, Tables & Calendars on page 72.

MAKE AN EXISTING NOTE INTO A SUB-NOTE

To make a Sub-Note:

1 Click the Note’s icon to select it. 

2 Drag the Note beneath another Note. A destination rectangle indicates where the Note will 
be placed.

3 Drag the Note to the right. As you drag, the destination bar indents to show you the Note will a 
Sub-Note of the Note above. 

4 Release the mouse button. If the Note has any Sub-Notes, they are dragged also. When dropped, the 
Sub-Notes retain their relative levels.

Figure 3 Notes and Sub-Notes
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CREATE A SUB-NOTE

To create a Sub-Note:

1 Select the parent Note, and:

2 Hold down the Option key and choose New Note;

■ Or, press -Option-Return;

■ Or, hold down the Option key and click one a Note type button on the Shelf.

3 A Sub-Note is created below the current insertion point or selection in your Document.

THE TRIANGLE

The triangle is the Note Control and manages the display 
of Sub-Notes. By default, the triangle is empty. When a 
Note has one or more Sub-Notes, the triangle is dark. This 
indicates the Note has Sub-Notes.

To expand a Note and display its Sub-Notes, click the 
triangle. The triangle points down, and the 
Sub-Notes display.

To collapse a Note and hide its Sub-Notes, click the triangle again.

UPDATING THE TRIANGLE

When a Note is copied, the triangle for each appearance of the Note is updated to reflect the Note’s 
new status.

The triangle changes from a small triangle to a double triangle. This indicates there is more than one 
appearance of the Note. This change only happens when you make the first copy of a Note. Subsequent 
copies don’t change the Note control.

❖ Note: A Note appearing only once has a single triangle Note control. A Note appearing more than 
once has a double triangle Note control.

MAKE SELECTIONS WITH SUB-NOTES

When you select a Note, the rectangle displays around it. When a Note is expanded and its Sub-Notes 
are displayed, the rectangle extends to include the Sub-Notes. When you move a Note, its Sub-Notes 
move with it. 
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APPLY FORMATS TO SELECTIONS

When you make format changes to a Note, the changes are not applied to Sub-Notes. 

To make changes to Sub-Notes too, select the parent Note and select the Sub-Notes individually. Hold 
down the Shift key and click each one. A selection rectangle displays around each individual Note.

To select all Notes in a Topic, regardless of their level: 

■ Hold down the Shift key and choose Select All Levels in the Edit menu;

■ Or, press -Shift-A.

■ To select just the text in a Memo Note or field containing the insertion point, hold down the 
Option key, then choose Select Text.

You can also use Select in the Edit menu to select Notes that match a certain description.

PROMOTE AND DEMOTE NOTES

When a Note is promoted, it’s moved so that it’s at the same or higher level as its parent Note. The 
Note’s Sub-Notes move with it. They remain Sub-Notes.

When a Note is demoted, it’s moved so that it’s at the same or lower level as its Sub-Notes were. The 
Note’s Sub-Notes move with it. They remain Sub-Notes.

To promote or demote a Note:

1 Select the Note.

2 Drag the Note to the left to promote it or to the right to demote it. The destination bar moves to the 
left or right, indicating the level to which the Note will be moved. If the Note is already at the top 
level, you won’t be able to promote it.

3 Release the mouse button.

You cannot drag Notes to an undefined position. You can only drag a Note to top-level Note or 
Sub-Note level. 

You can move a Note to a different location at the same time that you’re promoting or demoting it. Drag 
it vertically to the correct place and then horizontally to the correct level in the list.

You can select multiple items and promote or demote them all at one time. When multiple Notes are 
moved in this manner, they are all moved to the location that the first selected Note would have moved 
to if it had been moved individually.
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OUTLINE

The various Note manipulations described above can also be performed with menu commands or 
keyboard shortcuts. 

Table 2 Outline menu commands and keyboard shortcuts for Note manipulation

COPY NOTES BETWEEN TOPICS

When you move a Note between Topics, you remove it from one Topic and add it to another. Sometimes 
you may want a single Note to appear in more than one Topic. For example: You have a Topic for friends 
and another for business contacts, you may have a person who falls into both categories.

Instead of moving, you can copy a Note from one Topic to another. This creates a linked copy of the 
Note. See Linked Notes on page 34.

❖ Note: The new location must be a different Topic. Otherwise, the Note is moved rather than copied

To copy a Note to another Topic:

1 Hold down the Option key.

2 Click and hold the Note’s icon in the Topic area.

3 Drag the Note to the new Topic.

Keyboard 
Shortcut

Outline in Edit Menu 
Command Use

-Up Arrow Move Up Move Note up in the Topic.

-Down Arrow Move Down Move Note down in the Topic.

-' Select the Note(s) 
and select Expand

Expand the first level of Sub-Notes.

N/A Select the Note(s) 
and select Expand To. 
Enter the number of 
levels to expand 

Expand more than one level of Sub-Notes.

-; Collapse Collapse the first level of Sub-Notes.

N/A Select the Note(s) 
and select Collapse All. 

Collapse all levels of Sub-Notes.

-Left Arrow Promote Promote one or more Notes.

-Right Arrow Demote Demote one or more Notes.
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4 Release the mouse button. The Note is copied from the selected Topic and added to the destination 
Topic. The original Topic is still displayed in the Topic area.

❖ Note: Copy and Paste in the Edit menu also create a linked copy of the Note.When you Copy and Paste 
within the same Topic, the Note is moved. It is not copied, since a Note can appear as a top-level 
Note only once per Topic.

❖ Note: WebArranger’s Topic Agents automatically copy Notes for you. See Topic Agents on 
page 46. 

LINKED NOTES

Multiple appearances of a Note aren’t just copies of the original Note. All appearances are linked...we 
call them clones. The information contained in a Note is shared among all appearances of that Note. 
This keeps all the information you manage with WebArranger accurate and consistent.

We think Linked Notes are so great because WebArranger copies and updates Note information from 
one place. You’ll never need to enter information twice. Once you enter information anywhere, it is 
cloned — and put in the other appearances, any number of times, in any number of Topics. You’ll never 
have to reconcile information again!

If you make a change to one appearance of a Note, the change is made in all other appearances of that 
Note unless you specify otherwise. See Create an Unlinked Copy of a Note on page 34.

Sub-Notes of the linked Note are also shared among the Note’s clones. For example: When you add a 
Reminder Sub-Note to a People Note in your Friends Topic, that Sub-Note is also added to the People 
Note in your Business Contacts Topic.

CREATE AN UNLINKED COPY OF A NOTE

Duplicate Note provides a convenient way to create a copy of a Note without linking it to the original.

To make an unlinked copy:

1 Select the Note to copy.

2 Choose Duplicate Note in the Edit menu.

A copy of the Note appears directly beneath the original Note. The original Note and the copied 
Note are not linked.

3 Drag the unlinked copy to any location in your Document.
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DETACH NOTES

When you create multiple appearances of a Note and then later need to disconnect them, you can detach 
them. For example: You want to update a phone number in one appearance of a Note but not in others. 

To detach a Note from its other appearances:

1 Select the Note to detach.

2 Choose Detach Note in the Notes menu. 

The triangle of the detached Note is single.This indicates the selected Note is detached from other 
copies of the same Note. 

Once a Note is detached, changes made to it are not reflected in other appearances of the Note. 
Similarly, changes made to other appearances are not reflected in the detached copy. All other 
appearances of the Note remain linked. 

❖ Note: When a detached Note is auto-gathered by a Topic agent, it automatically becomes linked 
again. See Auto-Gather Notes into a Topic on page 46.

DELETE NOTES

Chances are you’ll find certain Notes no longer useful. For example: A project is completed, a task 
done, or a business contact retired. When a Note is no longer needed, you can delete it.

If a Note has only a single appearance, deleting it is simple. However, if you want to delete a Note 
appearing in more than one place in your Document, you’ll need to decide whether to delete just an 
individual appearance or all appearances of the Note. 

You’ll typically delete a single appearance if the way you use the Note has changed and you want to 
remove the Note from a particular Topic but not from others. You’ll typically delete all appearances of a 
Note if the information in the Note itself is no longer useful.

DELETE A SINGLE APPEARANCE OF A NOTE
To delete one appearance of a Note:

1 Select the Note to delete. 

2 Press the Delete key, or choose Clear in the Edit menu. The Note is removed from its Topic, but all 
other appearances of the Note remain unchanged. 

If deleting one appearance of a Note leaves only one other appearance of the Note, the triangle for the 
remaining appearance is changed to a single triangle.
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Use the Trash Topic to Delete a Note
You can also delete Notes by dragging them to the Trash Topic.

❖ Note: Things thrown in the Trash Topic aren’t actually deleted until you choose Empty Trash. 
Dragging things to the Trash is a good way of getting them out of the way without permanently 
deleting them. Just click the Trash to select what you want, and drag-n-drop it out.

To delete a Note using the Trash Topic:

1 Click and hold on the Note’s icon in the Topic area.

2 Drag the Note to the Trash Topic and release the mouse button.

3 When you’re sure you want to permanently delete the items in the Trash, choose Empty Trash in the 
Edit menu.

▲ WARNING: You can also drag Folders and Topics to remove to the Trash to remove them. When you 
Trash a Folder, you are also trashing its Topics and Notes!

DESTROY ALL APPEARANCES OF A NOTE
To remove all appearances of a Note:

1 Select any appearance of the Note to 
be destroyed.

2 Choose Destroy Note in the Edit menu;

■ Or, press -Delete.

A warning dialog asks you to confirm your decision.

3 Click OK. All appearances of the Note are destroyed.
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CHAPTER 3: FOLDERS & TOPICS

In this chapter, you’ll learn about Topics and Folders, and you’ll find out how all these 
pieces work together to make WebArranger a truly revolutionary management tool.

A Topic is a list of Notes and their attached Sub-Notes. You can work with several 
Topics in the same Document. And, you can organize your Topics into Folders, just as 
you would file multiple papers into a subject Folder.

FOLDERS

In WebArranger you use Folders to organize your Topics. You can create, rename, and delete Folders, 
and move Topics from one Folder to another. 

CREATE A FOLDER

To create a Folder:

1 Select New Folder in the Topics menu;

Or, click the New Folder button.

2 The new Folder displays in the Contents list, with 
the default name of untitled. The Folder name is 
highlighted with an edit box for the real name.

3 Type a name for the Folder and press Return.

SELECT A FOLDER

Click the Folder name in the Contents list to select it. When a Folder is selected, the Topic header bar shows 
the Folder’s name and the number of Topics in the Folder. You can also select a Folder with Go To. See 
page 42.

❖ Note: The Topic area under the Topic header bar is always empty when you select a Folder.

OPEN AND CLOSE FOLDERS

To open a Folder, click the Folder’s icon. Make sure you click the icon. When you click the Folder 
name, the Folder stays closed and the Folder name is selected.

The Topics contained in a Folder display beneath it in the Contents list.The icon changes to show the 
Folder is open. 

To close a Folder, click the Folder’s icon again. The contents of the Folder are hidden and the icon 
changes to show the Folder is closed. 

Figure 4 New Folder button
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MOVE TOPICS BETWEEN FOLDERS

You can move Topics between Folders at any time. To move a Topic, click the Topic in the Contents list 
and drag it to a new position.

You can drag a Topic to another Folder whether the destination Folder is currently open or closed. If the 
Folder is closed, a frame displays around the Folder name. Release the mouse button when you see the 
frame to move the Topic to the end of the list of Topics.

As you drag a Topic around the Contents list, a gray destination bar displays to indicate where the Topic 
will be moved when you release the mouse button.

See Move Information Between Documents on page 48.

RENAME A FOLDER

You can rename a Folder at any time. To rename a Folder:

1 Double-click its name in the Contents list.

2 Type the name in the edit box.

3 Press Return or click outside the edit box.

OR:

1 Click the Folder’s name in the Topic header bar.

2 Enter a name in the edit box.

DELETE A FOLDER

You can delete a Folder at any time. Deleting a Folder removes all Topics and Notes in it as well. To 
delete a Folder:

1 Select a Folder in the Contents list.

2 Choose Delete Folder in the Topics menu.

A warning dialog asks you to verify that you want to delete all the Topics in this Folder.
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TOPICS

TOPIC HEADER BAR

.The area of the window 
where you edit your 
Notes is called the Topic 
area. The bar directly 
above is known as the 
Topic header bar. The 
Topic header bar is green 
on color displays, gray 
on grayscale, and white 
on black-and-white.

Topic header bars are similar to the title bars on normal Macintosh windows. They display the Topic 
name in the center of the bar. The left side of the Topic header bar displays the current date and time, 
and also acts as a “stamp.” Click the date and time display to insert the current date and time at the 
insertion point.

The right side of the Topic header bar displays the number of top-level Notes in the Topic. 

THE CONTENTS LIST

The Contents list shows all Folders and Topics in the current Document. 
At any time, only one Folder or Topic is selected in the Contents list. 
The Notes in the selected Topic are displayed in the Topic area of the 
Document window.

The first item in the Contents always shows the name of the open Document. 
This is called the Document Folder. 

The Contents also includes individual Topics, which you create and delete 
with the commands in the Topics menu. 

The first Folder in the Contents is normally Jump Start. You can rearrange and 
rename anything in the Contents.

When you create a Document, WebArranger makes a number of Topics 
for you and selects the Document Folder. It is untitled until you name 
the Document. 

You can rearrange, create, or delete Topics at any time. Any Topics you 
create are added to the Contents list. See The Organizer Template on page 47. 

Date and time display and “stamp” Number of top-level Notes

Figure 5 The Topic header bar

Figure 6 The Contents List
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THE TRASH TOPIC

The Trash Topic is the last Topic in the Contents list. The Trash Topic works just like the Finder’s trash can. 
You can delete a Folder, Topic, or Note by dragging it to the Trash Topic. You can view the contents of the 
Trash Topic by selecting the Trash Topic in the Contents list. The contents of the Trash Topic are not deleted 
until you choose Empty Trash in the Edit menu. You can drag items out of the Trash Topic, if you haven’t 
emptied it since you dragged the item to the Trash Topic.

CONTENTS LIST DISPLAY OPTIONS

Show All Folders in Contents in the Topics menu is the default.

■ Show Just This Folder — Hides all other Folders in 
the Contents list. This is useful when you have a Folder 
with a large number of Topics.

■ Name View — Hides the Topic icons and displays only the Topic names. This is useful when 
you have a lot of Topics or long Topic names. When the icons are not displayed, each Topic 
entry in the Contents list occupies less room both horizontally and vertically.

■ Icon View — Displays the Topic icons, and is the default

SELECT AND REARRANGE TOPICS

■ Click a Topic in the Contents list to select it. 

■ Click and drag to rearrange entries in the Contents list. You can drag and drop entries in the 
Contents list and to other WebArranger Document Contents lists. 

GO TO

You can also select Folders, Topics and Views with Go To 
in the Topics menu. This is convenient when:

■ The Contents list is hidden

■ There are many Topics in the Contents list and 
you’re working on a small display

■ You don’t want to take your hands from the keyboard 

The Go To dialog has a single text edit box. Type the name of the Folder, Topic, or View, and press 
Return or click OK. 

When you enter a name that is not in the Contents list, the text displays in italics. This indicates 
WebArranger cannot find the Topic, Folder or View.
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MATCHING MESSAGE AREA

Below the edit box is a Matching message area. The Go To dialog displays the Folder, Topic, or View it is 
currently matching. If the text you enter doesn’t match anything in the Contents list, the message area 
displays No Match Found.

When you first choose Go To, the message area displays the name of the first Topic in the Contents list. 
This is the default match of the Go To dialog.

INTELLIGENT GO TO

The text edit box in the Go To dialog includes a number of features that make it smarter than the 
average text edit box:

■ As you enter text into the edit box, it automatically completes what you are typing with the first 
item in the Contents list that matches. If you agree, press Return to go to that choice. If you don’t 
agree, continue typing.

■ When you have Topics and Views with the same name, you can specify which one to go to. 
Enter a colon (:) between Topic and View names.

For example: You have a View of your Contacts list called “In a Table.” Another View of your 
To Dos is also called “In a Table.” The Go To dialog always matches whichever one comes 
first in the Contents list. To get around this, enter Contacts:In a Table or To Dos:In a Table to 
distinguish between them.

■ Wild card characters can help you choose between Topics and Views with similar names. See 
Wild Cards on page 143.

For example: You have three Topics called “King Lear Act 1,” “King Lear Act 2,” and “King 
Lear Act 3.” Instead of typing the full text to choose these Topics, you can use the ≈ (Option-x) 
character. The ≈ matches any number of other characters. In this example, you can just enter 
“≈1” to match “King Lear Act 1,” or “≈2” to match “King Lear Act 2,” and so on.

These techniques can be used in combination. It is a very powerful way to navigate in your 
WebArranger Document.
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ORGANIZE WITH TOPICS

Topics are a great way of collecting information, putting off the details of categorizing or organizing it 
until later. However, there are a few organizational principles for Topics. 

Table 3 Topic guidelines

CREATE A TOPIC

To create a Topic:

1 Choose New Topic in the Topics menu.

■ Or, click the New Topic button. 

The new Topic displays in the Contents list, with the default name 
“untitled.” The Topic name is highlighted with an edit box so you 
can type a more appropriate name.

2 Type a Topic name and press Return. 

The Topic area is always blank after you create a Topic. There are 
no Notes in it yet. The Topic’s name is displayed in the center of the Topic header bar.

RENAME A TOPIC

You can rename a Topic at any time:

1 Double-click its name in the Contents list.

Topic Type Description Examples

Categories Information that’s categorized into related 
groups, making it easier to understand and 
control.

A list of under-performing public 
companies; sales prospects generated 
through telemarketing; books to read.

Projects Tasks that have a well-defined beginning 
and end. A collection of information with 
only one common element: it all applies to 
the task at hand.

Sharing overlapping resources (create 
multiple appearances of the appropriate 
Notes, sharing people, tasks, and 
resources just by clicking and dragging).

Collections A specific set of things. Store inventory; the set of books in 
a collection.

Priorities Tasks that need to be listed, arranged, and 
managed in priority order.

Things you must do; things you need to do; 
things you’d like to do.

Focus Time critical information that needs to be 
isolated from all other details.

A deadline; an urgent phone message; an 
unexpected crisis.

Paper Sometimes the best way to use a Topic is 
the same way that you would a blank piece 
of paper.

To take Notes in a meeting, or just before 
starting an important phone call, or when 
you need to brainstorm some ideas.
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2 Type the new name in the edit box.

3 Press Return or click outside the edit box.

OR:

1 Click the 
Topic’s name 
in the Topic 
header bar. 

2 Enter a 
different name in the edit box.  

OR:
■ Select Topic Settings in the Topics menu.

OR:
■  Hold down the Command key and click a Topic in the Contents list.

TOPIC SETTINGS DIALOG

To change the current Topic’s name, type the name in 
the Topic Name edit box. 

To change the Topic icon, click Topic Icons and select a 
new icon in the dialog.

SET A TOPIC’S DEFAULT NOTE TYPE

Every Topic has a default Note type. When you create a Note using the -Return shortcut, the Note 
created is of the default Note type for the current Topic. WebArranger uses the default Note type 
to determine what fields to display in many other places. 

To change the default Note type, select from the Default Note Type drop-down list.

Figure 7 The edit box on the Topic header bar.
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AUTO-GATHER NOTES INTO A TOPIC

Auto-Gather Notes of Types lets you decide which Notes to auto-gather into a Topic. Indicate the Note 
type(s) you want from the drop-down list. 

Sometimes just organizing information by Topic isn’t enough. Finding stuff can be tricky. For example: 
A person whose phone number you need moves from Topic to Topic over time. It is difficult to find her 
unless you remember exactly where she is in your WebArranger Document.

TOPIC AGENTS

WebArranger ships with some default auto-gather selections, which we call Topic Agents. Certain 
Topics automatically collect their corresponding Note types. Topic Agents organize all information in 
your Document by collecting specified Note types. See Table 4 on page 46

When you make a Note of a type specified in auto-gather or by the Topic Agents, WebArranger 
automatically creates a linked copy of the Note in the appropriate Topic.   

Table 4 Topic Agents settings

Whenever you want to find a particular type of information, switch to the Topic that auto-gathers that 
Note type. WebArranger automatically placed a copy of the Note there for you. 

❖ Note: Changes made to linked Notes apply everywhere the original Note appears.

DELETE A TOPIC

You can delete a Topic at any time. When you 
delete a Topic, all Notes in the Topic are removed 
as well. To delete a Topic:

1 Select the Topic in the Contents list.

2 Choose Delete Topic in the Topics menu.

Topic Auto-gathers Note type

WebArranger Template

Web Schedule URL and To Do

People People

History URL and To Do

Organizer Template

Contacts People

Schedule Appointment, Reminder, and To Do

To Do To Do
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A warning dialog asks you to verify that you want to delete all Notes in this Topic.

THE ORGANIZER TEMPLATE 

The Organizer Template ships with three Folders — My Data, Organizer, and 
Trash. It provides other Topics and Note types to help you manage information. 
See The Organizer Template on page 19.

The My Data Folder is ready for your own Topics.To 
open the Organizer Template:

1 Select New in the File menu.

2 Select Organizer Template.

3 Click Open.

4 Select Save in the File menu.

5 Give your Organizer Document a name.

6 Click OK.

TOPICS

In addition to a Clippings Topic, the Organizer Folder ships with three Topics.

CONTACTS

This is a great place to put your People Notes. Several Views give you different angles to see your 
contacts, such as Sorted by Last Name and Sorted by Company. The default Note type is People, and this 
Topic auto-gathers People Notes.

SCHEDULE

Your calendar is in the Schedule Topic, with a variety of Views to help you be on time and together. 
The Views provided are Calendar, Today, Week and Month. The default Note type is Appointment. This 
Topic auto-gathers Appointment, Reminder, and To Do Notes.

TO DO

Put your To Do Notes here. You can look at your To Do list in three Views — Sorted by Priority, 
High Priority only, or those which are Completed. The default Note type is To Do, and this Topic 
auto-gathers To Do Notes.
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For example: You create a To Do Note anywhere in your Document, and a copy is automatically 
gathered into the To Do Topic.

The Topics in the Organizer Folder are automatically created in every Document, the same as standard 
Notes are created in every Document. Just as you can add to the Note types that WebArranger 
understands, you can also create Organizer Topics to automatically organize the new Note types 
you define.

MOVE INFORMATION BETWEEN DOCUMENTS

The number of WebArranger Documents that you can have open simultaneously is limited only by 
available memory. From time to time, you’ll probably want to move information from one Document to 
another. WebArranger lets you do this in a number of ways.

DRAG INFORMATION

The simplest way to move information between WebArranger Documents is to open both Documents, 
and click and drag information between them.

You can select one or more Notes in a Document and drag them to another Document window the same 
way you’d drag them to another window of the same Document. 

The Notes are copied to the target Document, but do not remain linked to the copies in the original. 
If the target Document does not have the correct Note types or field types defined, the definitions 
are created.

DRAG DEFINITIONS

If you’d like to teach a Document about a particular kind of Note without actually transferring any 
Notes of that type, you can drag Note definition buttons from either the Shelf or the Note Catalog of one 
Document to the Shelf or Note Catalog of the other. You can also copy field definitions in this manner.

DRAG TOPICS

You can move an entire Topic from one Document to another. Click and drag the Topic from the 
Contents list of one Document’s window to the Contents list of the other. All the Topic’s information —
Notes, settings, Views, and so on — are copied.

COPY AND PASTE INFORMATION

You can also use Copy and Paste to move Notes, text, or pictures between Documents. Copy something 
from one Document, select the window of another, and paste. However, you can’t use Copy and Paste to 
move Note or field definitions between Documents.
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IMPORT AND EXPORT COMMANDS

Although you’ll normally use Import and Export to share information with other programs, you can also 
use them to move information between Documents. This is especially useful if you’d like to rearrange 
some fields along the way.

To move information between Documents in this manner:

1 Export a Topic or View from the original Document. Select one of the structured formats, like Tab 
or Comma Delimited. 

2 Close the original Document and open the target Document.

3 Select Import to bring the information into the Document. In the Import dialog, select the Note type 
and fields into which the information will be imported. 

This lets you rearrange the information from Note type to Note type and from field to field. However, 
it’s not a perfect solution. Structured import and export formats, like Tab and Comma Delimited, can’t 
handle certain kinds of information, such as graphics or Note Link fields. See Chapter 9: Import & Export 
on page 155.
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CHAPTER 4: NOTE FIELDS

The generic Memo Note is perfect for organizing certain kinds of information. It lets 
you jot down any unstructured type of information — an idea, a limerick, someone’s 
movie recommendation — without breaking the information into precise pieces. How-
ever, some times it’s more convenient to have structure. Structured information is all 
around us: a bibliography reference, a person’s business card, a While-You-Were-Out 
message form. 

WebArranger uses structured Notes to manage structured information the same way you use paper 
forms. Structured Notes break information into separate parts. In a structured Note, each part is called 
a field. 

THE RESPONSIBILITY OF FLEXIBILITY

Standard Notes manage the most basic kinds of information. Usually these standard Notes will satisfy 
your needs. See Note Types on page 17.

When they don’t, you can customize them. You can also create Note types. You can modify existing 
fields or define new fields, and control which fields appear in which Notes. The maximum number of 
fields in a Note is 100. And, you can assign icons to Notes, customize Summary Lines, and convert 
Notes from one type to another. You can customize Notes and fields at any time, before or after you’ve 
entered information in them, and much more. 

However, with this ability comes responsibility. You should clearly understand the behavior of the 
appropriate commands before you apply them to your data.

■ When you add a field to a Note’s definition, information already stored in the Note’s fields is 
not affected. 

■ When you remove a field, all information stored in that field is removed. Exercise caution when 
you use any command that deletes information.

■ When you modify a field definition, it alters the kind of information that field can store. 
WebArranger does its best to translate information in existing fields whenever you change the 
field’s definition, but sometimes it can’t. For example: You change a field from a Picture field to 
a Text field. The pictures you’ve stored in all appearances of that field are lost. 

➣ IMPORTANT: WebArranger always warns you and asks for confirmation before performing 
data-threatening operations.



52 WebArranger

THE FIELD CATALOG

Every Note and field in WebArranger has a definition...a 
description of the basic properties of that Note or field. Fields 
hold information. Each field has a name and a type, as well 
as a default value. Fields always appear within Notes, never 
by themselves. WebArranger’s standard Note types have 
pre-defined fields.

Structured Notes such as the People Note contain a list of fields instead of the empty text in the 
Memo Note. Fields always appear in a single list within structured Notes. Fields can contain more 
than one line.

Before you can add a field to a Note, create the field...decide the basic properties that comprise a 
field’s definition: 

■ the field name

■ the kind of information it will contain

■ the field’s default format and contents

❖ Note: Modifying a field’s definition means changing one or more of these properties. It’s important 
to understand when you modify the definition of a field, you modify that field in all places it 
appears. You cannot change a field definition in only one place. However, you can customize an 
individual Note so that it contains different fields than other Notes of the same type. See Add Field 
to Single Note on page 60. 

All defined fields are listed in the Field Catalog. WebArranger’s standard Note types have pre-defined 
fields. Each Document has its own Field Catalog. To open the Field Catalog:

■ Click the Field Catalog icon on the Icon Bar;

■ Or, choose Field Catalog in the Notes menu.
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The Field Catalog is a modeless dialog. It doesn’t lock you into a 
single mode of action. It doesn’t have OK or Cancel buttons. 

■ The Field Catalog remains open when you bring another 
WebArranger window to the front. 

■ You can drag the Field Catalog dialog anywhere on 
your screen.

■ Click the close box to close it.

FIELD DEFINITION LIST

The field definition list is on the left side of the Field Catalog dialog. It 
is a directory of all fields defined in the current Document. The little icon to the left of each field name 
helps identify the field type. See Field Types on page 66.

Click to select field definitions from the list. Click and drag within the list to rearrange them.

Buttons are on the right side. These buttons modify the list of field definitions. See Table 6 on page 54.

SORT BY
The field list’s Sort by drop-down list controls the order in which fields are displayed. 
See Table 5.

Table 5 The actions of the Sort by drop down list 

Sort by Description Example

creation 
(date)

Sorts fields by the date they were first 
defined.

Group fields that were created together, or 
group fields you’re currently working on.

field name Sorts fields in alphabetical order by 
field name.

Find a field based on its name.

field type Sorts fields based on the type of 
information they can contain.
Groups all Date/Time fields, then all 
Text fields, etc.
Within a group of fields of the same 
type, fields are sorted by their
previous order in the list.

See all fields you use in a certain way, spot 
misspellings, and find existing fields of a 
given type to re-use in other ways.
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BUTTONS
The buttons in the Field Catalog dialog affect the field definitions in your Document.                

Table 6 Field Catalog button actions

CREATE OR CHANGE A FIELD DEFINITION

To add or edit Fields:

1 Click Define New or Edit to display the Define Field dialog. 

2 Set the name of the field in the Field Name edit box.

3 Select from the Field Type drop-down list. See Field Types on 
page 66.

4 To set a default value for the field, type it in the Initial Value edit 
box. See Table 7 for formatting instructions.

5 Click OK. See Note Link Field on page 68.

Button Use

Define New Opens the Define Field dialog to create field definitions. You don’t need to select a 
field definition before you select the Define New button. It creates a field definition 
instead of modifying an existing one. See Create or Change a Field Definition on 
page 54.

-click a field’s name to open the Define Field dialog for that field.

Edit Opens the Define Field dialog to modify the selected field definition.

Duplicate Creates a field definition based on the selected field definition.

Delete Removes a field definition from your Document. Also removes the field from all 
Notes that contain it, and deletes all information stored in fields of this type. This 
can be a dangerous operation, so use it with caution.
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Table 7 How to format a field definition

❖ Note: Add a field definition to the Shelf for easy access. Drag the field from the Field Catalog to the 
Shelf. See Note Definitions on the Shelf on page 59.

NOTE CATALOG

The Note Catalog is a directory of all Note types defined in a 
particular Document. The Notes types vary from Document 
to Document, based on those defined in each one. The Note 
Catalog dialog is similar to the Field Catalog dialog. It doesn’t have 
OK or Cancel buttons. See The Field Catalog on page 52.

You change all Notes of a type, in all places they appear. You can 
also modify the fields in individual Notes, without affecting 
other Notes of that type. See Create or Change a Field Definition 
on page 54.

When you modify a Note’s definition, you change one or more of the following:

■ the Note type’s name

■ the Note type’s icon

■ the fields the Note type contains

To use the Note Catalog:

1 Click the Note Catalog icon on the Icon Bar; 

■ Or, select Note Catalog in the Notes menu. 

Field Type Initial Value Format Instructions

Text Enter default text. Click Default Style.

Number Enter a default number. Click Default Style.

Picture N/A N/A

Date/Time Enter a date using any of the legal date styles. Click Default Style

Time-of-Day Enter a time using any of the legal time styles. Click Default Style.

Note Link Two pop-up edit boxes display. N/A

Drop-down list Enter the choices you want to see in the drop-down list 
for this field, one per line (press Return to end a line).

Click Default Style.
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2 Click a Note type and an action button to display the Define 
Note dialog. 

3 Make your changes. See The Define Note Dialog on 
page 57.

4 Click OK.

❖ Note: When you’re working with a Note, -click its icon to 
open the Define Note dialog.

The Note Catalog dialog has two sections:

■ On the left is a scrolling Note definition list. It contains all Note definitions in the 
current Document. 

■ On the right is a set of buttons to modify Note definition types. See Table 7.  

Table 8    Note Catalog button actions

❖ Note: You can create a Note without changing any default settings. WebArranger automatically 
adds a Note text field.

Button Action

Define New Opens the Define Note dialog to create Note types (definitions). You don’t need to select a 
Note type before you select Define New. It creates a Note definition. It does not modify an 
existing one. 

Duplicate Creates a Note definition based on the selected one. 

Delete Removes a Note type, or definition, from your Document. Also removes all Notes of that 
type from all Topics, and deletes all information stored in Notes of this type. This can be a 
dangerous operation. Use it with caution.

Edit Opens the Define Note dialog to modify the selected Note definition.

Summary Opens the Set Summary Line dialog.
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THE DEFINE NOTE DIALOG

The Define Note dialog is one of the most powerful dialogs in WebArranger. It creates and modifies 
different Note types. 

THE FIELD SECTION

The left side of the dialog is almost a duplicate of the Field Catalog dialog. It contains a list of fields, 
a drop-down list to sort the list of fields, and buttons to create fields and modify existing fields. To 
duplicate and delete fields, use the Field Catalog.

The field list appears in both dialogs because it is needed in both, but for different reasons. In the Field 
Catalog dialog, you use the field list to manage the set of fields defined in your Document. In the Define 
Note dialog, the field list selects the set of fields that appear in a particular Note definition.

The field list’s Sort by drop-down list controls the order in the field list to help you find a field.

New opens the Define Field dialog to create field definitions. Any new field is automatically added to the 
Note you’re defining and to the Field Catalog as well. -N is the shortcut for New Field.

Edit opens the Define Field dialog for the selected field in the field list. 

Field section Note definition section

Field list

Field prototype

Figure 8 The Define Note dialog



58 WebArranger

THE NOTE DEFINITION SECTION

The right side of the Define Note dialog shows the Note’s definition. A Note definition is the Note 
name, Note icon, and the fields common to all Notes of this type. All are shown as a prototype of the 
actual Note.

NOTE NAME
To name or edit the name of a Note type, use the Note Name edit box.

NOTE ICON
To change the icon of a Note type:

■ Click Icons to select an icon from the dialog;

■ Or, click the Note Icon edit box. Paste a 16 x 16 pixel 
picture. When you paste a picture larger than 16 x 
16, WebArranger shrinks it to fit. 

ADD FIELD
To add a field to the Note definition:

1 Select a field in the field list.

2 Click >> to add it to the prototype. The field’s icon is added to the prototype and the field appears in 
italics in the field list.

See Add Field to Single Note on page 60.

❖ Note: The field list won’t let you select fields already included in the Note definition. Select them in 
the Note definition’s prototype.

REMOVE FIELD
To remove a field from the Note definition:

1 Select the field in the prototype.

2 Click << to remove it. The field’s name is deleted from the prototype and the field no longer 
appears in italics in the field list.

When you remove a field from a Note definition and click OK to exit, a warning dialog asks you to 
confirm the deletion. Table 9 on page 59 describes how to respond to this warning. See Remove Field 
from Single Note on page 60.

System Fields
The system fields — Date Created, Date Modified, Creator Name, Last Editor Name — are always 
included and automatically updated in every Note in your Document. 
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When you add or remove system fields from a Note definition prototype, you’re really just instructing 
the Note to show or hide the fields. These fields are always present, just not always visible.

To see the information in these fields at any time, select a Note and choose Note Info in the Notes menu. 
See System Fields on page 71.

REARRANGE FIELDS IN NOTE DEFINITIONS
Click and drag the field names to rearrange them in the prototype. The new field list order applies to all 
existing Notes of that type, as well as to Notes created after the change is made.

STYLES
Set defaults for Text, Date/Time, Time-of-Day, and drop-down list fields. Select them in the prototype and 
click Styles. 

Enter the default value in the edit field, to the right of each field’s icon in the prototype. The default field 
values here override those set when the field was defined.

THE SUMMARY BUTTON
Click Summary to open the Summary Line dialog for the selected Note type. See Summary Lines on 
page 61. 

Table 9 Define Note exit warning

NOTE DEFINITIONS ON THE SHELF

When you create a Note type, WebArranger adds the new Note definition to the list in the Note Catalog. It 
also adds the Note definition to the Shelf. The Note definition looks like a button on the Shelf. Use it as a 
shortcut to create Notes of your new type.

CUSTOMIZE THE SHELF

Click and drag items on the Shelf to customize it. For example: Click the icon for new Note definition 
and drag it to the Trash Topic to remove it from the Shelf. If you later want to add a copy of a Note def-
inition to the Shelf:

1 Open the Note Catalog.

Button Action

Cancel Returns to the Define Note dialog.

No Applies your changes to the Note definition and to all future Notes you make of that type. 
Does not apply to existing Notes of that type.
When you click No, two Notes of the same type may contain different fields, depending 
upon when they were created.

Yes Applies your changes to the Note definition and to all future Notes you create of that type. 
Also applies to all existing Notes of that type.
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2 Click the Note in the Note definition list.

3 Drag it to the Shelf. See Use the Shelf on page 29.

ADD FIELD TO SINGLE NOTE 

To add a field to an individual Note:

1 Place the insertion point in a Note, or select one or more Notes. 

2 Select Add Field in the Notes menu to display the Add Field dialog;

■ Or, click the Add Field icon on the Icon Bar.

3 Select the field in the Add Field dialog.

Enter a field name in the Add the field text box. Type the 
name of the field or choose it from the drop-down list. If 
you type the name of an undefined field, the name dis-
plays in italics.

4 Click Define Field to display the Define Field dialog. When 
you’ve defined the field, its name is not italicized.

5 Specify the range of Notes to which the field will be added:

■ Click selected Note to add the field to only the selected Notes.

■ Click all Notes of this type to add the field to the definitions of the selected Note types. This adds 
it to all Notes of those types.

REMOVE FIELD FROM SINGLE NOTE

If a field is part of the Note’s definition, you can’t remove it from an individual Note. To remove fields 
included in a Note’s definition, use the Define Note dialog.To remove a field from an individual Note, or 
from a set of selected Notes:

1 Place the insertion point in a Note or select one 
or more Notes.

2 Select a field in a Note and select Clear in the 
Edit menu;

■ Or, press Delete;

■ Or, drag the field to the Trash;

■ Or, click the Remove Field icon on the Icon Bar;

■ Or, select Remove Field in the Notes menu to display the Remove Field dialog.
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3 Select the field to remove in the Remove Field dialog. Type the field name or choose it from the drop-
down list. If you type the name of an undefined field, the name appears in italics. The drop-down 
list shows a list of the fields that exist in the selected Notes.

SUMMARY LINES

Structured Notes are typically “taller” than Memo Notes. 
Every field in a structured Note takes a minimum amount of 
vertical space, even if it only holds a little information. It’s often 
useful to see as many Notes on screen at once as possible, and 
structured Notes can be reduced to a Summary Line. This 
reduces the amount of screen space they occupy.

A Summary Line is a single line of text. It summarizes the 
information in the structured Note. Each type of Note can 
have its own custom Summary Line defined for it; individual 
Notes cannot.

You can tell the People Note shown above has a Summary Line by the two horizontal bars...one above the 
first field and one below the last field. The Summary Line always appears above the first bar.
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To define which fields from the Note 
appear in its Summary Line:

1 Select Note Catalog in the 
Notes menu.

2 Select the Note type.

3 Choose Summary.

4 Click the Automatic Summary Line 
radio button to display a 
default Summary Line. A default 
Summary Line includes all the 
fields from the Note. 

CUSTOM SUMMARY LINE

To create a customized Summary 
Line:

1 Click the Custom Summary Line 
radio button.

2 In the prototype Summary Line, 
select the fields that you want. 

3 In each column where you want 
a field to appear, select the 
desired field from the column 
drop-down list.

4 If there are more fields than can be displayed at once on the prototype Summary Line, use the right 
and left arrows to scroll additional columns into view.

TOP SECTION OF THE COLUMN MENU
The top section affects a column. 

■ Hide Column — Removes the column from the Summary Line. 

■ Add Column — Adds a column directly to the left of the current column. 

■ Set Column Field — Opens the Choose Field dialog to select the field to display in this column.

Type the name of the field in the Show box. 
Or, choose the field from the drop-down list. 
It lists all fields defined in the 
current Document. 

■ Show Date and Show Time — Control how 
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the contents of date/time fields display in the column. These commands are disabled if you 
don’t have a date/time field selected.

MIDDLE SECTION OF THE COLUMN MENU
The middle section contains a list of fields in the Topic’s default Note type. These commands are 
shortcuts for choosing a field to display in the column. Select a field to display by choosing Set Column 
Field dialog. 

BOTTOM SECTION OF THE COLUMN MENU
The bottom section contains a list of system fields. The commands in this section are shortcuts for 
choosing one of the system fields. You can also choose a system field in the Set Column Field dialog. See 
System Fields on page 71.

SLIDE COLUMNS TOGETHER

Click the Slide Columns Together checkbox if you want the fields in your Summary Line to be right next to 
each other. If you want every Summary Line to have equal column widths, do not select the checkbox. 

TEXT FORMAT

Select Styles in Preferences in the File menu to set the text format of all Summary Lines in your Document. 
See Style on page 10.

OPEN AND CLOSE SUMMARY LINES

When you see the two bars and the fields in a structured Note, the Note is open. When you see only the 
Summary Line, the Note is closed. You can’t edit a Note by editing its Summary Line; you must open the 
Note and edit its fields.

To open a closed Note: 

■ Click once anywhere on the Summary Line; 

■ Or, press -].

■ Select Open Note in the Edit menu.

A table with the Slide Columns 
Together option turned off

A table with the Slide Columns 
Together option turned on
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To close an open Note:

■ Click once anywhere on the Summary Line; 

■ Press -[.

■ Select Close Note in the Edit menu.

SET SUMMARY LINES FOR LINKED NOTES

You can set a Local Summary Line for Notes that are linked inside of other Notes with the Note Link field. 
You can set this Local Summary Line to be different than the ordinary Summary Line for a Note.To set a Local 
Summary Line:

1 Choose Field Catalog in the Notes menu, or -click a field name in an open Note to open the Define 
Field dialog.

2 Select a Note Link field from the field list, such as Who.

3 Click Edit to display the Define Field dialog.

4 Click Summary.

5 Use the Set Summary Line dialog to set the Summary Line for Notes appearing in this field.

6 Click OK. This Summary Line appears only for Notes within this field.
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WORKING WITH FIELDS 

To enter information in a field, click to the right of the field’s name to place the insertion point. The text 
you enter is interpreted differently depending upon the type of the field.

You can manipulate the information in most types of fields the same as text in a Memo Note:

■ Select information in a field with the mouse. 

■ Copy and Paste it using the appropriate commands in the Edit menu. 

■ Format text with the Text menu. See Text Menu on page 27.

Table 10  Field navigation and selection

REARRANGE FIELDS

To rearrange fields in a Note:

1 Select the fields and drag them vertically to a new location. The gray destination bar displays in the 
new location.

2 Release the mouse button.

Field Navigation and Selection

When insertion point is in the field, press the to go to

Tab key Next field

Shift key and Tab key Previous field

When you get to the start or end of the field, the insertion point wraps back to the first field the 
next time you press the Tab key.

Use arrow keys to move in text and between fields.

To select a field

Click the field name to select a field and its contents. A rectangle is around the selected field.

To select field text

Hold down the mouse button while dragging across the text you want to select.

Click the field contents, hold down the Option key, and choose Select Text in the Edit menu.

Click the field contents and press -Option-A.

Hold down the Option key and use the Left and Right arrow keys to move the insertion point by 
words

Triple-click the mouse anywhere within the text.

Apply formatting commands from the Text menu. See Text Menu on page 27.
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To rearrange fields in all Notes of a given type, rearrange them in the Note definition. See The Define 
Note Dialog on page 57.

FIELD TYPES

WebArranger has various types of standard (pre-defined) fields. They 
are listed in the Field Type: drop-down list in the Define Field dialog.

Each is optimized for a particular kind of information. Every field you 
use or create in WebArranger is based upon one of these types. For 
example: Numbers entered in Time-of-day fields display as time. 

You can have any number of fields of a particular type, each with a 
different name. For example: Name and Address fields in People Notes are Text fields.

INTELLIGENT FIELDS

The different types of fields handle different kinds of information. Text and Picture field types are 
passive. You enter information into them and it is stored for you. Date/Time and Number field types have 
built-in intelligence about their contents. 

WebArranger monitors information entered in fields. When you enter information into an intelligent 
field that does not match the field’s type, the information entered is displayed in italics. This indicates it 
does not make sense for that type of field. For example: You enter text characters in a Number field. The 
text characters display in italics. When you enter the correct type of information for a field, it is plain, 
non-italicized text.

▲ WARNING: Do not apply italic formatting to intelligent fields.

TEXT FIELD

A Text field is a like a Memo Note — you can enter and edit text. Examples of Text fields are name, 
address, and comments.

NUMBER FIELD

Number fields accept only numbers. When you enter an invalid character in a Number field, the contents 
appear in italics. Examples of Number fields are quantity or amount.

CHECKBOX FIELD

The Checkbox field contains a box to check or uncheck. Use Checkbox fields for values that can be shown 
as yes/no, done/not done, or on/off.
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To check a 
Checkbox field, 
click in the 
box. To uncheck 
a Checkbox 
field, click in a 
checked box.

You can sort 
and filter on 
Checkbox fields, make them show up in Summary Lines or Tables, and use them in forms.

The To Do Note has a Checkbox field for Completed. 

PICTURE FIELD

Picture fields accept pictures, and will not accept any other type of information. 
You can paste any picture from the Clipboard into Picture fields. Examples of 
Picture fields are employee photos, real estate pictures, or Icons. 

Text formatting commands do not apply to Picture fields. They’re disabled when 
you’re working in a Picture field.

When Picture fields are empty, they display a small rectangle to help you locate them. To paste into a 
Picture field:

1 Click the rectangle to select it.

2 Select Paste.

To delete a picture from a Picture field:

1 Select the picture.

2 Choose Clear in the Edit menu, or press Delete.

DATE/TIME FIELD

Date/Time fields accept numeric and alphabetic characters to indicate the date 
and time separated by the @ symbol. For example: 1/14/93 @ 3:45 PM or 
October 11, 1994 @ 2:11 AM. 

When you enter just date information, the time is filled automatically. When you enter just time 
information, the date is filled in automatically. If you enter information other than a valid date and/or 
time in a Date/Time field, the contents appear in italics.
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Date/Time fields include two pop-ups to the right of the 
field’s name. 

The date pop-up is a way to choose the field’s date 
setting. It shows current and following months. 
The current day is highlighted. 

To choose a date, move the mouse pointer to it and release. The date under the mouse pointer is always 
highlighted. To select a date before the months visible, move the pointer to the left of the calendar to 
scroll. To move to following months, move the pointer to the right of the calendar. Scroll up to move to 
an earlier year and down to move to a later year.

Date information is formatted according to the default date format set in Dates in Preferences in the File 
menu. See Date on page 12.

The time pop-up selects the field’s time setting. To choose a time, move 
the mouse pointer to the time you want to select and release. Choose 
time in 5-minute intervals. To enter other times, type them in the field. 
The center of the clock displays confirmation for the selected time.

TIME-OF-DAY FIELD

Time-of-Day fields accept numeric and alphabetic characters to indicate 
time. For example: 2:30 AM. If you enter invalid information, the 
contents appear in italics. 

Time-of-Day fields contain a drop-down list like the Date/Time field’s time pop-up. 

ALARM ON FIELD

See Reminder on page 19.

NOTE LINK FIELD

Note Link fields are one of the more advanced and powerful concepts in WebArranger. Note Link fields let 
you embed Notes within other Notes. A Note Link field doesn’t hold text or pictures. It holds other Notes 
... up to 50 other Notes. When a Note is linked to another, the triangle is double. 
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Every Note Link field has a drop-down list so you can select any type of Note to link into the field. The 
first option in every Note Link pop-up menu is Link. Select Link to link a default Note type into the Note Link 
field. Or, select any other Note type. You select and manipulate Notes within a Note Link field the same as 
within a Topic. 

 For example: The To Do Note has a Note Link field called URL Link, and 
the default Note type is the URL Note. This means you can connect a 
To Do Note to a URL address. The Organizer Template’s Appointment 
Note and Reminder Note have a Note Link field called Who. The default 
is the Memo Note. You can select the People Note for the link. 

DRAG TO LINK
To move a Note into a Note Link field, just drag it there. When you 
drag the first Note into a Note Link field, the field is highlighted with a 
gray rectangle. When a Note Link field contains at least one Note, the 
destination bar displays when other Notes are added.

Note Link fields can also contain linked copies of other Notes. To move a linked copy of another Note into 
a Note Link field, hold down the Option key and drag the Note into the Note Link field.

AUTO-LINKING TOOL
When a Note is in another Topic, you can’t see it to drag it. The auto-linking tool moves a specific Note 
into a Note Link field.

To use the auto-linking tool:

1 Click the Note Link symbol to display an edit box.

2 Enter text in the edit box that matches text in the Note you want linked.

3 Press Return.

4 WebArranger searches your Document and brings a linked copy of the matching Note into the Note 
Link field. 

If no Notes match the text you entered, you can create one. 

If more than one Note matches the text you entered, the Choose the Note dialog displays.

See Gather on page 144.
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POP-UP FIELD

The Pop-Up field type lets you create your own 
pop-up fields. Pop-Up fields are really text fields 
with a list for text choices. You can type your 
own values in Pop-Up fields.

 When you create a Pop-Up field, you specify 
the choices that will appear in the list. This field type is useful when you want 
easy access to a small set of choices. An example of a Pop-Up field is the 
Priority field in the To Do Note.

You can easily edit the choices listed, or you can make a new Pop-Up field. To 
automatically append a pop-up value to a field, hold down the Shift key while selecting the list item.

FILE REFERENCE FIELD

Use File Reference fields to manage files on your hard 
disk while in WebArranger. When a File Reference field is 
empty, it displays the text double-click to set file. When 
a File Reference field has been set to a file, it displays the 
name of the file. A File Reference field is set to one file at 
a time.

Use the drop-down list to the right of the field’s name to specify a certain file, or to open the specified 
file. You cannot type directly into File Reference fields.

To specify a file:

1 Select Set to display the standard Macintosh file chooser dialog. 

2 Select the file.

3 Click Open. The file won’t really be opened. It is assigned to the File Reference field. The name of the 
file is then visible in the field.

To go to the specified File:

1 Select Open. 

2 If the field is set to a document-type file, Open launches the 
application that created it.

3 If the field is set to an application file, Open launches the application.

Open is disabled if the field is not currently set to a file.
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SYSTEM FIELDS

Every Note contains four fields which are automatically maintained by WebArranger. Usually, they are 
not visible. These four System fields are used behind the scenes to keep track of Notes:

■ Date Created

■ Date Last Modified

■ Creator Name

■ Last Editor Name

The names in the Creator Name and Last Editor Name system fields are taken from the Sharing Setup control 
panel or the Chooser.

As you work with Notes, WebArranger updates these fields automatically. You never have to use them. 
However, you can use these system fields to filter and sort your information. See Choose the Field to 
Sort On on page 87.

To view the contents of these fields:

1 Select the Note.

2 Choose Note Info in the Notes menu.

The Note Info dialog displays the values for the system 
fields. This dialog also indicates the Note’s type and the 
number of times that the Note appears in the Document.

DISPLAY SYSTEM FIELDS WITHIN NOTES

Technically, you don’t add system fields. They’re always there, just not visible. You display them. 

To make one or more of the system fields visible in a Note, select Add Field in the Notes menu. See Add 
Field to Single Note on page 60.

To make one or more of the system fields visible in all Notes of a given type, add them to the Note’s 
definition. See Add Field on page 58. 
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CHAPTER 5: VIEWS, TABLES & CALENDARS

Information in WebArranger is stored in Notes, and Notes are grouped together in 
Topics. A View is a look at a Topic, with the Notes rearranged. The rearrangement is 
made with the View tools: Filter, Sort, Table, Calendar, and Calendar Settings.

Views make information in a Topic more useful. You can:

■ Isolate information with a common theme, such as all people you know at a particular company

■ Order the information in an certain way, such as ranking your tasks by priority

■ Focus on a smaller set of information, such as your appointments for this week

A View is attached to a particular Topic, and remains attached to it until you remove it. You can attach 
any number of Views to a Topic, and rename or remove them at any time. If you remove the Topic, all its 
Views are removed, too. Views can also be attached to anything in a Document’s Contents.

Views are dynamic...as the information in a Topic changes, the Views attached to that Topic 
automatically show those changes. You can specify if you don’t want a View to automatically 
update. For more information, see View Update.

MANIPULATE INFORMATION SAFELY 

It’s important to understand that Views control only how Notes are displayed. Views don’t change 
the Notes themselves. It’s perfectly safe to experiment with Views without worrying about accidentally 
losing or changing your information. 

Views don’t change the information ... they only control how things are displayed. The View tools do 
not affect the underlying Notes; changing data through a View does.

For example: The Filter View command restricts the Notes displayed in a View, but it doesn’t affect the 
original Notes in the View’s Topic. On the other hand, changing a phone number in a People Note using 
a View changes the number in that Note and all linked copies of it. 



WebArranger  73

VIEWS

You work with Views just as you work with Topics — creating, selecting, renaming, closing, 
and deleting.

NEW VIEW

To create a View:

1 Select a Topic in the Contents list.

2 Choose New View in the Views menu.

You can tell a View is selected when you see a second title bar at the top of the Topic area. The upper bar 
is the Topic title bar; it doesn’t change when you’re in a View.   

Beneath it is the new View title bar. On color or grayscale screens, the View title bar appears lighter than 
the Topic title bar. 

SHORTCUT TO CREATE A VIEW

You can quickly create a View by choosing a View tool while in a Topic. Once the View is created, you 
can apply View tools to it.

Figure 9 A View displays its own title bar below the Topic title bar.
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For example: While in a Topic you choose Filter View in the Views menu. You specify your filter in the 
dialog, and instantly see the results in the Document window. Click the View close box to close the 
View, or click the View trash can to delete it. See The View Tools on page 77.

VIEW TITLE BAR

Like the Topic title bar, the View title bar displays the name of the View, and the number of top-level Notes 
contained in it. A new View is called untitled.

The left corner of the 
View title bar has two 
controls: a View close 
box and a View trash can.

NAME OR RENAME VIEW

The name of the current View is always displayed in the center of the View title bar. You can name or 
rename a View at any time.

■ Click the name 
in the View title 
bar, and type 
the name in the 
text box. Press Return or click outside of the text box; or,  

■ Select View Settings in the Views menu and enter the 
name in the text entry box. See View Settings on 
page 76.

DISPLAY VIEW

WebArranger displays the Views attached to a Topic in a 
drop-down list.

The View list displays to the right of the Topic’s name in the 
Contents. The Bookmarks, History, and Web Schedule Topics ship 
with Views. The Organizer’s Topics provides several Views as 
well. See The Organizer Template on page 47. 
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❖ Note: The View drop-down list is also to the right of the Topic’s name in the Topic title bar. This is 
useful when you’ve hidden the Contents list to maximize the Topic area workspace. 

To open a View:

1 Click the View drop-down list. When a Topic doesn’t have 
any Views, it doesn’t have a drop-down arrow.

2 Choose a View. This automatically updates the information in that View. 

GO TO

The Go To command moves you to any other Folder, Topic or View. Go To has exactly the same effect as 
selecting from the View drop-down list. Go To is in the Topics menu. See The Organizer Template on 
page 47.

CLOSE VIEW

To close a View and return to its Topic:

■ Click the Topic’s name in the Contents. The Topic’s name remains selected but the View closes 
and the full contents of the Topic are displayed;

■ Or, click the View’s close box;

■ Or, press -J (Go To), type the name of the Topic, and click OK to return to the Topic.

DUPLICATE VIEW

Duplicate View creates another View just like the existing one. You must be in a 
View to use Duplicate View. Use it to create a series of Views with the same:

■ table formatting

■ filter setting

■ sort setting

■ calendar formatting

■ font and style setting, and/or

■ form settings. See Set Up a View to Display Forms on page 133. 

When a View is duplicated, the two Views are not linked, and each can be modified individually. To 
make a Duplicate View:

1 Open a View.

2 Hold down the Option key and click the Views menu. The Duplicate View command displays instead 
of New View.
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3 Select Duplicate View. A duplicate View named untitled 1 displays. It has the same settings as the 
original View.

DELETE VIEW

 To remove a View:

1 Select the View.

2 Choose Delete View in the Views menu.

3 Click OK.

To bypass the warning dialog, hold down the Command key when you select Delete View. 

Or, click the View trash can in the View title bar.

VIEW SETTINGS

View Settings lets you design the look of a View:

1 Click View Style.

2 Enter text in the View Name text box to name or rename 
a View.

3 Select font, size, and style in the Choose 
Style drop-down lists.

4 Click OK.

The other options in View Settings apply to 
Forms. See Set Up a View to Display Forms on 
page 133.

VIEW UPDATE

When information in a Topic changes, the Views are automatically updated. View Update controls the 
dynamic behavior of Views. 

UPDATE WHEN VIEW IS CHOSEN

When you create a View, the Update View When Chosen 
command is the default. Whenever you select that 
View, its contents are automatically recalculated.
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FREEZE VIEW

Choose Freeze View to prevent a View from automatically updating. The View will not update until you 
use another command. Use Freeze View to prevent unnecessary recalculation when you’re manipulating 
large amounts of information.

UPDATE NOW

If you choose Freeze View and later want to force a View, choose Update Now.

GUIDELINES FOR UPDATING VIEWS 
The View Update commands can be used to match the capabilities of your Macintosh with the scale of 
information you’re managing. A good rule of thumb is to leave the default Update View on Entry command 
chosen, until you notice a delay when switching to a View. At that point, estimate how often the 
information changes and compare that to the number of times you use the View. In general, the more 
you use a large View, the more you’ll use Freeze View. See Tool Application Order on page 78. 

THE VIEW TOOLS

Views are a powerful way of customizing how you work with WebArranger. The 
View tools define Views to meet your needs.

When you create a View, you are not rearranging the information in the Topic. All 
Notes in the Topic are still displayed when you first create a View. 

The View tools customize the information displayed in the View. Select a View 
and then select a View tool in the Views menu. You’ll see the effect of that tool in 
the Topic area of your Document window.

■ Filter View — Controls which Notes from the Topic are displayed in the View 

■ Sort View — Controls the order of the Notes in the View 

■ Show Table — Controls which of the Note’s fields are displayed

■ Show Calendar — Lets you display and manipulate date-oriented information using a 
calendar layout 

■ Calendar Settings — Controls the display of the calendar and modifies the default settings
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COMBINE VIEW TOOLS

You can use the tools in almost any combination to create a custom View. Table and Calendar are 
mutually exclusive. See Table 11..

Table 11  Customize your Document with the View tools

Sometimes the effects of the tools overlap. For example: Both Filter View and Show Calendar restrict 
the Notes that appear in a View.

VIEW TOOL SETTINGS

The View tools remember their settings. The next time you select a particular View, the View tools are 
configured the way you left them. The settings of the View tools in one View do not affect the settings in 
any other View. Change the settings of one or more of the View tools to modify an existing View.

TOOL APPLICATION ORDER 
To determine how a combination of View commands affects a View, apply them in this order: 

1 Calendar and Calendar Settings

2 Filter

3 Sort

4 Table 

➣ IMPORTANT: No matter what order you apply the tools to a View, this is the order WebArranger uses 
when it updates a View.

FILTER VIEW

It’s so easy to get more information than you can manage efficiently. For example: Your People Topic 
has grown to hundreds of People Notes. The Topic you use to manage a project is filled with a sizable 
mix of People, To Do, and Appointments Notes. Filtering is a convenient way to tidy stuff up. 

Tool Menu Command Use

Filter Filter View… Lets you choose which Notes from the View’s 
Topic will appear in the View.

Sort Sort View Lets you choose the order in which you want the 
Notes to appear in the View.

Table Show Table Lets you control the layout of individual Notes’ 
fields in the View.

Calendar Show Calendar Displays date-oriented information in the View.

Calendar Settings Calendar Settings… Lets you manipulate date-oriented information.
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Filters reduce the number of Notes you see in a View, leaving only the pertinent Notes. Filtering is not 
destructive. When you sift out information in a View, you aren’t deleting any information from the 
Topic. You’re just being selective about what Notes you see. 

To use Filter View: 

■ Select New View and then Filter View in the Views menu;

■ Or, choose Filter View while you’re in a Topic. WebArranger automatically creates a View 
for you;

■  Or, click the Filter icon on the Icon Bar.

THE FILTER DIALOG

FILTER ON NOTE TYPES
All Note types in the Document’s Note Catalog are displayed in the Show edit box drop-down list. Choose 
any Note type as a filter. If you don’t want to filter on a specific Note type, select Any Type.

The default is the Topic’s default Note type. For example: You’re creating a View for the People Topic. 
The default for the Show edit box is the People Note, since that’s the default Note type for the People 
Topic. See Topic Settings Dialog on page 45.

To filter on a Note type:

1 Select Filter View.

2 Select a Note type(s) in the Show 
edit box. This specifies the type 
of Notes to display in the View. 

3 You can type a Note type name, 
or select from the drop-down list.

4 Click Just Notes or Both Notes and 
Sub-Notes. The Just Notes and Both Notes and Sub-Notes buttons specify where the filter should look in 
the Topic. When you select Just Notes, Filter View examines only the top level Notes of the Topic.

When you select Both Notes and Sub-Notes, Filter View examines both top level Notes and 
any Sub-Notes. 

5 Click OK.

FILTER ON THE TEXT CONTAINED IN NOTES
Filter View compares a text string to all text in a Note, whether the Note’s text is in a single field — like 
the Memo Note type — or the Note’s text is broken into several fields, as in structured Notes like People 
and Appointment.
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To filter on text:

1 Select Filter View.

2 Type the text in the Notes containing edit box. 
This specifies the text string that Notes must 
contain to be included in the View. The 
matching process is not case sensitive.

Wild card characters can be included in the text string. Wild cards are a very powerful tool 
for matching information when you have the exact spelling, and for matching related groups 
of information using patterns in their text. See Wild Cards on page 143.

3 Click Just Notes or Both Notes and Sub-Notes. The Just Notes and Both Notes and Sub-Notes buttons spec-
ify where the filter should look in the Topic. When you select Just Notes, Filter View examines only 
the top level Notes of the Topic. 

When you select Both Notes and Sub-Notes, Filter View examines both top level Notes and 
any Sub-Notes. 

4 Click OK.

CLOSE THE FILTER DIALOG
The Filter dialog retains its settings for each View. Every time you open the dialog with Filter View, the 
dialog contents are like you left them.

To close the Filter dialog:

■ Click Clear to discard any options that have been set in the View; 

■ Or, click Cancel to exit the dialog and discard any changes you’ve made; 

■ Or, click OK to exit the dialog and apply any changes you made.

More Choices 
Click More Choices to open the Advanced Filter dialog.

ADVANCED FILTER DIALOG

The Advanced Filter dialog defaults to the same 
behavior as the normal Filter dialog. When you 
enter a text string in the text edit box and click 
OK, you get the same results.

However, the options in the Advanced Filter let you 
be more selective than those in the normal Filter.
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❖ Note: You can read the Advanced Filter dialog (and most WebArranger dialogs) as sentences to more 
easily understand what the dialog controls. For example: This dialog reads, “Match Notes and Sub-
Notes of Type Memo where the Creator Name Field Contains Smith.” Not exactly the way you 
usually talk to yourself, but it works.

FILTER ON NOTE LEVEL AND NOTE TYPE
The first line of the Advanced Filter dialog specifies the Note level 
and Note type by which to filter. 

To specify the Note level: 

1 Click More Choices to open the Advanced Filter dialog.

2 Select a command in the Match drop-down list. 

Notes includes only top-level Notes in the View. Notes & Sub-
Notes includes both top-level Notes and Sub-Notes. 

3 Click OK.

SPECIFY OF TYPE
Enter the Note type in the of Type edit box, or choose a Note type from the drop-down list.

FILTER WITH RULES
In the normal Filter dialog, a text string to search for in the Note is specified. In the Advanced Filter 
dialog, you can be much more specific about describing what to search for and where to search for it. 
This additional capability is provided through rules. Each rule describes one aspect of a match.

The list of rules is located in the center of the Advanced Filter dialog. Each line of text in the rule list 
represents a separate rule. You can create up to 16 rules.

Each rule in the list has three parts: 

■ Field choice control 

■ Relation drop-down list

■ Text edit box

Field choice control
Relation drop-down list

Text edit box
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Field Choice Control
The field choice control specifies the name of a field to filter on. 
Either type the name of the field or select the field name 
from the drop-down list.

The drop-down list presents all fields in the Note type 
selected in the of Type edit box. It also lists system fields and 
a command to choose any other field defined in the current 
Document. 

Any Field searches all fields of the Notes that it filters. A spe-
cific field type searches fields of that type.

Set Filter Field lets you pick other fields (in any Note type). 
However, you can’t filter on Picture or File Reference fields. 
See Picture Field on page 67 and File Reference Field on 
page 70.

Relation Drop-down List
Once you’ve chosen the field on which to filter, you can 
specify a condition that must be true for that field. The 
default choice varies depending upon the type of field speci-
fied in the field choice control. 

■ When Any Field is specified, the following choices 
are available:

■ When you select a Text field in the field choice control, the Relation list offers text-specific choices. 
Enter the text to match in the text edit box.
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Table 12 How Relation options work with any field 

Table 13 How Relation options work with text fields

For example: You select Is Before and then enter c in the text edit box. The rule specifies 
the View will include only those Notes which contain text in the chosen field that begins with 
a letter prior to c.

When Is Present is chosen, the text edit box on the right side of the rule is disabled, since no 
value is needed.

■ Date/time fields and Time-of-Day fields

When you select a date/time field or a Time-of-Day field in 
the field choice control, the Relation list offers date and/or 
time-specific choices. 

Enter a date and/or time in the text edit box. Drop-down lists 
are added to the text edit box to help you specify the date 
and/or time.

See Table 13. for an explanation of the options.

For example: You choose Is Before Or On and enter “3/31/96” in the text edit box. The filtered 
View includes only those Notes whose date fields contain a date prior to 3/31/96.

■ Number fields

Relation Matches if

Contains The field contains the text you enter in the text edit box.

Equals The field contents exactly equal the text you enter in the text edit box.

Starts With The field contents start with the text you enter in the text edit box.

Relation Matches if

Contains The field contains the text you enter.

Doesn’t Contain The field does not contain the text you enter.

Starts With The field contents start with the text you enter.

Equals The field contents exactly equal the text you enter.

Doesn’t Equal The field contents do not exactly equal the text you enter.

Is Before The first character of the field contents comes before (alphabetically or 
numerically) the text you enter.

Is After The first character of the field contents comes after (alphabetically or 
numerically) the text you enter.

Is Present The chosen field is present.
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When you select a Number field in the field choice control, 
the Relation list offers number-specific choices. Enter a 
numeric value in the text edit box.

Table 14 How Relation options work with number fields

The Equals and Is Present options are described in Table 13. The Not Equal option is the same as 
the Doesn’t Equal option described in Table 13. 

For example: You select Greater Than and enter 175 in the text edit box. The filtered View 
includes only those Notes whose chosen Number field contains a number greater than 175.

■ Pop-Up fields

When you select a pop-up field in the field 
choice control, the Relation list offers list-
specific choices.

  

Relation Matches if

Greater Than The field contains a number greater than the number you enter.

Greater or Equal The field contains a number greater than or equal to the number you 
enter.

Less Than The field contains a number less than the number you enter.

Less or Equal The field contains a number less than or equal to the number you enter.

Relation Matches if

Contains The field contains the text you enter.

Doesn’t Contain The field does not contain the text you enter.

Starts With The field contents start with the text you enter.

Equals The field contents exactly equal the text you enter.

Doesn’t Equal The field contents do not exactly equal the text you 
enter.

Is Before The first character of the field contents comes before 
(alphabetically or numerically) the text you enter.
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Table 15 How Relation options work with drop-down list fields

Enter text or one of the options from the Note’s drop-down list in the text edit box. The choices 
from the Note’s drop-down list are added to the text edit box.

For example: You choose Contains from the Relation list and select Work from the text edit’s list. 
The filtered View includes only those Notes with the pop-up field in containing Work.

■ Note Link fields

When you select a Note Link field in the field choice control, the Relation drop-down list 
offers Contains and Doesn’t Contain choices. See Table 13. Enter the text to use in matching 
the Summary Line of all the Notes in the field. See Note Link Field on page 68. 

TEXT EDIT BOX
The text edit box is empty at first. When a Text field is 
chosen for the rule, you can enter any text for the filter 
to search for.

When a date/time field is chosen for the rule, you can 
enter any date and time for the filter to use. Three 
pop-ups — Repeating Event, date, and time — are 
added to the text edit box. 

When a time field is chosen, you can enter any time 
for the filter to use. 

MULTIPLE RULES
The power of the Advanced Filter dialog comes into 
play when you create multiple rules to narrow a filter 
so it selects and displays only those Notes that you 
want to see.

To add a rule to a filter, click Add Rule and then adjust 
the settings for the rule. 

To delete a rule, place the insertion point in the rule 
and click Remove.

Experiment with various combinations of rules. You’ll find that working with multiple rules in the 
Advanced Filter dialog lets you filter your information very precisely.

Is After The first character of the field contents comes after 
(alphabetically or numerically) the text you enter.

Is Present The chosen field is present.

Relation Matches if
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TELL A FILTER HOW TO APPLY THE RULES
 The choices in the Notes must match pop-up specify how the 
filter should apply the rules that you’ve created.

all of the Rules makes the filter very specific — all rules in the 
rule list to be true for a Note to match the filter. The other 
choice, any of the Rules, is more lenient. A Note must match any 
one (or more) of the rules.

DISPLAY THE RESULTS OF A FILTER
The choices in the Show pop-up list specify what the View 
should do with the results of the filter. 

Matching Notes displays the Notes that match the Filter dialog 
settings. Unmatched Notes displays Notes from the Topic that do 
not match the Filter dialog settings.

RETURN TO THE NORMAL FILTER DIALOG
Click Fewer Choices to return to the normal Filter dialog.

FILTER AND SORT IN NOTE LINK FIELDS

The settings in the Define Field dialog for each Note Link field determine what text from linked Notes is 
used. If a particular field is chosen in the dialog’s Match based on field drop-down list, Filter and Sort 
commands use the contents of this field. See Note Link Field on page 68.

If no field is selected:

■ Filter looks through all text fields of all linked Notes.

■ Sort only looks at the first text field of the first linked Note.

FILTER AND SORT WITH THE NAMES OF FILE REFERENCE FIELDS

To filter and sort on File Reference fields, use the text of the file’s name as the text to filter and sort on. 
See File Reference Field on page 70.

SORT VIEW

You’ll typically manage your information by placing related Notes near each other in Topics. The ability 
to organize information just by clicking and dragging is one of the cool features of WebArranger. 
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However, sometimes you’ll want to View the information in a Topic in a different order. This is when 
the Sort View command is handy. Sorting is not destructive. You aren’t permanently rearranging any 
Notes in the View’s Topic. You’re just reordering them in the View. Sorting is a way to use different 
arrangements to see patterns of information in your Notes.

Sort View arranges the Notes in a Topic based on the contents of specific fields in the Notes. To apply Sort 
View to a View:

■ Create a View and choose Sort View in the Views menu;

■  Or, choose Sort View while you’re still in a Topic. In this case, WebArranger automatically 
creates a View for you; 

■ Or,click the Sort icon on the Icon Bar.

THE SORT DIALOG

The control on the left is a drop-down list that 
chooses the field by which you want the Notes 
sorted. The control on the right is a drop-down 
list that chooses the order in which to display 
the Notes.

CHOOSE THE FIELD TO SORT ON
The first three choices in the Sort Notes by drop-down 
list are system field types. Subsequent choices in the 
menu are determined by the current Topic’s default 
Note type.

❖ Note: You can’t sort on Picture, Note Link, or File 
Reference fields.

 

Command Description Sorts Use

Note Type The Note type field is a special 
field maintained automatically for 
all Notes. This field contains the 
type of its Note. 

Sorts Notes by 
their type. 

To see groupings of similar 
types of information, such 
as a mixture of Note types in 
a Topic.

Date Cre-
ated

The date created field is a special 
system field maintained automati-
cally for all Notes. This field con-
tains the date when the Note was 
created. 

Sorts Notes by 
their 
creation date. 

To detect patterns over time.
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Table 16 How the Sort by list options work

THE DISPLAY ORDER
The drop-down list on the right side of the Sort 
dialog sets the order in which the results of the sort 
are displayed.

■ Ascending — Displays the smallest values first. 
This is the default.

■ Descending — Displays the largest values first. 

CLOSE THE SORT DIALOG
The Sort dialog retains its settings for each View. Whenever you open the dialog, the dialog contents are 
like you left them the last time you closed the dialog with OK.

To close the Sort dialog:

■ Click Clear to discard any sorting options that have been set in the View;

■ Or, click Cancel to exit the dialog and discard any changes you’ve made;

■ Or, click OK to exit the dialog and apply any changes you made.

MORE CHOICES FOR SORTING
Click More Choices to go to the Advanced Sort dialog.

Date Modi-
fied

The date modified field is a special 
system field maintained automati-
cally for all Notes. This field con-
tains the date when the Note was 
last edited. 

Sorts Notes by 
their modification 
date. 

To detect patterns of activ-
ity and to View information 
you work with most fre-
quently.

... The fields appended to the menu 
vary depending upon the current 
Topic’s default Note type.

Varies depending 
upon the type of 
field selected.

To arrange Notes based on 
the contents of their fields.

Command Description Sorts Use
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THE ADVANCED SORT DIALOG

The Advanced Sort dialog offers several additional 
controls for defining a sort. It defaults to the same 
behavior as the normal Sort dialog.

Notice the four lines of sort rules. Each sort 
rule has two controls corresponding to the 
two controls in the normal Sort dialog. 

The left control is a drop-down edit box that   
specifies the field on which the rule should sort.

The right control is a drop-down list that sets the display order of the sort rule.

The Advanced Sort dialog applies the first sort rule to the Notes in the View. Then, for any Notes that tie, 
it applies the second sort rule, and so on. By nesting sort rules, you can specify that information be 
sorted in exactly the order you want. The Advanced Sort dialog supports up to four sort rules. You can 
leave any of the rules blank.

RETURN TO THE NORMAL SORT DIALOG
Click Fewer Choices to return to the normal Sort dialog.

SORT VIEW VS. SORT TOPIC

Sort commands are available in both the Topics and Views menus. The Sort View and Sort Topic dialogs are 
nearly identical. However, there is an important difference between them.

■ Sort View affects the order of Notes only in the View where it is applied. It never changes the 
order of Notes in the Topic. 

■ Sort Topic reorders Notes in the Topic. Any Note organization that you’ve done by clicking and 
dragging is overridden by Sort Topic. It affects top-level Notes only.

FILTER AND SORT IN NOTE LINK FIELDS

The settings in the Define Field dialog for each Note Link Field determine what text from linked Notes 
is used. If a particular field is chosen in the dialog’s Match based on field drop-down list, Filter and Sort 
commands use the contents of this field. If no field is selected:

■ Filter looks through all text fields of all linked Notes.

■ Sort only looks at the first text field of the first linked Note.

See Note Link Field on page 68.
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FILTER AND SORT WITH THE NAMES OF FILE REFERENCE FIELDS

To filter and sort on File Reference fields, use the text of the file’s name as the text to filter and sort on. See 
File Reference Field on page 70.

SHOW TABLE

The Filter and Sort View tools fundamentally affect the Notes displayed in a View. Filter View hides cer-
tain Notes. Sort View changes the order of Notes in the View. 

The Table View tool has a less significant effect. Show Table simply lets you set a Summary Line for all 
Notes in the View. A View Summary Line is independent of the Note Summary Lines in the rest of your 
WebArranger Document.

Show Table displays a Table header just below the View title bar. The Table header is a convenient, interactive 
way to set the Summary Line for Notes in a View.

To apply Show Table to a View:

■ Create a View (with the New View command) and then choose the Show Table command; 

■ Or, choose Show Table while you’re still in a Topic, and WebArranger will automatically create 
a View; 

■ Or, click the Show Table icon on the Icon Bar.

When you choose Show Table, the command name changes in the Views menu to Hide Table. Hide Table 
hides the Table header and changes the command name back again. The Table header retains its settings, so 
you can toggle the Table header on and off.

TABLE HEADER

The Table header has two parts: the 
column area and the Add Column 
button. The column area is where 
you manipulate columns. The New 
Column button creates columns. The 
New Column button is the little white 
square in the upper right corner.

Like a column in a spreadsheet, a column in WebArranger is a vertical area of fixed width that contains 
information. In a Table, a column is used to display the contents of a Note field. Each row of the Table 
corresponds to an individual Note.

Table headers display a set of default columns that match the fields of the Topic’s default Note type

For example: Topics with the default Memo Note type display a single Note text column. Topics with 
the default People Note type display a set of columns, one for each field in the Appointment Note type.
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CREATE A COLUMN

To create a column, click the New Column button. Or, double-click the blank area to the right of the last 
column in the Table header.

New Column creates a column to the right of all existing columns and contains the Column drop-down list. 
When you create a column, it appears as a new rectangle on the right side of the Table header.    

Top Section
The top section contains basic commands that affect a column. 

■ Hide Column — Removes the column from the Table header 

■ Add Column — Adds a column to the left of the current column. The New Column button in the 
Table header adds a column to the right of existing columns.

■  Set Column Field — Opens a dialog to select the field 
to display in this column

Type the name of the desired field in the Show edit box. 
Or choose the field from the drop-down list, which lists 
all fields defined in the current Document. 

■ Show Date and Show Time — Control how the 
contents of date/time fields display in the column. These commands are disabled if you don’t 
have a date/time field selected. 

Middle Section 
The middle section of the Column drop-down contains a list of fields in the Topic’s default Note type.
This list is a shortcut to select a field to display in the column. You can choose a field to display with Set 
Column Field. 

Bottom Section 
The bottom section of the Column drop-down contains a list of system fields. As in the middle section, the 
list is a shortcut to select system fields. You can also choose a system field in the Set Column Field dialog.
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DISPLAY FIELD CONTENTS IN A COLUMN
Once you’ve chosen a field to display in a column, the contents of all Notes that contain that field 
display in the column. The column takes on the name of that field.

RESIZING COLUMNS
The vertical lines between columns are called column dividers. To resize a column, click the column 
divider on the right side of the column and drag it to position.

When field information is displayed in a column, the information may not all fit in the space provided. If 
all information from a field can’t fit in a column, an ellipsis (…) is appended to indicate it contains 
information you can’t see. 

REARRANGE COLUMNS
To rearrange columns, open a column’s menu and choose the field you want to display. Then choose 
Hide Column and Add Column for other columns. The same field can be used in more than one column.

Click a column’s field name and drag it left or right to rearrange.

QUICK COLUMN SORTING
A shortcut to sorting in Tables: Click the field name at the top of a column to immediately sort the Table 
based on that field. This doesn’t affect the Sort View dialog settings. Table sorts are always in ascending 
order. The resulting View will not re-sort automatically, as it does when you choose Sort View. 

NOTES IN TABLES

Since Tables are just a way of creating a local Summary Line for the Notes in a View, Tables affect only 
the visual display of information. Tables do not affect the Note contents. Working with Notes in Views 
that contain Tables is much the same as working with Notes in Views that don’t contain Tables. 

If a Table’s column is set to a field that isn’t contained in any of the Notes, the column is empty. If all 
columns in the Table are set to fields that aren’t present in the Notes, the entire Table is empty. The 
Topic’s Notes are still present. Click an empty Summary Line to open a Note. 

SUB-NOTE BEHAVIOR 
Hiding and showing Sub-Notes works the same as usual. However, Sub-Notes display with the 
Summary Line defined for their Note type, not the Summary Line defined by the Table header. This 
makes sense, since Sub-Notes appear offset to the right of their top-level Note. Their Summary Lines do 
not align with the columns in the Table header.
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SHOW CALENDAR

Some of the information you 
manage is time-related. Show 
Calendar is designed to handle 
time-oriented information.

Show Calendar behaves somewhat 
differently than the other View tools. 
The others affect a Note’s ordering 
and display. Show Calendar alters the 
behavior of the View itself.

WebArranger calendars are general 
purpose. Any Note can be displayed 
and manipulated in a calendar View, 
as long as that Note has some date/
time-related information associated 
with it. 

Many Note types, such as the 
Appointment Note, contain explicit 
date/time type fields for setting the 
start and end of appointments. 

All Notes contain the date Created system field. It can be used to see Notes on a calendar, based on the 
date they were created. See Date Created Field on page 98.

The second calendar-related command in the Views menu, Calendar Settings, controls the display of the 
calendar. Use it if you want to modify the default calendar settings. 

Show Calendar displays a calendar header just below the View title bar. The calendar header is a powerful tool 
to selectively display and manipulate date-oriented information. 

Show Calendar also attempts to determine which date/time fields you want to base the calendar on, using 
the following:

■ Show Calendar first checks the default Note type of the Topic. If the default Note type contains 
two date/time fields, the calendar is automatically based on these fields. 

■ If the default Note type contains more than two date/time fields, the calendar uses the first two 
in the Note type’s list of fields. 

■ If the default Note type doesn’t contain a date/time type field, Calendar Settings is automatically 
chosen. A dialog lets you set the date/time fields on which to base the calendar. 

You can apply Show Calendar to a View: 
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■ Create a View (using the New View command) and then select Show Calendar.

■ Choose Show Calendar while you’re in a Topic. WebArranger automatically creates a View for 
you. The calendar collects Appointment, Reminder, and To Do Notes that have dates in them.

When you select Show Calendar, the command name changes in the Views menu to Hide Calendar. Hide 
Calendar hides the calendar header and changes the command name back again.

THE CALENDAR HEADER

The calendar header selects which Notes to display in the View. Only those Notes display that contain 
date-oriented fields matching the dates selected in the calendar header. The calendar header acts as a 
date-oriented filter.

The calendar header has default values: 

■ Month drop-down list — set to the current month

■ Year drop-down list — set to the current year

■ Current date — selected and is indicated by the frame around the date in the calendar header

COLLAPSE AND EXPAND THE CALENDAR HEADER
In the top right corner of the calendar header is a small flag. Click 
this flag to collapse the calendar header to a single line.

Click it again to restore the full-size calendar header. A collapsed 
calendar header is convenient when running WebArranger on a small monitor, such as a PowerBook.

When the calendar header is collapsed you can’t click to select individual dates, because the three-
month display isn’t visible. However, you can still use the Month, Year, and Calendar Format drop-down 
lists, and the Previous and Next arrows, to control the calendar View.

Viewing a Specific Date
A calendar header View for a specific date shows Notes’ date/time fields specified.

Collapse/Expand flag

 Calendar format drop-down list

Three-month display

Next arrow

 Year drop-down listPrevious arrow

Month drop-down list

Week handle

Figure 10 The calendar header.
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To use the calendar header to see the Notes for a specific date:

■ Click the date in the calendar header to select it, when the calendar header is expanded;

■ Or, choose the date from the drop-down list, when the calendar header is collapsed. 

To change the date in the calendar header, click a different date or use the drop-down lists. The View is 
updated to display the Notes that appear on that date.

CALENDAR FORMAT

The Calendar Format drop-down list in the calendar header 
has these options:

■ By day — Displays the Notes that fall on a 
particular date, laid on a time bar that runs along 
the left edge of the View area. 

■ By workday — Same as By day, except the time bar 
is restricted to show just the hours of the standard workday. You can set the time bar’s 
increments in the Calendar Settings dialog.

■ By week — Displays Notes with dates that fall within the seven days of the selected week. 
They are laid out in seven day lists arranged in two columns in the Topic area.

■ By month — Displays Notes that fall anywhere in the days of the selected month. They are 
arranged in a standard monthly calendar layout in the Topic area.

■ Day List — Displays just a list of days and their Notes.

BY DAY
The time bar covers the hours of the day in 1 hour, 30-minute, or 15- minute increments. You can set the 
increment in the Calendar Settings dialog. See Workday Times and Intervals on page 99.

Notes displayed in the By day format have a black duration line on the right edge of the time bar. If two 
Notes overlap, the duration line is striped to indicate the time conflict.

To use the By day calendar format:

Choose By day from the Calendar Formats drop-down list; or

■ If the calendar header is expanded, Click the three-month display to select a day;

■ Or, click Days in the Calendar Settings to set the Summary Line for Notes.

BY WEEK
To use the By week calendar format:

1 Choose By week from the Calendar Formats drop-down list; or
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■ If the calendar header is expanded, Click the week handle and 
choose a week from the three-month display. 

2 Double-click the white space under the existing Notes on a day to 
create a Note.

3 Click Week in Calendar Settings dialog to set the Summary Lines 
for Notes.

4 Double-click the header bar of the appropriate day to switch to a By day View.

BY MONTH
To use the By month calendar format:

1 Choose By month from the Calendar Formats drop-down list; 

■ Or, if the calendar header is expanded, Choose a month from the three-month display.

2 Click the month’s name, or click the Days of the Week label at the top of each month. 

■ Click Months in Calendar Settings to set the Summary Line for Notes.

■ Double-click the white space under the existing Notes on a day to create a Note.

■ Double-click the header bar of the appropriate day to switch to a By day View. 

To change the months displayed in the calendar header:

1 Select the By month calendar format. 

2 Click the Previous or Next arrow to shift the set of months visible in the calendar header by 
one month; 

■ Or, select the desired month and year from the Month and Year drop-down lists.
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CALENDAR SETTINGS

Calendar Settings controls the display of the 
calendar. Use it if you want to modify the 
default Calendar Settings.

Calendar Settings is enabled when you are in 
a calendar View.

TOP SECTION
The top section of the Calendar Settings 
dialog contains two controls.

DEFAULT DATE RANGE
The On entry drop-down list controls the default date range. Choose 
an option in the drop-down list to select what you see when you 
display a calendar. Last Shown shows the calendar as it was left.

CALENDAR HEADER 

The with calendar header drop-down list controls whether the 
calendar header displays. 

■ Select Open to display the calendar header when you 
open the calendar.

■ Select Close to not display the calendar header when you 
open the calendar.

■ Select Last Shown to leave the calendar header as it was left.

MIDDLE SECTION
The middle section of the Calendar Settings dialog controls the behavior 
of Notes. 

SELECT NOTE
Select the Note type from the Setup drop-down list. This Note type is 
affected by the other options in the middle section.
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START/END FIELDS
Use the Start at and End at fields to determine when a 
Note is displayed.

Appointment and To Do Notes use the Begin and 
End fields to specify what date they appear on 
the calendar. 

The Start at field is required. The End at field is 
not required.

The calendar automatically collects Appointment, Reminder, and To Do Notes with dates in the Begin 
field. To collect other Notes automatically, use Topic Settings in the Topics menu.

To Do Notes are automatically collected by the To Do and Schedule Topics. However, only To Do Notes 
with a date in the Begin field display on the calendar.

Date Created Field
Some standard Notes, such as the Memo Note, don’t contain date/time fields. However, all Notes 
contain two date/time system fields: the date Created and date Last Modified fields. 

When you base a calendar on the date Created field, you can quickly browse through a Topic’s Notes 
in the order in which you created them. However, you can’t “reschedule” a Note. System fields can’t be 
edited. All system fields are automatically managed by WebArranger and reflect the history of each 
particular Note. 

To create a calendar that displays Notes based on the date Created field:

1 Create a calendar.

2 Choose Calendar Settings in the Views menu.

3 Select the date Created field in the Start at drop-down list. 

4 Click OK.

You can also use date Created to detect patterns or to see when something occurred.

You can’t base a calendar on the date Last Modified field.

CARRY FORWARD NOTES
You’ve got a list of To Do Notes on one day. Some will get done, others won’t. You want the unfinished 
Notes to carry forward to the next day, and continue until they get done.

WebArranger supports Notes that carry forward in the calendar’s untimed event area. See Untimed and 
Timed Events on page 100.
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Select the Carry forward until checkbox and select a field in the drop-down list. WebArranger will continue 
to put the Note on your calendar until that field in the Note has been checked.

For example: The To Do Note has a Completed checkbox field. To Do Notes carry forward, starting on 
the date they appear and continuing until the Completed field is checked.

The Note type you selected in the Setup drop-down list must contain a checkbox field. If not, add one. 
The To Do Note is the default carry forward Note type. However, any Note can be set up to carry 
forward. Checkbox fields behave just like any other field when you add them to a Note. 
See Checkbox Field on page 66. 

To use Notes that carry forward:

1 Place a Note that is set up to carry forward in the untimed event area of the current day or any 
future day.

2 At midnight on that day, the Note carries forward to the next day. 

If you create a Note in the past, WebArranger immediately carries it forward to the current day, not 
waiting for midnight.

SUMMARY LINES
Each calendar format provides a 
different amount of space to display 
Notes. For example: Notes in the By 
month format are given less space than Notes in the By day format.

The Summary Line buttons control the Note’s Summary Line in the three calendar formats. Use these 
buttons to set an appropriate Summary Line for each type of Note in each calendar format. These 
settings override the default Summary Line for the Note type.

WORKDAY TIMES AND INTERVALS 
You can customize the hours displayed on your calendar. 

The Show Day and Workday in drop-down list lets you 
select time intervals.
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UNTIMED AND TIMED EVENTS
A calendar’s untimed event area is at the bottom of the window. Here you can manage information with no 
specified time. For example: You use the untimed event area to store To Do Notes that contain tasks to 
accomplish during the day. See Carry Forward Notes on page 98.

Default Note types are generated whenever you use calendar shortcuts to create Notes. In the Web 
Schedule, the To Do Note is the default for timed and untimed events. In the Organizer Template’s 
Schedule Topic, the Appointment Note is the default timed event. The default for untimed events is the 
Memo Note. See Calendar Shortcuts on page 100.

You can change the default Note types with the drop-down lists. Your default Note selection only affects 
Notes created when you double-click or Option-double-click in the calendar. You can always drag any 
type of Note into the timed or untimed event areas.

Both timed and untimed events appear in By week and By month views. Timed events are listed before 
untimed events.

Calendar Shortcuts
These are shortcuts to create Notes:

■ Option-double-click on a day to create a default timed event.

■ Option-double-click in the untimed event area to create a default untimed event.

If a day on the calendar By month View is full: 

■ -click on the day number to create a timed event.

■ Option- -click on the day number to create an untimed event.

To reschedule an untimed event, drag it to the desired date in any calendar view, or drag it to any day in 
the three-month display.

ATTACHING VIEWS 

Views for standard Topics are the most common kinds of Views. The Contents lists other places you 
might want to attach Views: the Document Folder, other Folders, Topics, and the Trash. 

Views of larger sets of information, like Folders, makes it easier to find stuff, or to summarize 
information that you normally organize as separate Topics.
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The first item in the Contents list always shows 
the name of the open Document. This is 
called the Document Folder. 

The Contents list also includes individual 
Topics, which you create and delete with the 
commands in the Topics menu. You can 
rearrange and rename anything in 
the Contents list.

The last item in the Contents list is the Trash. 
The Trash is like the standard trash can in the 
Macintosh Finder.

ATTACH A VIEW TO THE DOCUMENT FOLDER

The Document Folder itself 
doesn’t contain any Notes. All 
the Document’s Notes are in the 
Topics in the Contents list. The 
Document Folder represents all information in the WebArranger Document. The right side of the View 
title bar displays the number of Folders in the Document, instead of the number of Notes in the View. 

Once you’ve selected the Document Folder, you can create a View by choosing New View in the Views 
menu. See New View on page 73.

When you create a View associated with the Document Folder, WebArranger builds a list of all Notes in 
your Document. It may be a very large list. You can use the View tools to customize this View of all 
information in your entire Document. See The View Tools on page 77.

ATTACH A VIEW TO A FOLDER

Views are attached to Topic Folders just as they’re attached to the Document Folder — select a Folder in 
the Contents and choose New View from the Views menu. Folder Views provide a summary of related 
information organized as multiple Topics within a Folder.

For example: You have a People Folder with separate friends, family, and business Topics. Creating a 
View of the Folder lets you search all your contact lists at once. Since there are no Notes in the Folder 
itself, the Folder represents all information from the Topics in the Folder. So, the right side of the View 
title bar doesn’t display the number of Notes in the View. It shows the number of Topics in the Folder. 

This Folder shows the 
name of the Document
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ATTACH A VIEW TO THE TRASH

The Trash functions more like a regular Topic than the Document Folder or a Topic Folder. When you 
select the Trash in the Contents, it displays the Notes in the Trash. The right side of the Topic title bar 
shows how many Notes are in the Trash. This is the number of Notes you’ve dragged to the Trash since 
the last time you chose Empty Trash in the Edit menu. You can create Views of the Trash.

VIEWS WITH MULTIPLE WINDOWS

The New Window command in the Windows menu displays information from one 
Document in multiple windows. Displaying Views in multiple windows works 
the same as displaying Topics in multiple windows, since a View is just another 
way of looking at the information in a Topic. You can select a Topic or a View 
in any window, and the corresponding information displays in the Topic area of 
the window.

Hide the Contents list, Shelf, and Icon Bar to use the entire Document window area to display information. 
This lets you create smaller windows, and fit more windows on your screen. Since you can drag Notes 
between windows, multiple windows are often very convenient.  
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■ To hide the Contents list and Shelf, choose Hide Contents/Shelf in the Windows menu. 

■ To hide the Icon Bar, choose Hide Icon Bar in the Windows menu. 

To display these items again, select Show Contents/Shelf and Show Icon Bar. See The Icon Bar on page 117.

NAVIGATE TOPICS WITH THE CONTENTS HIDDEN
When the Contents list and Shelf are hidden, you can still select different Topics and Views with 
Go To in the Topics menu. You can also use the View list drop-down list in the Topic title bar. 
See Go To on page 75.

WORKING WITH NOTES IN VIEWS

Working with Notes in Views is almost identical to working with Notes in Topics. You select Notes 
and text, open and close Summary Lines, expand and collapse Sub-Notes, and edit the information in 
a Note’s fields in the same manner. However, dragging, creating, and deleting Notes can have slightly 
different effects. See Calendar View on page 105.

MOVE NOTES

When you drag a Note to rearrange it in a View, you may move it further than you think. 

■ When you drag a Note up one position in a Topic, the Note moves to the new position. 

■ When you drag a Note up one position in a View, the Note moves one position in the View, but 
it may move many positions in the Topic. The filter setting for the View may hide Notes that are 
visible in the Topic.

■ Notes in a View move in the Topic to the same position relative to the Note above them. When 
a Note is moved, it always follows the same Note in both the View and the Topic.

DRAG NOTES

Dragging Notes in a sorted View also has a slightly different effect: The move is mimicked in the View’s 
Topic, and the Note is moved to follow the same Note in both Topic and View. 

However, the next time you choose the View, Notes from the Topic are automatically re-sorted if Update 
View on Entry is chosen. The dragging is undone. Conversely, the result of the move in the Topic remains 
in effect.

CREATE NOTES

When you create a Note in a View, the Note is actually created in the Topic and displayed in the View. 
When you switch back to the Topic, the newly created Note is right where you expect it to be. 
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This works fine for standard Topics, but works differently in the Document Folders and Topic Folders. 
They don’t contain Notes. When you create a Note in a View of a Document or Topic Folder, 
WebArranger stores the Note in the first Topic in the Contents list with a default Note type which matches 
the Note type you created.

For example: You create a People Note. It is placed in the first Topic in the Contents containing a 
People Note.

If no Topic has a default Note type that matches the Note type you created, WebArranger stores the Note 
in the first Topic in the View’s Document or Topic Folder. See Set a Topic’s Default Note Type on 
page 45.

DELETE NOTES

Deleting Notes in Views also behaves slightly different from deleting Notes in Topics. 

■ When the View is associated with a standard Topic, deleting a Note in the View deletes the 
Note from the Topic. 

■ When the View is attached to a Document or Topic Folder, deleting a Note in the View 
deletes the Note from the Topic where it actually appears. Document and Topic Folders 
don’t contain Notes.

DELETE A NOTE WITH MULTIPLE APPEARANCES

A Note displayed in a View may have multiple appearances in the View’s Topic. 

For example: A Note may be in two Topics in the same Folder. When you create a View of the Folder, 
the Note appears only once in the View. When you delete the Note from the View, the Note is deleted 
from all Topics in that Folder. 

You can delete a Note from all Topics in your Document by choosing Destroy Note in the Edit menu.

When you delete a Note from a View, and the View’s filter specifies Notes and Sub-Notes, the 
Note is removed from the View’s Topic and from any Notes in that Topic. This is the same as 
choosing Destroy Note.



WebArranger  105

CALENDAR VIEW

Notes displayed in a calendar View use little 
real estate. 

When you click the Summary Line the Note is 
selected, but it doesn’t open. 

Double-click anywhere on the Note’s 
Summary Line to edit Note fields while you’re 
in a calendar View. 

This moves the Note into a hoisted Note, where 
you can edit the fields. A Note in an open window 
is called hoisted Note. 

When you’re done, click the close box of the 
window. This is the same behavior as when you 
double-click a Note icon anywhere else.

CREATE NOTES

To create a Note for a particular day and time:

1 Choose By day in the Calendar Format drop-down list.

2 Select the date in the calendar header.

3 Click the time bar to select the start time. Drag downward. Release the mouse button when you 
reach the ending time. 

The Note is displayed in its own window. WebArranger automatically fills in the Note’s appropriate 
date/time fields with the date and time values chosen, and it is added to the Topic.

4 Fill in the rest of the Note’s fields and click the window’s close box.
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CHANGE DATE/TIME FIELDS

MOVE NOTES BETWEEN DATES
There are a number of ways to drag a Note to a different date:

Table 17 Moving Notes between dates

CHANGE THE DATE 
■ Double-click the Note to move it into its own window. Edit the appropriate date/time fields and 

close the window. The Note automatically moves to the new date and time that you set. Make 
sure you change both the start and end date/time fields.

■ Cut and Paste in the Edit menu.

CHANGE START TIME AND DURATION
To change the start time of a Note:

1 Select the appropriate day in the calendar header and select the By day calendar format.

2 Find the Note you want to change.

3 Click and drag the Note to the new start time.

To change the duration of a Note in a Calendar View:

1 Select the appropriate day in the calendar header and select the By day calendar format.

2 Find the Note you want to change.

3 Click the bottom of the Note’s black duration line and drag it to the new end time.

You can also double-click a Note to move it into its own window. Then edit the start and end date/time 
fields. Type the new information or use the field’s pop-up date and time menus.

Calendar Status Action

Calendar header is expanded and the 
new date is visible

Drag Notes directly to the desired date in the calendar 
header. While you are dragging the Note, the dates in the 
calendar header are highlighted as you pass. Release the 
mouse button when over the desired date.

Calendar header is expanded and By 
week calendar format selected

Drag Notes directly from any day to any other day of the 
week, or to the dates in the calendar header.

Calendar header is expanded and By 
month calendar format selected

Drag Notes directly from any day to any other day of the 
month, or to the dates in the calendar header.

Calendar header is expanded in Day List 
calendar format

Drag Notes directly from any day to any other day 
displayed in the list, or to the dates in the calendar header.
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REPEATING EVENTS 

Suppose you want Notes to appear every Tuesday, once a month, or once a year. You can use the 
Repeating Event button in any date/time field to make a Note appear multiple times in the calendar. Any 
Note that contains a date/time field can become a Repeating Event in the calendar. An example of a 
date/time field is the Begin field in the Appointment Note. 

INSERT REPEATING EVENT

To insert a Repeating Event: 

1 Drag a Note with a date/time field onto your calendar. The Note opens in 
a window. 

2 Click the Repeating Event button in the field that controls the starting date 
and time to display the Repeating Event dialog.

REPEATING EVENT DIALOG
The Repeating Event dialog sets the start and end dates, the start 
and end times, and the repetition pattern for Repeating Events.

1 Select in the Start Date drop-down list to set a date if it is 
different from where you put the Note.

2 Select in the Times drop-down list to set the start and end 
times if the event takes place during a time period.

3 Select the repeat frequency in the Repeat settings.

4 Select an end date or a number of repetitions for the event 
in the End settings.

5 Click OK. Each occurrence of this event displays on your calendar.

When a Repeating Event is set, no value appears in the Note’s end field. All information about the 
Repeating Event displays in the start field.

To make an untimed event that repeats, create it first as a timed event. Then drag it to the untimed 
section of the day calendar view.
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TURN OFF A REPEATING EVENT
To stop a Repeating Event:

1 Double-click the Note that contains the Repeating Event.

2 Click the Repeating Events button.

3 Click Non Repeating.

DRAG TO CHANGE REPEATING EVENTS

You can drag Repeating Events between days to change the day they start or occur. If you drag a 
Repeating Event to another time within a day, a Change Repeating Event dialog displays. 

■ Click Just this Event to change the event for just one occurrence.

■ Click All Future Events to change the event for this and future occurrence.

■ Click All Occurrences to change the event for every occurrence.

■ Click OK to approve the change.

You can bypass the Repeating Events dialog by changing preferences in the Document Preferences dialog. 
See Document Preferences on page 108.

DELETE REPEATING EVENTS

Select a Repeating Event and press Delete to display the Delete Event dialog.

■ Click Just this Event to delete just this one occurrence of the event.

■ Click All Future Events to delete this and future occurrence.

■ Click All Occurrences to delete all occurrences of the event.

DOCUMENT PREFERENCES 

Document Preferences set default behavior when you drag 
or delete a Repeating Event. To set default behavior:

1 Select Document Preferences in Preferences in the 
File menu.

2 Select default behavior for Repeating Events in the 
two drop-down lists.

The When I drag an event drop-down options that 
apply when you drag within a day:

■ Change All Events — Whenever you drag one 
Repeating Event, all occurrences of the 
event change.



WebArranger  109

■ Change This Event — Whenever you drag one Repeating Event, just that occurrence of the 
event changes.

■ Change Future Events — Whenever you drag a Repeating Event, that event and all 
occurrences following it change.

■ Show Dialog — When you drag a Repeating Event, a dialog lets you choose behavior for that 
event. Show Dialog is the default value.

The When I delete an event drop-down lists these options:

■ Delete All Events — Whenever you delete one Repeating Event, all occurrences of the event 
are deleted.

■ Delete This Event — Whenever you delete one Repeating Event, only that occurrence of the 
event is deleted.

■ Delete Future Events — Whenever you delete one Repeating Event, that event and all 
occurrences following it are deleted.

■ Show Dialog — Whenever you delete one Repeating Event, a dialog lets you choose behavior 
for that event. Show Dialog is the default value.

If you drag a Repeating Event from one day to another, the Begin field changes to Repeats irregularly and 
no dialog displays.

See Document on page 12.
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CHAPTER 6: TOOLS

The Tools menu is installed when you launch WebArranger 2.0. If you are upgrading 
from WebArranger 1.0, this menu is updated.

INSTALL INTERNET PLUG-IN

This command is enabled if you are upgrading and have a defined 
Home Document. For more information, see Home Document on 
page 13.

Otherwise, the Internet Plug-in is installed along with the rest of 
WebArranger 2.0, and this command is disabled.

LAUNCH URL

This command takes you right to the Internet!

1 Select a URL Note. It is boxed when it is selected.

2 Select Launch URL;

■ Or, press -R.

TIP: You can also use -R when your cursor is just in the URL field ... the Note doesn't have to 
be selected.

TIP: -R works with other Internet applications when you set it up in Internet Config. For example: For 
NewsWatcher, set up Internet Config for news format — news:addres ... such as news:alt.adoption.

INTERNET PLUG-IN MENU OPTIONS

CLEAN UP “CHANGED WEB PAGES” TOPIC

Every now and then, select this command. The Changed Web Pages Topic is the repository for URL 
Agent missions.

AGENTS

The sub-menu lists WebArranger’s 
Agents that do so much to help you 
manage information from the Internet.
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START URL AGENT

The URL Agent monitors http URLs for changes, and lets you know when a Web pages has changed. You 
don’t have to go there manually “just to see if anything has changed”. The default note type is URL. 

To use URL Agent:

1 Put your favorite URL Notes in the URL Agent Topic.

■ To move a URL Note into this Topic, drag it. 

■ To copy a URL Note, press the Option key while you drag it. 

■ To create a URL Note, click it in the Shelf and complete the fields.

2 Select Start URL Agent, and the URLs are watched. The tool’s name changes to Stop URL Agent.

3 URL Agent puts copies of the URLs of changed sites in the Topic, Changed Web Pages.

4 To end URL Agent activity, select Stop URL Agent.

SET THE FREQUENCY
To set the frequency for the checks by URL Agent:

1 Select Preferences in the File menu.

2 Choose Internet Plug-in. 

3 Set the frequency in the dialog. 

4 Select the checkbox if you want a dialog to alert you 
when a change has been detected.

URL Agent begins checking the URLs when you select Start 
URL Agent. It continues checking at the frequency you set, and 
stays on between WebArranger launches. However, URL Agent is active only while the 
WebArranger application is running.

❖ Note: URL Agent looks at the last modified field in a Web page’s http header. If this field is not 
present, URL Agent can not work as described. The affected URLs are put in the Changed Web Pages 
Topic with an error field attached. It may be helpful for you to contact the WebMaster at a site which 
does not use this field, if you want its URL checked by URL Agent. 

CHANGED WEB PAGES
Open the Changed Web Pages Topic to display the list of URLs copied there by URL Agent.

Select a URL and select Launch URL to go to the URL’s Web page. Or, press -R. You are there just by a 
couple of clicks!
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When URL Agent first places a URL into this Topic, the Note looks like the example below. The Next Time 
to Visit field is set by you, and used by the Web Schedule calendar to track URLs and To Do Notes. You 
can attach an Alarm here. This field is not used by URL Agent. URL Agent visits are set by the frequency 
you specify in Preferences.

When URL Agent first places a URL into this 
Topic, the note looks like this. 

TIP: The URL Agent requires the Last Visited 
field must be on or after the Last Agent Action 
field. Last Visited shows the last time you were 
at that Web site via -R. When you do not visit the Web page, this field is not updated. URL Agent will 
not check it again for you until the Last Visited date is on or after the date it last checked. 

When the URL has been processed by 
URL Agent, the Note contains the Last Agent 
Action field. This field shows the last date and 
time URL Agent checked the Web page. The 
other field added tells you when the Web 
page changed. 

When you select the checkbox in Step 4, this 
dialog tells you when a change has been noticed.

START URL VALIDATOR AGENT

Have you ever used a URL, only to discover it no longer works? WebArranger’s URL Validator Agent gets 
that information for you.

The Validator checks http URLs in your History Topic, and puts invalid ones in a special Topic. The 
Validator also attaches an Error Description field to each invalid URL, so you’ll know if it is no longer 
active or if it has changed.

The History Topic auto-gathers all URL Notes in your Document. For more information, see Auto-Gather 
Notes into a Topic on page 46.

To use the Validator:

1 Select Start URL Validator Agent to begin the checking. 

2 The Agent puts invalid URLs in the Invalid URL Topic. The Validator attaches an Error Description field 
to each invalid URL.
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3 When a URL has moved, it even puts the active address in the URL field. And a field called Outdated 
URLs is added to the Note. This field contains the old address. 

4 When all URLs have been checked, the URL Validator turns off automatically.

FTP DOWNLOAD AGENT

The FTP Download Agent can save the time spent waiting for an Anarchie FTP site to be available for 
downloading. It attempts to download files from the specified ftp URLs for you. 

To use FTP Download Agent:

1 Put a ftp URL Note in the Topic, FTP Download Agent. 

2 The Agent puts the downloaded file’s URLs in the Topic, Successful FTP Downloads. Each file you 
want downloaded must have its own URL.

SET THE FREQUENCY
To set the frequency download attempts by FTP 
Download Agent:

1 Select Preferences in the File menu.

2 Choose Internet Plug-in. 

3 Set the frequency in the dialog.

❖ Note: FTP stands for File Transfer Protocol. This is a 
common way of moving files between two Internet 
sites. It’s a special method to login to another Internet 
site to get and/or send files. There are many Internet 
sites which have established publicly accessible files of material that can be downloaded using FTP. 

START WWW FOOT STEPS

WWW Foot Steps logs your trail as you surf with any Web browser that supports the WWW Apple Event® 
Suite. Later you can follow these URLs to revisit a page. This can be very handy during research.

WWW Foot Steps captures the Netscape Navigator history while you are using the browser. 

For example: You and your best buddy, Mona, are looking around on Flag Day. You make a Topic called 
Flag Day and save the Foot Steps log in it. This preserves your tracks, and when Mona is going nuts 
trying to remember where she saw that address for hybrid Kansan coffee beans, she owes you big time. 
To create a Topic, use the commands in the Topics menu.
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To use WWW Foot Steps:

1 Select Start WWW Foot Steps. This activates the URL path capture. It takes you right to your browser. 
The tool name changes to Stop WWW Foot Steps.

2 To deactivate the capture, select Stop WWW Foot Steps.

IMPORT/EXPORT

This tool imports and exports the 
bookmarks you’ve made during your 
Internet excursions.

To import bookmarks:

1 Select Import Netscape Bookmarks or Import Anarchie Bookmarks in the Import/Export menu.

2 When your bookmarks display, click the Bookmarks drop-down list. This list is available on the 
Topic header bar or beside the Topic name.

3 Select the View in the drop-down list. Add and work with URL Notes here as in any Topic. 

Now you can manipulate and categorize your bookmarks the way 
you want them to be. This is very useful if you have a large number 
of bookmarks. 

TIP: When you import bookmarks, the bookmark Notes in your 
current bookmarks Topic are replaced. To avoid losing these Notes, 
create another Topic and move your existing bookmarks to it before you import. 

To export bookmarks, select Export Netscape Bookmarks or Export Anarchie Bookmarks. 

❖ Note: You must be in the FTPs View to export Anarchie bookmarks.

INTERNET APPS

This submenu lists Internet applications types. 

Click one to launch it. It launches when it is 
configured with Internet Config. 

Internet Config and WebWhacker are installed with 
WebArranger. 
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OPEN “INTERNET CONFIG”

See Internet Config on page 6.

OPEN “WEBWHACKER”

WebWhacker is a great tool to use with WebArranger. WebWhacker 
captures information, so you can store it to peruse later while off-line.

If did not to install WebWhacker when you installed WebArranger, 
re-run the WebArranger installation.

YOU NEED TO KNOW
■ WebWhacker replaces the whacked URL’s prefix of HTTP:// with the prefix of FILE:. 

■ In order to have WebArranger launch this type of URL, establish the FILE: prefix within 
Internet Config and associate your browser helper application to it. 

■ To start using WebWhacker, you must know the site you want to whack. 

For example: To whack the CE Software Home Page, select the line below and copy it to the 
Clipboard. Then launch WebWhacker. 

                                         http://www.cesoft.com

To use WebWhacker:

1 Select Open WebWhacker. You can also create a 
file reference to it with the File Note. See File 
Note on page 20.

2 Select New Group to create one. For example: 
Name the group EXAMPLE.WWD

3 Select New URL in the Add menu.

4 Paste the URL, and click OK.

5 Select Whack on the tool bar.
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6 When the information is whacked, your browser is launched. 

❖ Note: The URL field is referencing a FILE:// URL. You can use 
Grabber to capture that URL and add it to WebArranger. Just select the URL and use the hot key 
sequence to grab.

See WebWhacker’s extensive on-line Help for more information.

TIP: WebWhacker replaces the whacked URL’s prefix of http:// with the prefix file://. So that 
WebArranger can launch this type of URL, establish the file:// prefix in Internet Config. Associate your 
browser helper application to it. Then, create a helper in Internet Config called file and point it to your 
Web browser. Now you can whack a page, and launch it with -R.

THE ICON BAR

You can shortcut to many of WebArranger’s features with the buttons on the 
Icon Bar.

Select Show Icon Bar in the Windows menu. 

New Note Add Field Remove Field

Note Catalog

New View

Field Catalog Find Next Appearance

Filter View Sort View Show Table

Gather 

Figure 11 The Icon Bar provides shortcuts to WebArranger features.
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KEYBOARD SHORTCUTS

Table 18 WebArranger hot keys

Shortcut What it does Shortcut What it does

-A Select all Notes in a Topic or 
View

-T Plain text

-B Bold text -U Underline text

-C Copy -W Close Document if front window is 
a Document window; if front win-
dow is a catalog, close the catalog

-D Duplicate Note… -X Cut

-E Set Alarm -Y Time/date stamp (same as to click 
the time display in topic header 
bar)

-F Find… -Z Undo/Redo

-G Find Next -Return New Note; no dialog displayed; 
Topic’s default Note type

-I Italic Tab Move to next field in current Note 
or dialog

-J Go To… Shift Move to previous field in current 
Note or dialog

-K Destroy Note; warning dialog 
displayed

-' Expand Note

-L Next Appearance - - Filter…

-M Gather (query by example) -; Collapse Note

-N New Note; dialog displayed -= Update now (View)

-O Open… -? Help

-P Print -[ Close Note

-Q Quit -] Open Note

-R Launch URL -. Cancel a dialog; force quit 
some operations

-S Save
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FUNCTION KEYS

Table 19 Function keys

Key Use

Home/End Scroll to beginning or end of list

Page Up/Page Down Scroll up or down by one screen

Forward Delete Delete selected text, or character after the insertion point

Command-Arrow keys Up and Down moves the selected notes up and down. 
Left and Right promotes/demotes the selected notes, if possible.

Control Up and down act as Page Up and Page Down

Control-Shift Up and Down act as Home and End

Shift-Click Multiple select

Option Up and Down select the next or previous text field (contents) or 
summary line. Left and right move by words.

-Backspace Destroy Note

-Option-Backspace Destroy Note; no dialog

-Clear Destroy Note

-Enter Same behavior as Return Key

F1 Undo

F2 Cut

F3 Copy

F4 Paste

Help Opens the Help Document (same as the Help command in the 
Apple menu)

Escape Cancels a dialog
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FILE FORMATS 

File format What it does

Text, one ¶ per note Links together the contents of all fields in a Note, then inserts 
a paragraph return. If you have paragraph returns within the 
contents of your fields (like in a paragraph of text or a multi-line 
address), they appear as well.

Text, one ¶ per field Exports the contents of each field onto its own line in the 
text file.

Text, one ¶ per field (UNIX®) Exports the contents of each field onto its own line, but also 
limits the number of characters on a line to 80. This is for 
compatibility with computers that run or communicate with the 
UNIX operating system.

Text, named fields Exports one field per line, but precedes the contents of each 
field with the name of the field, a colon, and a space. It also 
adds a blank line between notes. This format is useful if you 
want to use the information in a WebArranger Topic or View on 
a computer that only supports simple text editing. The field 
names make it easy to see the structure of your information.

Text, named fields (UNIX) Same as “Text, named fields” except that lines are trimmed to 
80 characters for compatibility with computers running UNIX.

TAIL WebArranger’s special information language format. Use TAIL 
to send Topics and Views to other WebArranger users, so they 
can bring the information into another WebArranger Document 
using the Import or File Merge commands.

Tab Delimited A common file format. The contents of fields within a Note are 
separated by tabs, while the Notes themselves are separated 
by returns. When you choose Tab Delimited, only the top level 
Notes are exported.

Comma Delimited A common file format. The contents of fields within a Note are 
separated by commas, while the Notes themselves are 
separated by returns. When you choose Comma Delimited, 
only the top level Notes are exported. 

Mail Merge A structured file format designed to help you create lists of 
information to use with the mail merge feature of a word 
processing program. The Mail Merge format is more 
sophisticated than the Tab and Comma Delimited formats, 
because it exports not just the contents of fields but the names 
of the fields as well. This allows word processing programs to 
ask you questions about the mail merge procedure using the 
actual names of the fields from your WebArranger Document.
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Table 20 File formats

 Arrange File The standard file format for WebArranger. Saving a copy of 
your file in this format is the same as duplicating the file in the 
Finder. Re-opening a file saved in this format results in a 
Document that is identical to the original.

Text Exports your entire WebArranger Document as a simple text 
file that can be read with any word processor. You can’t use 
the Open command to re-open a WebArranger Document that 
has been saves as text. But you can import it using the Import 
command. The resulting Document won’t be the same as the 
one you saved, because text files can’t contain the structural 
information that WebArranger uses to organize Documents.

WebArranger Template Saves your WebArranger Document as a template file. 
Template files are like stationery pads. You choose from a set 
of template files when you use the New command to create a 
Document. Saving a file as a template lets you extend the set 
of templates that WebArranger can use.

File format What it does
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CHAPTER 7: FORMS 

INTRODUCTION

A Form is just an arrangement of fields, field names, text, and graphics. Graphics 
includes shapes, lines, colors, imported graphics, and patterns. You make this 
arrangement with the tools and commands in the Form Editor.

When you look at a Note in as a Form, you see a 
custom layout of the Note’s information, instead of 
the Note’s usual format.

This example is a Note in usual format. The 
example below is a Note as a Form.

There are three ways to use Forms in 
WebArranger: 

■ Set up a View to display Forms. 
Forms make efficient use of the 
Macintosh display because you 
can combine many fields on a 
single line.

■ Attach and designate a Form as a 
default Form for a Note type. For example: You display information about companies you work 
with in a Company Note which you have customized. Your customized Company Note contains 
a default Form, which displays in every View.

■ Print Notes’ information on paper, envelopes and labels. You can create Forms that arrange 
information to fit envelopes, labels, file cards, etc. For example: You set up a View in your 
Contacts list to show a file card Form with information about each contact.

WebArranger ships with a Forms package to help you create your own Forms and labels. It 
includes a set of Avery™ label and standard envelope layouts. 

See Using Forms on page 133.

FORM SPECIFICS

■ Forms are a View tool.

■ Forms can only be used in a View. 

■ Each Form you create has a name and can be used in multiple Views. 

■ Only top-level Notes in a View can display as a Form; Sub-Notes cannot.

■ Forms control only the appearance of a Note, not the content.
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For example: You create a Form for a People Note that only displays the first name, last 
name, and phone number of the person. The People Note itself still contains the full set
of information.

THE FORM CATALOG

The Form Catalog lists all the Forms in your WebArranger 
Document. To display the Form Catalog, choose Form Catalog in 
the Notes menu.

The Form Catalog manages your Forms:

■ Create Forms — Click Define New to go to the 
Form Editor.

■ Edit Forms — Select the Form and click Edit to display 
the Form Editor.

■ Duplicate Forms — Select the Form and click Duplicate.

■ Delete Forms — Select the Form and click Delete.

■ Move Forms between WebArranger Documents — Drag a Form from the Form Catalog of 
one WebArranger Document to the Form Catalog of another.

THE FORM EDITOR

You can create a Form in several places in your WebArranger Document. In each place, WebArranger 
tries to guess what fields you’ll need in the Form, and places those fields in the Form Editor’s Layout Area. 
See Create a Default Form While Defining a Note on page 132 and Create a Form While Printing on 
page 133.

When you create a Form from the Form Catalog, WebArranger makes no guesses. You get an empty slate 
... the Form Editor.

CREATE A FORM

To go to the Form Editor:

1 Select Form Catalog in the Notes menu.

2 Click Define New, or select an existing Form and click Edit.

3 Build the Form.

4 Name the Form.
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5 Click OK when you have completed creating or editing your Form. Your new or edited Form is 
added to the Form Catalog.   

LAYOUT AREA

The Layout Area is where you build the Form. You can choose a graphic or a color for the background.  To 
select a background:

1 Click the Layout Area to select it. If you are editing an existing Form, this also deselects all elements 
in it.

2 Use the Fill Controls for color and pattern. See Pen and Fill Controls on page 130.

■ Or, paste an image from another program.

TOOL PALETTE

These tools create the elements of a Form. Elements refer to the parts of your Form, such as the fields, 
boxes, ovals, and lines. A Form can contain a maximum of 60 elements. 

Layout Area

Label buttonName text field

Pen and 
Fill Controls

Tool Palette

Pen Menu

Align Menu

Tools Menu

Figure 12 The Form Editor
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The tools work like tools in a standard drawing application. Click a tool to select it. After you use a tool, 
WebArranger reverts to the pointer.

POINTER

The pointer selects any element in the Form layout. You can drag and drop elements to move them. An 
light gray line displays at the text baseline to help align the elements.

To select more than one element, Shift-click them. Or you can drag to select several, and then 
Shift-click elements to deselect.

TEXT 

The text tool creates text in a text box. To create a text box, select the text tool and 
click anywhere — in a field element, in a box or oval, in the background.

FORMAT TEXT
You can format text in any element, except a field name. When you format text in 
field elements, all text that displays in that field appears in that format.

To format text:

1 Click the element to select it.

2 Use the Text menu to set text formatting.

■ Justification works only on text fields. It does not work on date and 
number fields.

See Text Menu on page 27.

Pointer

Named Field

Unfilled 
Rectangle

Unfilled 
Rounded Rectangle

Unfilled Oval

Text

Unnamed Field

Filled Rectangle

Vertical Line

Filled Rounded Rectangle

Filled Oval

Horizontal Line

Figure 13 Click a tool to select it from the Tool palette.
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NAMED FIELD

The named field tool draws one element that 
creates two boxes: the field name and the field 
contents. This tool is the standard box-drawing 
tool, + .  

When you place a named field in your Form, 
WebArranger displays the contents of that field 
in the space occupied by the field contents 
element. The contents may be text or a date, 
number, picture, etc. 

Select the field from the drop-down lists 
provided in the elements. When you select a 
field for one, it appears for both. The field 
contents box can be sized to accommodate the 
text string, picture, etc.

This example shows how the Form looks 
in the Notes.

You can delete the field name box without 
affecting the field contents box. If you delete 
the field name, the field contents 
is the same as if you use the unnamed 
field tool.

Field TextField Name

Figure 14 The named field tool creates two boxes.
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UNNAMED FIELD 

The unnamed field tool creates a field 
text element.

UNFILLED AND FILLED RECTANGLES 

Create unfilled or filled rectangles with the two rectangle tools. When you create an unfilled rectangle, its 
border is designed with the Pen Controls. 

When you create a filled rectangle, its border is designed with the Pen Controls and its area is designed 
with the Fill Controls. See Pen and Fill Controls on page 130.

UNFILLED AND FILLED ROUNDED RECTANGLES

The filled and unfilled rounded rectangle tools work just like the rectangle tools.

UNFILLED AND FILLED OVALS

The filled and unfilled oval tools work just like the rectangle tools.

HORIZONTAL AND VERTICAL LINES

Click the horizontal or vertical line tools to create line elements.

PEN MENU

The Pen menu controls the pen width used for lines, and for the outline of 
rectangles and ovals. A pen option stays selected until you change it.

1 Select an element in the Layout Area.

2 Select one of the pen options.

Field Text

Figure 15 The unnamed field tool creates a field text element.
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ALIGN MENU

The Align menu specifies how selected elements are aligned to each another 
— right, left, top and bottom.

ALIGN CENTER VERTICAL 

Aligns the top and bottom midpoint of selected elements.

ALIGN CENTER HORIZONTAL

Aligns the left and right midpoint of selected elements.

DISTRIBUTE VERTICAL

Places an even amount of space between selected elements. If objects are overlapping, this option 
is disabled.

DISTRIBUTE HORIZONTAL

Places an even amount of space between selected elements. If objects are overlapping, this option 
is disabled.

TOOLS MENU

The Tools menu controls many other functions.

GROUP AND UNGROUP

When elements are grouped you can move them all at the same time or align 
them together.

LOCK AND UNLOCK

Select elements and then Lock to prevent them from being modified or moved. 
Select Unlock to release them. These commands are helpful when working with a 
multi-layered Form.

MOVE AND DUPLICATE

Perform standard graphics editing functions.

TURN GRID ON AND HIDE GRID

Turn Grid On toggles the grid display. Hide Grid toggles the Layout Area grid display. When the grid is 
on, elements in the Form align to the grid unless you press the Option key. These controls 
operate independently.



130 WebArranger

FIXED SIZE FIELDS

This option selects whether or not fields expand as text is typed into them. Select Fixed Size Fields when 
you create a Form to print labels. Do not select this option if you want to create Forms that are small but 
whose fields expand as text is typed.

SHOW/SIDE EXTRA FIELDS

Show/Hide Extra Fields allows any new fields added to a Note to display at the bottom of a Form. If Show is 
selected, new fields display. If Hide is selected, new fields remain hidden. 

If you’re printing information onto Forms, select Hide Extra Fields. 

SHOW TAB ORDER AND SET TAB ORDER

These options allow you to select the order in which you tab through the fields of a Form.

To set the tab order:

1 Use the pop-up menu in each field to select the field name for that field.

2 Click Show Tab Order to display the order in which you’ll tab through the fields.

3 Click Set Tab Order to change the tab order.

PEN AND FILL CONTROLS

The Pen Controls select the pattern and color of a line or 
the outside border of a graphic element.

The Fill Controls select the pattern and color for the 
inside of an element or the Form’s background.

Pen and Fill Controls provide:

■ Pattern pop-up — select the pattern for a 
border, line, or fill.

■ Color pop-up — select a color for a border, 
line, or fill.

Pattern pop-up

Fill pop-up

Pattern pop-up

Fill pop-up

Figure 16 Pen and Fill Controls

Color pop-up

Pattern pop-up
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Double-click a color patch to display the 
standard Macintosh color wheel dialog for other 
color definitions.

CHANGE PEN OR FILL SETTINGS
To change the setting for a box, oval, or line:

1 Select the element.

2 Change the Pen or Fill Control settings.

NAME TEXT FIELD

Type the Form name in the Name field. 

You can name a Form anything, but it’s best if you include the name of the Note type 
in the Form. 

For example: You’re creating a mailing label Form to use with People Notes. You 
name the Form People - Mailing Label. This makes it easy to spot a Form in a pop-up menu.

BUTTONS

LABELS

Label template files in the WebArranger Forms 
package contain layouts for various standard labels. 
To choose a label template file:

1 Click Labels.

2 Select a label template file. 

3 Click Open. If you don’t want to use a label 
template, select Clear.

When you select a label template with the Labels 
button, you attach that label to the Form. 
Whenever you print this Form as a label, you get 
this label layout.
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When you choose a label template 
file, an area the same size as the 
label is shaded gray in the Layout 
Area. Place fields on top of the gray 
area to make sure they’ll print 
correctly on the label. It’s a good 
idea to leave a small margin, 
in case of printer error.

To unattach a label from a Form:

1 Click Labels.

2 Click Clear.

CUT, COPY AND PASTE

CUT
Select one or more elements, and select Cut in the Edit menu. The items cut are 
placed on the ClipBoard. In the Form Editor, Cut cannot be undone.

COPY
Select one or more elements, and select Copy in the Edit menu. The items copied are 
stored on the ClipBoard. The selected items remain highlighted.

PASTE
When the ClipBoard contains cut or copied items, select Paste in the Edit menu. 
The items are pasted at the current insertion point. In the Form Editor, Paste cannot 
be undone.

CREATE A DEFAULT FORM WHILE DEFINING A NOTE

1 Choose Note Catalog in the Notes menu.

2 Select the Note type.

3 Click Edit.

4 Select New Form in the Form drop-down 
list in the Define Note dialog. The new 
Form automatically contains all the 
fields of the selected Note.

5 Edit the Form as necessary.

6 Name the Form.

7 Click OK. Your new Form is added to 
the Form Catalog.
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CREATE A FORM WHILE PRINTING

You can create Forms or edit Forms when you print: 

1 Select the View you want to print.

2 Select Print in the File menu, or press -P.

3 Select Labels from the Layout drop-down list. 

4 Choose New Form or Edit Form in the Current Form drop-down list.

5 Build or edit the Form as necessary.

6 Name the Form.

7 Click OK. Your new or edited Form is added to the Form Catalog.

USING FORMS

SET UP A VIEW TO DISPLAY FORMS

To display Notes in a View as Forms: 

1 Select a View from the pop-up Views menu next to a Topic, create a View, or 
duplicate a View.

2 Choose View Settings in the Views menu.

3 Choose a Form in the Form drop-down list. The list also 
lets you create or edit Forms.

See Create a Default Form While Defining a Note on 
page 132.

4 Make sure the Disable all Forms checkbox is not checked.

5 Click OK.

To see a Form in action, click the Summary Line to open 
one of the Notes in this View.

You can use the Forms function with the other View 
tools, such as Filter and Sort.
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❖ Note: When you select a Form in a View, that Form applies to all top-level Notes in that View, 
regardless of their Note type. See Create a Default Form While Defining a Note on page 132..

DISABLE SUMMARY LINES TO SEE FORMS

To always see Forms, disable Summary Lines for all top-
level Notes in a View. This replaces clicking the Summary Line 
for each Note.

1 Select View Settings in the Views menu. 

2 Select the Disable Summary Lines checkbox.

3 Click OK.

The Summary Line in each 
Form does not display.

CREATE A VIEW THAT SHOWS ALL NOTES AT THE TOP LEVEL

To display Sub-Notes as Forms, 
create a View in which all the 
Sub-Notes are displayed as 
top-level Notes.

1 Select New View in the 
Views menu.

2 Select Filter View in the 
Views menu.

3 Select Notes of Any Type.

4 Click the Both Notes and Sub-Notes radio button.

5 Click OK.

All Notes in the View are now displayed at the top level, and can be shown in Forms. Name this View 
for future use.
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ATTACH A FORM TO A NOTE TYPE

You can attach a default Form to any Note type, such as a People or Appointment Note. This Form 
automatically displays in all Views where that Note is at the top level. 

To set up any Note type to always display as a Form:

1 Choose Note Catalog in the Notes menu.

2 Select the Note type.

3 Click Edit.

4 Choose a Form in the Form drop-down list at the bottom right of the Define 
Note dialog.

5 Click OK.

6 Close the Note Catalog.

DISABLE FORMS IN A VIEW

When you don’t want a Note with a default Form to display as a Form in a particular View, disable 
Forms in just that View.  To turn off all Forms in a given View:

1 Select the View in which you want to disable Forms.

2 Select View Settings in the Views menu.

3 Check the Disable all Forms checkbox.

Even if a Form is the default for a Note type, that Note type won’t display as a Form when the Disable all 
Forms checkbox is checked.

PRINT FORMS

To print Forms, be sure they are displayed in the View. See Set Up a View to Display Forms on 
page 133.

■ You can print Forms in a View on paper.

■ You can print a document, Topic, View, or selection of Notes on labels or envelopes.
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PRINT FORMS ON PAPER

1 Select the View you want to print. 

2 Select Print in the File menu.

3 Select anything, except Labels, in the 
Layout drop-down list.

4 Click OK.

PRINT FORMS ON LABELS AND ENVELOPES

You can print onto labels or envelopes from a View that displays Forms. Or, you can select text and then 
choose a Form from the Print Options dialog.

LABELS

To print Forms on labels: 

1 Select the View you want to print.

2 Select Print in the File menu.

3 Choose Labels in the Layout drop-down list.

4 Select a Form from the Current Form 
drop-down list. You can also create and 
edit Forms.
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5 Click Set Label to select a label template. Use the 
file dialog to select a label template file. 

Use the Form Editor if you need to further align 
your Form with the label template.

6 Click OK.

The Notes print on the labels, using the Form 
you selected.

❖ Note: The Labels option is not available when 
you’re printing from a calendar View.

❖ Note: Label template files ship with WebArranger. They are located in the Labels folder in the 
WebArranger folder on your hard disk.

ENVELOPES

You can easily print envelopes with WebArranger. Before printing envelopes, first check Page Setup in 
the File menu to make sure your printer is set to print the type of envelope you want. Depending upon 
how your printer works with envelopes, use portrait or landscape mode.

Although you can print any selection of Notes onto an envelope, the easiest way is to print a View where 
all Notes appear at the top level. 

To print information onto envelopes:

1 Select the Topic, View, or set of Notes to print.

2 Select Print in the File menu.

3 Select the appropriate option in the Print the drop-down list.

4 Select Labels in the Layout drop-down list.

5 Select Envelope in the Current Form drop-down list.

6 The envelope form is designed to lay out information from a single Note onto a business envelope.

7 Click Edit in the Current Form drop-down list.

8 Customize the return address in the Envelope form. Click OK.

9 Click Set Label and select Envelope in the Labels Folder. 

10 Click Open to select an envelope layout. 

11 Click OK in the Print Options dialog.
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CHAPTER 8: FINDING INFORMATION

Storing information is only part of what WebArranger can do. Topics and Views let 
you build custom collections of information. WebArranger provides two types of 
commands to help you find specific pieces of information in your collections. 

One type, such as Find, moves you to the information. The other type brings the 
information to you, such as Gather. Gather is like the database command Query-by-Example.

FIND

 Use Find to search for a particular piece of information, based on an example of 
it. When Find locates matching information, it scrolls the Document window to 
show the match. To find an entire Topic, Folder, or View, use Go To in the Topics 
menu. See Go To on page 42.

To use Find:

1 Select Find in the Search menu to open the Find dialog;

Or, click the Find icon on the Icon Bar.

The Find dialog is a modeless dialog; you don’t have to close it before performing other actions in 
WebArranger. See The Field Catalog on page 52.

2 Enter text in the edit box. 
When you have text selected 
in your Document, it is 
automatically copied into the 
Find edit box.

3 Click Find Next.

WebArranger searches through your Document to find all Notes that match. The search is from top to 
bottom, starting at the current insertion point or selection. If there is no selection or insertion point, Find 
starts from the top of the current Topic or View. 

Find searches the current Topic, then through the next Topic in the Contents list. When it reaches the 
bottom of the Contents list, it wraps around to the top to return to the starting point. You can control this 
behavior in the Advanced Find dialog. See Advanced Find on page 140.

If there is no match, WebArranger beeps.

If it does find a match, it scrolls the Document window to show the matching text, and switches Topics 
when necessary. Find automatically opens Notes with Summary Lines to show the matching text. It 
closes them when you click Find Next before making any changes to the Document.
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When Find locates the particular piece of information you are looking for, click in the Document 
window to bring it to the front and resume your work. If the matching information isn’t what you want, 
click Find Next. Find will continue searching from the current selection.

FIND NEXT

Instead of leaving the Find dialog in front of your Document window as you search, you can close it. 
Select Find Next in the Search menu or press -G. 

Find Next works whether or not the Find dialog is open. The advantage of Find Next is the Find dialog 
doesn’t have to be on screen. 

FIND A PREVIOUS INSTANCE
To find the previous instance, hold down the Option key and select Find Next. This goes back to the last 
match. The Option key also works when you: 

■ Click Find Next in the Find dialog

■ Select Find Next in the Search menu

■ Press -G 

ADVANCED FIND

To open the Advanced Find 
dialog, click More Choices in 
the Find dialog. You can 
also choose Find/Change in 
the Search menu. Use this 
dialog to customize the 
behavior of Find.

OPTIONS PANE

SEARCH DROP-DOWN 

Find dialog

Change pane

Options pane

Figure 17 Advanced Find
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LIST
The Search drop-down list specifies where Find looks to find a match.

The default is in Document. It looks through all Topics in the Document. 
The other choice is in Topic, which narrows the search to include only the 
selected Topic or View. Select in Topic to find just the relevant information.

DIRECTION DROP-DOWN LIST
The Direction drop-down list specifies the order in which Find looks 
for matches. 

The default is forward, which searches from the current insertion point or 
selection downward through the current Topic. It continues downward 
through the Contents list.

The alternate is backward, which searches from the current insertion 
point or selection upward through the current Topic. It continues upward 
through the Contents list. If there is no selection or insertion point, Find 
starts from the top of the current Topic or View.

When the At End menu is set to wrap around, the forward and backward 
choices will eventually find the same matches.The only difference is the 
order in which the matches are found. 

However, when the At End menu is set to don’t wrap, these two choices 
have opposite meanings. The forward option searches only for matches 
below the current insertion point or selection. It stops at the end of the 
Document or Topic. The backward option searches only for matches 
above the current insertion point or selection. It stops at the top of the Document or Topic.

AT END DROP-DOWN LIST
The At End drop-down list specifies what happens when Find reaches 
the beginning or end of the Document or Topic. It depends upon the 
setting of the Direction option. 

The default is wrap around, which continues searching from the:

■ Beginning of the Document or Topic when it reaches the end, 
if Direction is set to forward

or

■ End of the Document or Topic when it reaches the beginning, 
if Direction is set to backward
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MATCH DROP-DOWN LIST
The Match drop-down list specifies how the text you enter in the Find edit 
box is interpreted.

The default is partial words. It matches the text you enter wherever 
it can, even if that match is only part of a word, or if it spans 
multiple words. 

The alternate is whole words. It matches the text you enter only if it 
can find that text as a whole, separate word. A word is defined in 
WebArranger as text surrounded by empty space, such as a space, tab, or 
return. Or by a punctuation mark, such as a period, comma, or semicolon.

The Match option is useful when you want to find a particular word that is 
spelled the same as pieces of other words. For example: You want to search for a person named “Tio.” 
With Match set to partial words, Find matches on “nation,” “generation,” and “integration” also. With Match 
set to whole words, Find only matches “Tio.”

SELECT DROP-DOWN LIST
The Select drop-down list specifies what happens when a match is found. 

The default is the text. It selects the matching characters in your Document 
when it finds a match. 

The alternate is the Note. It selects the entire Note that contains the 
matching text.

THE CHANGE PANE
The middle pane of the Advanced Find dialog is called the Change pane. 
It lets you change the information found by a search. The ability to 
change information globally is useful for fixing errors or updating 
information. Use the Change pane to specify how the information you 
find should change.

To change information found by a search:

1 In the Change to edit box, enter the replacement text.

2 Click Find. 

When a match is found, you have three choices:

■ Change replaces the selected text with the text from the Change to edit box.

■ Change/Find replaces the selected text, and then searches for the next match. 

■ Change All replaces every match with the text from the Change to edit box.
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❖ Note: If in Document is selected in the Search drop-down list, Change All replaces every match in the 
entire Document. If in Topic is selected, Change All replaces every match in the current Topic or View.

NEXT APPEARANCE

Next Appearance finds the next appearance of a Note that has linked copies. See Note Link Field on 
page 68.

To find a Note’s next appearance:

1 Select a Note with multiple appearances. A Note is in more than one place when its 
triangle is double. 

■ Select the Note and Note Info in the Notes menu to learn the exact number of times a 
Note appears.

■ A Note is also selected for Find processes when the insertion point is in it.

Appointment Note on page 21.“Reminder Note” on page 22. 

Topic Agents automatically create linked copies of Notes. See Auto-Gather Notes into a Topic on 
page 46.

2 Select Next Appearance or press -L.

■ Or, click the Next Appearance icon on the Icon Bar.

Next Appearance searches forward in the Document, wrapping around at the end, and always selects the 
matching Note. It opens other Notes and Sub-Notes as necessary to make the next appearance visible. 
Choose this command repeatedly to see all places in the Document where the Note appears.

To go to the previous appearance, hold down the Option key and select Next Appearance. The Option key 
also reverses the direction of Find Next searches.

WILD CARDS

The above descriptions are based on simple text strings you enter in the Find edit box. While this works 
fine when you know the exact spelling of the information you want to find, it doesn’t work so well when 
you’re not sure. When you don’t know the exact spelling, use wild card searches. You can use wild cards 
in other search processes:

■ Auto-linking tool, see page 69.
■ Gather, see page 144
■ Go To, see page 42
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Wild cards are special text characters that represent, or match, any other characters in their place. The 
wild card characters can represent any other character in their position in the text. See Table 21 and 
Table 22 on page 144.

 

Table 21 Wild card characters.

Table 22 Wild card examples

GATHER

Want to find all your contacts who have an AOL E-mail address? Need to find your URL Notes 
about Astronomy? 

Gather matches information and brings it to a specific place in your Document: 

■ Looks at an example of the information you want to find

■ Finds information in the Document that matches the example

■ Returns linked copies of that information to replace your original example

Gather has no dialog. Instead, it uses an example Note that you create in the Document.

To use Gather:

1 Open the Topic where you want to put the gathered Notes. 

2 Create a Note of the type you want to find. This Note is called the 
example Note. 

■ To match against all Note types in your Document, create a Memo Note as the example Note. 
The Memo Note acts as a wild card Note, and matches to Notes ofall types.

Wild card Description

? (Shift-/) Represents any single character.

* (Shift-8) Represents any number of sequential characters within a word.

≈ (Option-x) Represents any number of sequential characters within or across multiple words.

Wild card Description

?ffect Matches any six-letter word ending in “ffect,” such as “affect” and “effect.”

comp*se Matches any word beginning with “comp” and ending with “se,” such as 
“comprise” and “compose.”

cross≈platform Matches any word or word beginning with “cross” and ending with “platform,” 
such as “cross platform,” “crossplatform,” and “cross-platform.”.



WebArranger  145

3 Enter information in the example Note like what matching Notes should contain. You can use wild 
card characters in the text you enter in the example Note. See Wild Cards on page 143. 

If the example Note contains fields, enter information only in those fields you’re searching on. 
Empty fields are ignored.

4 Select the example Note, or place the insertion point in it.

5 Select Gather in the Search menu, press -M, or click the Gather icon on the Icon Bar. 

6 Gather searches through your 
Document, and finds any Notes that 
match the example Note. It returns 
linked copies of the matching Notes to 
replace the example Note. When no 
Notes match the example Note, you 
hear a beep. 

7 To select and insert multiple notes, 
hold down the Shift key while you 
click them. When you’re finished, 
click OK. All the Notes you select are 
inserted.

8 To select and insert all matching notes, 
click Insert All. All the listed Notes are inserted. You can insert up to 50 Notes into a Note Link field.

AUTOMATIC GATHER WITH NOTE LINK FIELDS

Gather works automatically with Note Link fields. For example: You want to schedule a visit to a certain 
URL, but all you remember is the Comment field begins with “Welcome.” 

1 Create a To Do Note for your 
example Note.

2 Click the URL Link field. This is 
a Note Link field.
See Note Link Field on page 68.

3 Type Welcome in the text box and 
press Return. 
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4 Gather takes over, and displays a list of 
URLs that have Welcome in the 
Comment field.

5 Select the URL you want. A box dis-
plays around it. Click OK.

6 You found the URL you wanted and it 
is linked to the To Do Note. Cool.

DELETE THE EXAMPLE NOTE
If you decide not to Gather, or if there are 
no matches, delete the example Note. 
First, check the state of the example 
Note’s triangle. 

If the example Note is of a type that no Topics are auto-gathering, the example Note’s control is a single 
triangle, and you can delete it. 

However, if some Topics are auto-gathering Notes of the example Note’s type, the example Note has a 
double triangle. To delete a Note with multiple appearances from everywhere it appears, select Destroy 
Note in the Edit menu or -Delete.

SELECT

Select finds Notes based upon their type and contents. The Select 
dialog is identical in function to the Filter dialog. 

However, Select picks the matching Notes instead of displaying 
them in a View. Select chooses from the Notes of the current Topic 
or View, and doesn’t change the Notes in any way. 

See Filter View on page 78. 
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THE SELECT DIALOG

SELECT ON NOTE TYPES
All Note types in the Document’s 
Note Catalog are displayed in the Show 
edit box drop-down list. Choose a 
Note type or Any Type.

The default is the Topic’s default 
Note type. 
See Topic Settings Dialog on 
page 45.

To select on a Note type:

1 Open the Topic or View.

2 Choose Select in the Edit menu.

3 Select a Note type(s) in the Show edit box. You can type a Note type name, or select from the 
drop-down list.

4 Click Just Notes or Both Notes and Sub-Notes. The Just Notes and Both Notes and Sub-Notes buttons 
specify where Select should look in the Topic. When you select Just Notes, Select examines only 
the top level Notes of the Topic. 

When you select Both Notes and Sub-Notes, Select examines both top level Notes and any Sub-Notes

5 Click OK.

6 The Notes are selected.

SELECT ON THE TEXT CONTAINED IN NOTES
Select compares a text string to all text in a Note, whether the Note’s text is in a single field — like the 
Memo Note type — or the Note’s text is broken into several fields, as in structured Notes like People 
and Appointment.

To select on text:

1 Open the Topic.

2 Choose Select in the Edit menu.

3 Type the text in the Notes containing edit box. This specifies the text string that Notes must contain to 
be selected. The matching process is not case sensitive.

Wild card characters can be included in the text string. Wild cards are a very powerful tool for 
matching information when you have the exact spelling, and for matching related groups of 
information using patterns in their text. See Wild Cards on page 143.
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4 Click Just Notes or Both Notes and Sub-Notes. The Just Notes and Both Notes and Sub-Notes buttons 
specify where Select should look in the Topic. When you select Just Notes, Select examines only the 
top level Notes of the Topic. 

When you select Both Notes and Sub-Notes, Select examines both top level Notes and any Sub-Notes

5 Click OK.

6 The Notes are selected.

CLOSE THE SELECT DIALOG
To close the Select dialog:

■ Click Cancel to exit the dialog and discard any changes you’ve made; or,

■ Click OK to exit the dialog and apply any changes you made.

More choices 
Click More Choices to open the Advanced Select dialog.

ADVANCED SELECT

The Advanced Select dialog defaults to 
the same behavior as the normal 
Select dialog. When you enter a text 
string in the text edit box and click 
OK, you get the same results. 

However, the options in the Advanced 
Select let you be more specific.

Read the Advanced Select dialog as 
sentences to more easily understand 
what the dialog controls.

SELECT ON NOTE LEVEL AND 
NOTE TYPE
The first line of the Advanced Select dialog specifies the 
Note level and Note type. 

To specify the Note level: 

1 Click More Choices to open the Advanced 
Select dialog.

2 Select a command in the Match drop-down list. 

Notes includes only top-level Notes in the View. 
Notes & Sub-Notes includes both top-level Notes and 
Sub-Notes. 

3 Click OK.
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SPECIFY OF TYPE
Enter the Note type in the of Type edit box, or choose a 
Note type from the drop-down list.

SELECT WITH RULES
In the normal Select dialog, a text string to search for in 
the Note is specified. In the Advanced Select dialog, you 
can be much more specific about describing what to 
search for and where to search for it. This additional 
capability is provided through rules. Each rule 
describes one aspect of a match.

The list of rules is located in the center of the Advanced Select dialog. Each line of text in the rule list 
represents a separate rule. You can create up to 16 rules.

Each rule in the list has three parts: 

■ Field choice control 

■ Relation drop-down list

■ Text edit box

field choice control
The field choice control specifies the name of a field to 
filter on. Either type the name of the field or select the 
field name from the drop-down list. 

The drop-down list presents all fields in the Note type 
selected in the of Type edit box. It also lists system 
fields and a command to choose any other field 
defined in the current Document. 

Any Field searches all fields of the Notes that it selects. A 
specific field type searches fields of that type. You can’t filter 
on Picture or File Reference fields.

Set Filter Field lets you pick other fields (in any Note type). 

Field choice control
Relation drop-down list

Text edit box
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Relation Drop-down List
Once you’ve chosen the field on which to select, you can 
specify a condition that must be true for that field. The 
default choice varies depending upon the type of field 
specified in the field choice control. 

■ When Any Field is specified, the following choices are available:

Table 23 How Relation options work with any field

■ When you select a Text field in the field choice 
control, the Relation list offers text-specific choices. 
Enter the text to match in the text edit box.

Table 24 How Relation options work with text fields

For example: You select Is Before and then enter c in the text edit box. The rule specifies the 
Select will include only those Notes which contain text in the chosen field that begins with a 
letter prior to c.

Relation Matches if

Contains The field contains the text you enter in the text edit box.

Equals The field contents exactly equal the text you enter in the text edit box.

Starts With The field contents start with the text you enter in the text edit box.

Relation Matches if

Contains The field contains the text you enter.

Doesn’t Contain The field does not contain the text you enter.

Starts With The field contents start with the text you enter.

Equals The field contents exactly equal the text you enter.

Doesn’t Equal The field contents do not exactly equal the text you enter.

Is Before The first character of the field contents comes before (alphabetically or 
numerically) the text you enter.

Is After The first character of the field contents comes after (alphabetically or 
numerically) the text you enter.

Is Present The chosen field is present.
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When Is Present is chosen, the text edit box on the right side of the rule is disabled, since no 
value is needed.

■ Date/time fields and time-of-day fields

When you select a date/time field or a time-of-
day field in the field choice control, the Relation 
list offers dateand/or time-specific choices. 

Enter a date and/or time in the text edit box. 
Drop-down lists are added to the text edit box 
to help you specify the date and/or time.

Table 24 on page 150 for an explanation of 
the options.

For example: You choose Is Before Or On and enter “3/31/96” in the text edit box. The filtered 
View includes only those Notes whose date fields contain a date prior to 3/31/96.

■ Number fields

When you select a Number field in the field 
choice control, the Relation list offers number-
specific choices. Enter a numeric value in the text 
edit box.

Table 25 How Relation options work with number fields

The Equals and Is Present options are described in Table 24. The Not Equal option is the same as 
the Doesn’t Equal option described in Table 24. 

For example: You select Greater Than and enter 175 in the text edit box. The filtered View 
includes only those Notes whose chosen Number field contains a number greater than 175.

■ Pop-Up fields

Relation Matches if

Greater Than The field contains a number greater than the number you enter.

Greater or Equal The field contains a number greater than or equal to the number 
you enter.

Less Than The field contains a number less than the number you enter.

Less or Equal The field contains a number less than or equal to the number you enter.
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When you select a Pop-Up field in the 
field choice control, the Relation list offers 
list-specific choices.

 

Table 26 How Relation options work with drop-down list fields

Enter text or one of the options from the Note’s drop-down list in the text edit box. The choices 
from the Note’s drop-down list are added to the text edit box. 

For example: You choose Contains from the Relation list and select Presentation from the text 
edit’s list. The selection includes only those Notes with the drop-down list field in 
containing “Work.”

■ Note Link fields

When you select a Note Link field in the field choice control, the Relation drop-down list offers 
Contains and Doesn’t Contain choices. See Table 26. Enter the text to use in matching the 
Summary Line of all the Notes in the field. See Note Link Field on page 68.

TEXT EDIT BOX
The text edit box is empty at first. 
When a Text field is chosen for the rule, 
you can enter any text for the 
filter to search for.

Relation Matches if

Contains The field contains the text you enter.

Doesn’t Contain The field does not contain the text you enter.

Starts With The field contents start with the text you enter.

Equals The field contents exactly equal the text you enter.

Doesn’t Equal The field contents do not exactly equal the text 
you enter.

Is Before The first character of the field contents comes before 
(alphabetically or numerically) the text you enter.

Is After The first character of the field contents comes after 
(alphabetically or numerically) the text you enter.

Is Present The chosen field is present.
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When a date/time field is chosen for the rule, you can enter any date and time 
for Select to use. Three pop-ups — Repeating Event, date, and time — are added to 
the text edit box.

 When a time field is chosen, you can enter any time 
for the filter to use.

MULTIPLE RULES
The power of the Advanced Select dialog 
comes into play when you create 
multiple rules to narrow a filter so it 
selects and displays only those Notes 
you want to see.

To add a rule to a select, click Add Rule 
and then adjust the settings for the rule. 

To delete a rule, place the insertion point in the rule and click Remove.

Experiment with various combinations of rules. You’ll find that working with multiple rules in the 
Advanced Select dialog lets you select very precisely.

HOW TO APPLY THE RULES
The choices in the Notes must match pop-up specify how 
the Select should apply the rules that you’ve created.

all of the Rules makes the filter very specific — all rules 
in the rule list to be true for a Note to match the filter. 
The other choice, any of the Rules, is more lenient. A 
Note must match any one (or more) of the rules.
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DISPLAY THE RESULTS OF A SELECT
The choices in the Show pop-up specify what Select 
should do with the results. 

Matching Notes displays the Notes that match the 
settings. Unmatched Notes displays Notes from the 
Topic that do not match the Select dialog settings.

RETURN TO THE SELECT DIALOG
Click Fewer Choices to return to the Select dialog.

OTHER WAYS TO GATHER AND SELECT NOTES

Putting Notes in a Topic to focus on a particular subject is very handy. Gather is a great way to 
automate collecting information from throughout your Document into one place. 

To gather Notes:

■ Option-drag a Note to the desired Topic in the Contents list

■ Use Select in the Edit menu to find the Note, and Option-drag it to the desired Topic

■ Go to a View, choose Select All in the Edit menu, and Option-drag the selected items to the 
desired Topic

To select Notes:

■ Click the Note icon 

■ Choose Select Topic/View in the Edit menu 

■ Use Find with the Select the Note option 
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CHAPTER 9: IMPORT & EXPORT

This chapter describes how to move information into and out of WebArranger.

■ Import moves entire files of existing information from other applications 
into WebArranger. Import determines the structure of the files it imports. 
The Import Format dialog lets you see the information you’re about to import 
in context, so you can choose how you’d like it organized. And many of 
WebArranger’s organizing features — including the ability to add fields, 
define fields, choose Notes, and define new Notes — are available during 
the import process.

■ The Grabber lets you gather text and graphics information from other 
applications while you’re using them, whether or not WebArranger is 
running. See How to Use the Grabber on page 9.

■ Export View and Save As are convenient ways of making information you 
manage in WebArranger available to other people and programs. Whether 
you want to share information with other WebArranger users, perform a 
mail merge with a word processor, or download to an electronic organizer, 
these commands support the file formats that you need.

■ File Merge makes it easy to keep your desktop and/or your PowerBook in total agreement, 
automatically.

IMPORT INFORMATION

TEXT FILES

WebArranger lets you easily import information from other applications and files. Import takes 
information from text files and converts it into Notes in your Document. 

Text files are structured and unstructured. Structured text files have a regular pattern to the information 
in them; unstructured files don’t. Most of the information you bring into WebArranger from other 
personal information manager applications will be structured information. 

For example: You’re importing contact information from a name and address manager. The file 
contains information for things like name, address, and phone. When you import scheduling 
information from a calendar program, the file contains information for things like date, time, 
and remarks. 

Import lets you match the structure of the text files you’re importing with the structure of Notes in a 
WebArranger Document.
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PREPARE INFORMATION FOR IMPORT

Almost all information management programs have an Export command that converts information from 
that program into a structured text file. You’ll usually need to decide which fields should be exported 
and what order should the fields be in. 

WebArranger makes these decisions easy ... export all the fields, in any order. Import matches the 
structure of the exported information to the structure of WebArranger’s Notes. Once you’ve exported 
your information, you are ready to import it. The maximum size for an import is 4K. 

IMPORT

To import information:

1 Choose Import in the File menu.

2 Locate the text file to import in the file 
chooser dialog. 

3 Click Open.

4 WebArranger looks at the information in 
the selected file to determine if it is 
unstructured or what kind of structure it has. 
Then the Import Formats dialog displays, and 
selects the best format. 

You can accept WebArranger’s format 
setting, or override it with your own. 

5 Click OK.

If the file is unstructured, WebArranger reads the 
file in as one or more unstructured Memo Notes, and 
adds them to the selected Topic.

The Other drop-down list features Internet 
applications, if they are installed.
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DEFINE IMPORTED INFORMATION

If the file is structured, WebArranger 
reads in the first several records and 
displays them in a table in the 
Import dialog.  

Modify how the information is imported 
by setting two options.

1 Set the type in the Import as Notes of 
type edit box.

2 Click Define Note to create a 
Note types specifically for the 
information you’re importing. 

3 Click Edit Note to edit existing Note types.

4 Set the Note fields that the information will 
be placed in. Assign each column of the 
table to a Note field. Choose a Field displays 
at the top of each column, along with a 
drop-down list of fields. 

This creates fields to hold some imported 
information but not add the fields to all Notes of that type.

For each column, you can:

■ Assign the information in that column to a field in the chosen Note type.

■ Assign the information in that column to any other field with Other Field. The Other Field dialog 
even contains a button that lets you define new fields while you’re importing. This lets you 
create custom Notes that match your imported information without changing the overall 
definition of Notes of that type.

■ Skip the column if you don’t want to import the information it contains.

5 Click OK. 

6 The Notes are imported into the selected Topic. When a Topic Agent gathers Notes of that type, the 
imported Notes are automatically gathered. See Auto-Gather Notes into a Topic on page 46. 
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IMPORT MULTIPLE FIELDS INTO A SINGLE FIELD
Sometimes you may want to combine multiple columns of imported information into a single Note 
field. For example: Many calendar-oriented information management programs use separate fields for 
date and time information. WebArranger uses the combined Date/Time field type. Or perhaps you want to 
use a single address field in your People Notes, but you’re importing information that has address infor-
mation stored in separate street, city, state, and zip code fields.

To combine multiple pieces of information into a single field, choose the same field in multiple
 import table columns. WebArranger combines the information from all the columns that have the 
same field selected, with a space between them. You can select any number of columns to combine into 
a single field.

For Date/Time fields, WebArranger inserts spaces and the @ character between information from 
separate columns. WebArranger assumes you are only combining two columns, one for date 
information and one for time.

IMPORT AND PERFORMANCE
WebArranger handles information more efficiently when fields are part of a Note definition, as opposed 
to when they are added only to a certain set of Notes. This normally isn’t an issue when you’re adding 
individual fields to Notes in normal use. However, it can have an impact when you import large amounts 
of information. 

When you import an existing contact list, you may want to edit the People Note definition, or create 
a Note definition for just the contacts you’re importing — to match the fields you are importing — 
rather than using the Other Field. This keeps your files smaller and allows WebArranger to perform 
more efficiently.

EXPORT INFORMATION

Export makes the information you manage in WebArranger available to other applications, people, or 
types of computers.

Export converts the Notes in a Topic or View into a specific text format, either structured or 
unstructured. It stores the resulting text to a file on your disk. Export to share information with:

■ other information manager programs

■ databases

■ word processors (to mail merge a contact list with a form letter)

■ people who don’t own a copy of WebArranger

Export operates on the contents of the current Topic or View. Since the Notes of any View can be 
exported, it’s easy to use WebArranger create a set of just those pieces you want to share.
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EXPORT

To export:

1 Switch to the Topic or View you want to export.

2 Choose Export Topic/View in the File menu.

3 Set the name of the exported file and the text 
format in the Export dialog. 

FILE FORMATS

The first few export formats in the pop-up menu are 
structured formats. These formats are listed in 
Table 27.

  

Table 27 Export structured file formats

 

File Format Description

TAIL WebArranger’s special information language format. Use TAIL to 
send Topics and Views to other WebArranger users, so they can 
bring the information into another WebArranger Document with 
Import or File Merge.

Tab Delimited A common file format. The contents of fields within a Note are 
separated by tabs, while the Notes themselves are separated by 
returns. When you choose Tab Delimited, only the top-level 
Notes are exported.

Comma Delimited A common file format. The contents of fields within a Note are 
separated by commas, while the Notes themselves are 
separated by returns. When you choose Comma Delimited, only 
the top-level Notes are exported.

Mail Merge A structured file format designed to help you create lists of 
information to use with the mail merge feature of a word 
processing program. The Mail Merge format is more 
sophisticated than the Tab and Comma Delimited formats 
because it exports the names and contents of the fields. This 
allows word processing programs to ask you questions about 
the mail merge procedure using the actual names of the fields 
from your WebArranger Document.
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The remaining formats in the pop-up menu are all unstructured — they export the contents of your fields 
as text with no embedded information about how to organize the text. These formats export all fields of 
all Notes and Sub-Notes in the current Topic or View, and are listed in Table 28.      

Table 28  Export unstructured file formats

CONTROL WHAT GETS EXPORTED

If you have a Topic selected, or a View without a table header, Export sends all fields in each Note, even 
any extra fields you may have added to some Notes but not to others. This is usually not what you really 
want. Most other programs can only import tab and comma delimited information if every entry in the 
text file is identical.

To export a particular set of fields from the Notes in a Topic, create a Table View of that Topic. Only the 
fields displayed in the Table are exported. The Note fields not displayed are not exported. See Show 
Table on page 90. 

File Format Description

Text, one ¶ per Note Concatenates the contents of all fields in a Note together, then inserts a 
paragraph return. If you have paragraph returns within the contents of 
your fields, like in a paragraph of text or a multi-line address, they appear 
as well.

Text, one ¶ per field Exports the contents of each field onto its own line in the text file.

Text, one ¶ per field 
(UNIX)

Exports the contents of each field onto its own line but also limits the 
number of characters on a line to 80. This is for compatibility with 
computers that run or communicate with the UNIX operating system.

Text, named fields Exports one field per line but precedes the contents of each field with 
the name of the field, a colon, and a space. It also adds a blank 
line between Notes. This format is useful when you want to use the 
information in a WebArranger Topic or View on a computer that only 
supports simple text editing. The field names make it easy to see the 
structure of your information.

Text, named fields 
(UNIX)

Same as Text, named fields except that lines are trimmed to 80 
characters in length for compatibility with computers running UNIX.
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EXPORT WITH SAVE AS

 You can also export information with the Save As in 
the File menu and an export format.

Table 29 Save As export file formats

File Format Description

WebArranger File The standard file format for WebArranger. Saving a copy of your file in 
this format is the same as duplicating the file in the Finder. Reopening 
a file saved in this format results in a Document that’s identical to 
the original.

TAIL File Described in Table 28.

Text Exports your entire WebArranger Document as a simple text file that 
can be read with any word processor. You can’t use Open to reopen an 
WebArranger Document that’s been saved as text, but you can import it 
with Import. The resulting Document won’t be the same as the one you 
saved, because text files can’t contain the structural information that 
WebArranger uses to organize Documents.

WebArranger 
Template

Saves your WebArranger Document as a template file. Template files 
are like stationery pads. You choose from a set of template files when 
you use New to create a Document. Saving a file as a template lets you 
extend the set of templates that WebArranger can use.
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MANAGE MULTIPLE COPIES OF A DOCUMENT

Managing copies of files on multiple computers has always been difficult. It’s hard to keep track of 
which elements of a file have changed. Usually, you do all the tracking and bookkeeping yourself; the 
computer seems to hardly help.

The popularity of portable computers, and of using more than one computer in general, has made this 
a major issue. The problem is most difficult for Personal Information Manager (PIM) users. PIMs 
encourage you to manage hundreds or thousands of separate pieces of information in a single file. It’s 
usually not possible to remember what changed in which copy of the file. 

For example: You have two copies of a file, one from your laptop and one from your desktop computer. 
Each lists a different phone number for one of your contacts. Is the new number in the laptop’s file or 
the other computer’s file? How can you tell which is the old number and which is the new?

FILE MERGE

To solve this problem, WebArranger provides File Merge to help you manage multiple files by 
combining two files into one.

Files are merged on a Note-by-Note basis. Every time you create a Note, WebArranger stores a special 
registration code for that Note, and also stores the information in the Note’s system fields. When 
WebArranger merges two files, it uses all this information to make decisions about which copy of a 
Note to use.

File Merge recognizes Notes that have been edited, new Notes, and Notes that have been deleted. If a 
Note has been edited in both files, the Note with the more recent change is chosen.

To use the File Merge:

1 Make sure both WebArranger Document files are 
visible in the Finder. This may mean using file 
sharing to look at files on another Macintosh, or 
using AppleTalk Remote Access (ARA) to look at 
files on a remote Macintosh, or simply copying a 
file from one machine to another via floppy disk.

2 Open one copy of the file with WebArranger. 
Usually, you’ll open your Home Document for the 
Macintosh you’re running on.

3 Select File Merge in the File menu.

4 In the file chooser dialog, select the copy of the file to merge with. 
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5 WebArranger then performs the merge. Depending upon how large the files are, this may take a 
few moments.

6 After merging, the file you originally opened in WebArranger contains the result of the merge with 
the other copy. You can look through the file to make sure what you expected actually happened. 
When you’re satisfied, Save to complete the merge. 

7 If the merge isn’t what you expected, select Revert to Saved in the File menu. This deletes the results 
of the merge and returns your original file. For example: You selected the wrong file in the file 
chooser dialog.

SYNCHRONIZE FILES

If you want to synchronize both copies of the file after merging, copy the newly merged file back over to 
the other Macintosh. Now you have identical copies of the file on each machine.

❖ TIP: When you first use File Merge, it’s a good idea to work with a copy of your Document file. That 
way, you can experiment without accidentally changing information.

MERGE MORE THAN TWO FILES

The file merge process described above works for any number of copies of a WebArranger 
Document file. 

1 Choose one copy of the file as the “accumulator” file. 

2 Use File Merge multiple times, each time merging with another copy of the file. 

3 When you’re done, copy the new Document back over all the other copies.

MERGE TOPICS

File Merge normally merges entire Document files. File Merge also works with Document files saved in the 
TAIL file format. 

Since you can save individual Topics as stand-alone TAIL files with the Export Topic, you can merge 
information on a Topic-by-Topic basis.

To merge two copies of a Topic:

1 Open a Document that contains the Topic you want to merge.

2 Export the Topic to merge in TAIL format.

3 Close the Document.

4 Open the Document you want to merge the Topic into.

5 Select File Merge. Select the TAIL file that contains the Topic you exported.
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This technique is particularly helpful in workgroups whose members use common Topics. By exporting 
and merging, multiple users can share the same Topic information.

Since File Merge is simultaneously using the contents of two files, it can use all the memory it can get. If 
you find that File Merge takes longer than you’d like, increase the amount of memory allocated to 
WebArranger in the Finder.
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CHAPTER 10: PRINTING

Putting information on paper makes it portable and easy to share with others. 
WebArranger’s View tools let you create custom Views for virtually any need. 

WebArranger’s Print options combine the versatility of Views with the convenience of 
printed output. See Chapter 5: Views, Tables & Calendars on page 72.

For information about printing labels, envelopes, and forms, see Chapter 7: Forms on page 123.

You specify the range of information you want to print — a few selected Notes, specific Views and 
Topics, or your entire WebArranger Document. 

To print a Document:

1 Select a printer to use.

2 Choose Page Setup and specify the options.

3 Choose Print and specify the options. -P is a shortcut.

Once you’ve chosen a printer and specified the Page Setup, you can usually bypass these two steps 
when printing.

SELECT A PRINTER

Before you can print, you must select a printer. To select a printer:

1 Choose Chooser desk accessory in the Chooser menu. 

2 Select the printer in the dialog. The contents of the dialog vary depending upon your setup. For 
more information on using the Chooser, refer to the manuals that came with your Macintosh.

PAGE SETUP

The options for Page Setup in the File menu include the size of the paper and the orientation of the image 
on the page. Sometimes you need to change the orientation. For example: You print on special paper that 
fits in small organizer books.

The Page Setup dialog varies depending upon your printer. For more information on options in the 
Page Setup dialog, refer to the manual that came with your printer and the manuals that came with 
your Macintosh.
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PRINT OPTIONS DIALOG

You specify printing options specific to 
WebArranger in the Print Options dialog. 
The Print Options dialog specifies what 
information to print, and how the 
information is laid out on the page. 
When you click OK, the standard 
Macintosh Print dialog displays. The 
dialog has four controls.

PRINT SELECTION 

The Print the drop-down list offers 
three options:

■ Current Selection — Prints all Notes currently selected. 

■ Current Topic — Prints all Notes in the current Topic or View. Current Topic is the default. 
When you’re in a View, Current Topic changes to Current View in the menu.

■ Whole Document — Prints all Notes in the Document. 

Table 30 Print selection drop-down list options

You may use the Current View option most frequently. Table 31 lists some Views useful when printing.

Table 31 Print options for Current View

Option Action

Current Selection Prints just the currently selected Notes.

Current Topic/
Current View

Prints all the information in the currently selected Topic or View. The name 
of this option changes depending upon whether a Topic or View is currently 
selected in your Document. 

Whole Document Prints all the information in your Document.

View Tool Example

Filter View Print just the relevant Notes.

Sort View Print Notes in a specific order.

Table View Print Note information in table format for easy reference.

Calendar View (day) Print your appointments for a particular day, by full, half, or quarter 
hour.

Calendar View (week) Print your appointments for a particular week, by day.

Calendar View (month) Print your appointments for a particular month, by day.
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LAYOUT

The Layout drop-down list specifies how 
the information is laid out on the page. 
WebArranger contains a list of layout 
options for one, two, or four to a page.

For example: You’re printing a week 
View. You can print one, two, or four 
week Views per page. You can mix 
and match Views to create custom Views. 
Combining WebArranger’s Views with 
the Two Up, Four Up, and Organizer 
Binder printing options let you generate 
almost any type of printed page you want

These layout options obey the landscape and portrait page orientation settings found in the 
Print Settings dialog in the File menu. See Table 32. 

For example: You’re printing the Two Up layout option, and you select the landscape setting. 

Table 32 Print arrangement options

STANDARD ORGANIZER-SIZE PAGES
WebArranger supports the following standard organizer page sizes. Select a page size that corresponds 
to the size of your organizer book.

■ Compact (4.25 x 6.75)

■ Jr. Pocket (2.75 x 5)

■ Organizer (5.5 x 8.5)

■ Portfolio (8.5 x 11)

■ Sr. Pocket 3.75 x 6.75

SHOPPING LIST
Shopping List prints a small, narrow list that’s perfect for carrying a shopping list or list of names 
and numbers.

Option Action

One up Prints one page of information at full size on a single sheet of paper.

Two up Prints two pages of information, scaled to 50%, on a single sheet of paper.

Four up Prints four pages of information, scaled to 25%, on a single sheet of paper.
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TRIFOLD
Trifold prints three lists on a page. You can then fold the page in three for easy access to 
listed information.

HEADERS

Headers lets you set up headers and footers for 
the Document.

Type information in the left, middle, and right 
header boxes or into the left, middle, and right 
footer boxes. 

Or, click in a header or footer space and click to 
insert one or more Variables. The page number variable appears in the right footer field by default. 

For example: You click in the left header box and then click View Name. This prints the name of the View 
in the upper left header of the printed page. 

SELECT FORMATTING FOR HEADERS AND FOOTERS 

1 Click Format.

2 Select the style to apply to all 
headers and footers. 

3 Click OK. 

MARGINS

Margins lets you set up margins 
around the selection you’re printing. 
Every printer is different; use the 
margin settings that work best with 
your printer.

1 Click Margins to display the Print Margins dialog. 

2 Type values to specify left, right, top, and bottom margin. 

3 Click OK.
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PRINT ITEM ICONS

This specifies if Note icons print to the 
left of each Note on the page. When you 
do not print Note icons, printed pages 
look less busy. This may be helpful for 
lists or tables comprised of Notes of the 
same type.

PRINT OUTLINE LABELS

This checkbox specifies if outline 
numbering labels print to the left of 
each Note on the page. This is useful 
for printing formatted outlines of 
your information.

PRINT FROM THE WEB SCHEDULE TOPIC

The Print Options dialog contains Include dates from pop-up menus when you’re in the Calendar View of the 
Web Schedule Topic and you select Current View.

The Include dates from pop-up menus specify which dates from your calendar to print. 

To print from the Calendar View of the 
Web Schedule Topic:

1 Select the Calendar View of the Web 
Schedule Topic.

2 Select Print in the File menu to 
display the Print Options dialog.

3 Select Current View.

4 Select a layout.

5 Select a date range from the Include 
dates from pop-up menu.

6 Click OK.



170 WebArranger

PRINT LABELS

The Labels option is available in Topics and in all 
Views except calendars. Before you can print onto a 
label, select both a form and a label template. See 
Labels on page 131. 

You can print any selection of information from 
WebArranger onto labels:

1 Select the Topic, View, or set of Notes to print.

2 Select Print in the File menu.

3 Select an option in the Print the drop-down list.

4 Select Labels in the Layout 
drop-down list.

5 Select a form in the Current 
Form pop-up list.

The form you select is used to lay out 
the information from a single Note 
onto a single label. Make sure the 
form you select fits onto the type of 
label you want to print.

■ Set up your own form. Select 
New Form in the Current Form 
menu. See Create a Form on 
page 124.

■ Modify a form to fit onto a label. Select the form in the Current Form menu and select Edit Form.

■ The Labels button displays a guide of standard label sizes. 

6 Click Set Label to select a label template.

WebArranger comes with a set of predefined label templates that correspond to the most popular 
label layouts. You can use these, or modify them, or create your own label layouts.

A label template specifies the size of an individual label, the space between labels on a page, and 
the number and position of labels on the page.

7 Select Edit to change the form.

8 Click OK.
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PRINT ENVELOPES

You can easily print envelopes with WebArranger. Depending on how your printer works with 
envelopes, use either portrait or landscape mode.

Although you can print any selection of Notes onto an envelope, the easiest way is to print a View where 
all Notes appear at the top level. See Set Up a View to Display Forms on page 133.

To print information onto envelopes:

1 Select the Topic, View, or set of Notes to print.

2 Select Print in the File menu.

3 Select the appropriate option in the Print the drop-down list.

4 Select Labels in the Layout drop-down list.

5 Select Envelope in the Current Form drop-down list. The envelope form is designed to lay out 
information from a single Note on a business envelope. 

6 Select Edit Form in the Current Form drop-down list.

7 Customize the return address in the Envelope form. Click OK.

8 Click Set Label and select Envelope in the Labels Folder. 

9 Click Open to select an envelope layout.

10 Click OK in the Print Options dialog.

See Print Forms on page 135.
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